
PINES libraries have uniform circulation policies and procedures. According to the PINES Executive Committee, this is a condition of participation [1999.05]. The procedures outlined herein represent the decisions of the PINES Executive Committee. Some procedures will remain under local control, varying with the specific situation of each library or library system. Individual patron abuse of general PINES policies may be addressed at the local level by the system director [2012.03].

PINES Circulation Policies are approved by the PINES Executive Committee with input by the PINES Subcommittees and the PINES Library System Directors. Any PINES Library System Director may suggest a change to the existing policy to the Executive Committee for review.

About This Manual

This manual is based on the 2003 version of the PINES Circulation Policies and Procedures Manual that contained complete descriptions of procedures in the existing automation system. The document was brought up to date with references to Evergreen and completely revised in 2010 by a dedicated workgroup made of up representatives of PINES member libraries. Since then, it has been updated regularly to accommodate policy changes, new procedures due to changes in the software, and additional information. In July of 2017, the manual was moved from a standard Word document format to a Wiki format in order to improve change tracking.

About the 2010 PINES Circulation Policies & Procedures Project

Annotations

The policy has been edited with bracketed inline annotations (e.g., “[2014.05]”) which refer to the year and month of the Executive Committee meeting at which the policy was decided. Only meetings where an action item resulted in a policy addition or change are referenced. Discussion items or PINES staff reports are not referenced.

Meeting Agendas and Notes

Downloadable PDF of This Manual

Downloadable Version 08-26-2022
From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link: https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:home

Last update: 2022/08/26 11:17
Confidentiality

Georgia Confidentiality Law
The Georgia Law (O.C.G.A. 24.12.30. Confidential nature of library records) prohibits the disclosure of any patron information, including titles checked out, amount of fines/fees owed, and phone numbers/addresses. All PINES library staff recognize the strict confidentiality of library records, and shall not disclose any information regarding library patrons unless legally compelled. If proper legal documents are presented, a Library Director or designee must approve the decision to release confidential records.

Confidentiality of Patron Information
Patron data such as email address, phone number or mailing address cannot be used for purposes other than PINES transactions initiated by library patrons. Board of Regents legal counsel has indicated that in their opinion that state and federal privacy laws prevent use of PINES patron records for any business other than library transactions initiated by the patron. Allowable use of data may include overdue notices, reminders, holds notices. Patron information may not be used for county mailings, Friends of Libraries solicitations, and unsolicited e-mail communications from the library staff [2009.05].

Customer Lifecycle Management and Market Analytics Platforms
Libraries may utilize customer lifecycle management and market analytics platforms such as Savannah/Orange Boy, Tableau or LibraryIQ with the stipulations that the BOR legal team has outlined. The BOR legal team has stipulated that libraries may use these types of products using anonymized data for collection and user analysis and that patron data can be used IF the patron was “opted in” to receive such communications. In order to do this, libraries can create a specific stat cat (used during the patron registration process) to ask the patron if they would like to receive communications from that platform. Then library staff can mark them as “opt in”. For existing patrons, library staff could do a marketing push to get them signed up. It would be the same process as above with library staff manually marking patrons who consent as “opted in”. Note: in handling user information, the BOR legal team and ITS must approve handling of data before any library can move forward with their contract. Please consult the PINES third party hardware and software policy for further details.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:
https://pines.georgialibraries.org/dokuwiki/doku.php?id=confidentiality

Last update: 2023/02/06 15:19
2010 PINES Circulation Policies and Procedures Project

The PINES Circulation Policies & Procedures Revision Project began in February 2010, and completed its work at the May 2010 meeting of the PINES Executive Committee. The working group for this project consisted of members from the Staff Training/Documentation Subcommittee, along with a few volunteers who showed particular interest in the project.

Completely Revised

This manual is based on a 2003 version of the PINES Circulation Policies and Procedures Manual that contained complete descriptions of procedures in PINES’ automation system. This document has been brought up-to-date with references to Evergreen. The first phase of the Revision Project also revisited the complete archive of PINES Executive Committee meeting minutes from 1999 to 2010 to make sure that all decisions were somehow accounted for.

New Annotations

The policy has been edited with bracketed inline annotations (e.g., “[2009.12]”) which refer to the year and month of the Executive Committee meeting at which the policy was decided. Only meetings where an action item resulted in a policy addition or change are referenced. Discussion items or PINES staff reports are not referenced.

New Versioning System

Each version of this documentation will be marked with the year and month of the most current change. This ensures that staff members using the documentation for reference know how current the policy is.

2010 Project Team Members:

- Judy Atwood, Athens Regional Library System
- Susie Brendle, Mountain Regional Library System
- Gayla Brewer, Cherokee Regional Library
- Karen Douglas, Athens Regional Library System
- LaToya Davidson, Twin Lakes Library System
- Jennifer Durham, Statesboro Regional Library System
- Trudi Green, Athens Regional Library System
- Martha Richardson, Northeast Georgia Regional Library
- Dawn Dale, PINES Helpdesk Manager
- Katherine Gregory, PINES Services Specialist
- Chris Sharp, PINES Program Manager, Project Coordinator
Registering Workstations

Before Evergreen can be used, a “workstation” must be registered. This process assigns a name to the workstation that gets recorded in the activity / auditing logs in the Evergreen database and also affects what information you will see on certain screens. Most computers will only need a single workstation name set up. However, it is possible to set up multiple workstation names associated with different branch locations for those staff members who do work for multiple branches (such as catalogers or local administrators).

Workstations can only be registered by staff members with a LibraryManager, LocalAdmin, or CatCoord type of account. If a computer has multiple Windows logins (a different Windows login for each staff person that uses it), then a workstation will have to be registered for each one (however, it can be the same workstation name if you want settings to be the same).

To register the first workstation on a computer, simply log in with a LibraryManager, LocalAdmin, or CatCoord account. You will be prompted to register a workstation before proceeding further.

If a workstation cannot be registered, verify that the date/time/time zone on the computer are correct, and that JavaScript and Cookies are enabled in the browser.

Workstation Registration

Registering Multiple Workstations

Staff such as LocalAdmins and Catalogers that support multiple locations may have a need to log in as if they are at a different location. To do this, they may register workstations for each required location:

1. In Evergreen, go to Administration > Workstation > Registered Workstations.
2. Under “Register a New Workstation for This Browser” select the appropriate branch and type in a workstation name.
3. Click Register.
4. Log out. The login screen should now show the new workstation in the dropdown list of registered workstation names.
Browser Tools

The Evergreen web client is optimized to work with the current versions of Chrome and Firefox. Other browsers are not officially supported. Your browser must be set to allow popups, cookies, and JavaScript.

Although we do not endorse one browser over the other, the Hatch local storage / printing program only works with Chrome at this time. If you wish to have better control over printing or if you wish to save local configuration settings (column configurations, registered workstations, custom print templates, etc.) without worrying about them being cleared out if you clear your cookies, then you will need to use Hatch with Chrome.

Allowing Popups

Your browser must allow popups from gapines.org. You should see a small icon or message when a popup is triggered, but if you do not, you may follow these steps to ensure that popups are allowed.

Allow Popups In Chrome

1. Click on the menu icon (three vertical dots in the upper-right corner).
2. Select Settings.
3. Scroll to the bottom and click Advanced.
4. Under “Privacy and Security” click “Content settings.”
5. Click on “Popups and Redirects.”
6. Click the Add button next to Allow.
7. Type in https://gapines.org and click Add.

Allow Popups In Firefox

1. Click the menu button (three horizontal lines in the upper-right corner).
2. Select Options.
3. Click on Privacy & Security.
4. Scroll down until you see “Block pop-up windows” in the Permissions section.
5. Click the Exceptions button.
6. Type in http://gapines.org and click Allow.
7. Click Save Changes.

Standard Browser Functions

Since the client is web-based, you can use common keyboard shortcuts and functions such as selections, copy & paste, and right-clicks to access menus.
Bookmarks and Profiles

The web client allows you to bookmark the pages that you use the most, and to use your browser's existing functionality to build your own custom toolbars and even to use browser profiles for different activities.

Firefox Bookmark Extensions

You can use Firefox's built-in Bookmarks Toolbar to create a custom toolbar, or you can install free extensions to customize your bookmark toolbars even further (Menu > Add-Ons > Extensions > Search). There are many extensions available, but a few that you may find useful are:

- Multirow Bookmarks Toolbar: Makes your built-in Bookmarks Toolbar wrap to multiple rows.
- More Bookmarks Toolbar: Adds a second bookmarks toolbar.
- Bookmarks Favicon Images: Allows you to customize the icons for your bookmarks.

Chrome Bookmark Extensions

You can use Chrome's built-in Bookmarks Bar, or you can install free extensions to customize your bookmark toolbars even further (Menu > More Tools > Extensions > Get more extensions). There are many extensions available, but a few that you may find useful are:

- Bookmark Manager (by Google): More sophisticated bookmark tools including search capabilities and folder suggestions.
- EverSync: Another way to sync, backup, and restore your bookmarks.
- Switchmark: Switch between multiple bookmark bars.

Firefox Sync

Firefox Sync is a free tool that allows you to synchronize your bookmarks, add-ons, and browsing history across multiple computers and mobile devices. This is useful for staff who work in multiple locations.

- See: Set up Firefox Sync

Chrome People

Chrome People allows you to synchronize your bookmarks, add-ons, and browsing history across multiple computers and mobile devices. This is useful for staff who work in multiple locations. You can also set up
Chrome profiles to separate work activities from personal activities or to separate different types of work activities, or for multiple staff who need to use the same computer.

- See: [Chrome profiles / people](https://pines.georgialibraries.org/dokuwiki/)

### Export Bookmarks from Firefox

1. Click Bookmarks > Show All Bookmarks.
2. Click the Import and Backup dropdown menu.
3. Select Export Bookmarks to HTML.

### Export Bookmarks from Chrome

1. In Chrome, click on the menu icon (3 vertical dots at upper-right corner of browser).
2. Click on Bookmarks > Bookmarks Manager.
3. Click the Organize dropdown menu.
4. Select Export bookmarks to HTML file.

### Set Up Default Email

If you want to be able to click on a linked email address and have it launch a new email window in your preferred email system (ie, Gmail, Microsoft Outlook, etc.), you may need to configure your browser so that it understands what type of email window to open.

#### Default Email in Firefox

1. Click on Menu (three lines in upper-right).
2. Select Options.
3. Scroll down to the Applications section.
4. Click the dropdown next to the “mailto” option to set your preferences.
5. (There is no Save button - it will save as soon as you make your selection.)
Set up default email in Firefox

**Default Email in Chrome**

By default, Chrome should launch whatever your Windows default email system is (for example, if Windows is set to use a program such as Microsoft Outlook or Thunderbird as your email program). If you want to change Chrome to launch Gmail instead, follow these instructions:

1. Open Gmail in Chrome and click the Protocol Handler icon (two overlapping diamonds) in your browser’s address bar.
2. When prompted to “Allow Gmail to open all email links?”, select “Use Gmail,” and click “Done.”

If Chrome is set to Gmail to default, but you need to change it back to your Windows default, you’ll need to clear out your Chrome settings:

1. Click the menu icon (three vertical dots in upper-right).
2. Click Settings.
3. Scroll down to the bottom and click Advanced.
4. Scroll down to Privacy and Security.
5. Click on Content Settings.
6. Scroll down and click on Handlers.
7. Delete Gmail as the mailto handler.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2019/03/11 18:01
Default Search Library

Whether you prefer your catalog searches from within the staff client to default to all of PINES, to your regional library system, or to a specific branch, you may set your preference on the Workstations page.

1. Click on Administration.
2. Click on Workstation.
3. Select using the Default Search Library Dropdown.
4. (There is no Save button, it will automatically save your preferences when you make the selection.)

Full Library Names

This is a new feature as of the January 2023 Evergreen 3.10 upgrade.

On the same page, under Workstation settings, there is a feature that allows staff on an individual basis the option to show the full library name in library selector dropdown lists. This only works for the newer staff client interfaces that are built in Angular. (You can tell if an interface is new or old by looking at the URL of the page you are on: if it has “eg” in the URL path then it is an older interface and if it has “eg2” then it is a newer interface.)

To configure:

- Go to Administration > Workstation
- Check “Include Full Library Names in Library Selector?”
- Log out and log back in
The newer interfaces (such as the staff catalog) should show the full library names along with the short names. The older interfaces (such as the patron search) will still show the traditional dropdown.
Function Bar

Pages that show tables of data (patron search results, checkin screens, holds pull lists, etc.) have function bars across the top of them similar to this one:

![Function Bar](image)

Function Bar

Paging controls are located to the upper-right of the table, with arrows to navigate from page to page of results and a Page dropdown to jump to a specific page. The “Rows 100” dropdown in the example allows you to control how many rows you wish to see at once.

Some pages will also present you with action buttons (such as the Add to Bucket and Merge Patrons buttons shown in the example above, or the Actions dropdown shown in the example below). You must use the checkboxes in the table to select at least one row before you can use the action buttons.

![Action Menu](image)

Action Menu

Column Configuration

To the far right of the paging controls, the single dropdown arrow on the right presents you with various column configuration options.
Various search results tables may not default to the most useful columns. For instance, the patron search results page may be easier to use if you change the columns to Card, Last Name, First Name, Middle Name, Dob, and Primary Identification, and you may wish to have the results sort by Last Name, then by First Name.

**To customize your columns:**

First:

1. Click on the dropdown arrow at the top-right of the grid.
2. Click on Manage Columns.
3. Use the checkboxes in the Visible column to select which columns to display or hide.
4. Use the up and down arrow buttons to control the order in which your columns should appear.
5. Use Sort Priority (if available) to prioritize how sorting should work. (A negative number will sort the column in reverse order.)
6. Click Close.
Manage Columns

Next:

1. Click on the dropdown arrow at the top-right of the grid.
2. Click Manage Column Widths
3. Use the arrows to expand or shrink each of the columns so that the content displays as you wish.
4. When satisfied, click on the dropdown arrow again and click Save Columns.

Reset Columns:

If you wish to clear your customizations and switch back to the default, click the dropdown arrow and then click Reset Columns.

Downloading or Printing Results

Every grid (aka, table) in the staff client has the option to Download Full CSV, available from the dropdown arrow on the function bar. This will download all of the records in the grid regardless of whether or not all of the records are currently visible. For example, if you do a patron search and retrieve 65 patrons but have your Rows set to 25, you will only see 25 patrons per page, but clicking Download Full CSV will download all 65 patron records to a CSV file, which can then be opened in Excel. When the CSV file downloads, it will download data for whatever columns you have visible.

Likewise, the option for Print Full Grid will also print the visible columns for all of the retrieved records even if they span multiple pages.
Shortcut / Function Keys

There are some pages in the staff client that use embedded content (the catalog is an example of this). The shortcut keys will not work properly if you are on one of these pages and your mouse cursor context is inside of the embedded content. If you click in the white space around the edge of the page outside of the embedded content, the shortcut keys will then work.

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Check Out</td>
</tr>
<tr>
<td>F2</td>
<td>Check In</td>
</tr>
<tr>
<td>F3</td>
<td>Search Catalog</td>
</tr>
<tr>
<td>F4</td>
<td>Search Patrons</td>
</tr>
<tr>
<td>F5</td>
<td>Item Status</td>
</tr>
<tr>
<td>F6</td>
<td>Record In-House Use</td>
</tr>
<tr>
<td>F8</td>
<td>Retrieve Last Patron</td>
</tr>
<tr>
<td>F9</td>
<td>Reprint Last Receipt</td>
</tr>
<tr>
<td>Shift-F1</td>
<td>Register Patron</td>
</tr>
<tr>
<td>Shift-F2</td>
<td>Capture Holds</td>
</tr>
<tr>
<td>Shift-F3</td>
<td>Search for Record by TCN</td>
</tr>
<tr>
<td>Shift-F8</td>
<td>Retrieve Last Record</td>
</tr>
<tr>
<td>Ctrl-F2</td>
<td>Renew</td>
</tr>
<tr>
<td>Ctrl-N</td>
<td>New Window</td>
</tr>
<tr>
<td>Ctrl-T</td>
<td>New Tab</td>
</tr>
<tr>
<td>Ctrl-W</td>
<td>Close Tab</td>
</tr>
<tr>
<td>Ctrl-Shift-T</td>
<td>Undo Close Tab (open last closed tab)</td>
</tr>
<tr>
<td>Ctrl-F5</td>
<td>Refresh / Reload Page</td>
</tr>
<tr>
<td>Ctrl-Tab</td>
<td>Switch between browser tabs (from left to right)</td>
</tr>
<tr>
<td>Ctrl-Shift-Tab</td>
<td>Switch between browser tabs (from right to left)</td>
</tr>
<tr>
<td>Ctrl-1</td>
<td>Switch to the First Tab</td>
</tr>
<tr>
<td>Ctrl-9</td>
<td>Switch to the Last Tab</td>
</tr>
<tr>
<td>Home</td>
<td>Go to Top of Page</td>
</tr>
<tr>
<td>End</td>
<td>Go to Bottom of Page</td>
</tr>
<tr>
<td>From:</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td></td>
</tr>
<tr>
<td><a href="https://pines.georgialibraries.org/dokuwiki/">https://pines.georgialibraries.org/dokuwiki/</a> - PINES Documentation</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Permanent link:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Last update:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018/12/03 13:43</td>
</tr>
</tbody>
</table>
Change Operator

If you click on the menu button on the upper-right corner of the interface, you'll see an option for “Change Operator.“

The operator change dialog allows the selection of a Temporary, Staff, or Permanent authotoken.

**Temporary**
Temporary logins expire within a few minutes of inactivity. This could be used when a Circulation staff person needs a Library Manager to log on in order to create another workstation, or it could be used for quick testing purposes. Use the Restore Operator option to return to the original user.

**Staff**
Staff is a normal staff login, but still allows the option to switch back to the original user.

**Permanent**
Permanent completely logs out the original user and does not offer the option to switch back.

From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation
Last update: 2018/10/11 16:15
Patron Account Information

General Policies

- Proper identification must be presented to register [1999.05]. (See: Acceptable Forms of ID)
- Library patrons must have a valid library card to check out materials [1999.05, 2010.09]. Library card barcodes may also be scanned from handheld devices [2014.05]. (See: Scanning Barcodes from Mobile Devices) If a patron does not have their library card with them when they present materials to be checked out, they may present an approved form of identification to staff so that they may look up the patron account. Care should be taken to ensure the correct account is used for check out [2021.12].
- Applicants for a card must complete and sign an application form, available at any PINES participating library’s circulation desk. Alternatively, applicants may fill out an online application form prior to visiting the library to present their identification and complete their application [2014.05]. As of September 2021, the online application form will automatically generate an e-card so that applicants can begin accessing online materials immediately. Those patrons must then visit the library in order to upgrade to a full PINES card.
- Patron account information is confidential and cannot be used for purposes other than PINES transactions. (See: Confidentiality)
- Patrons who are unable to visit the library due to physical disability may complete and sign an application form that may be mailed to the patron from his/her participating library or printed from the PINES application form. The applicant will make copies of his/her identification to be attached to the application form. The identification and application should be mailed to the local participating library. The participating PINES library will process the application and send a library card and any other materials typically shared with new patrons by mail to the patron. Copies of patron's identification documents will be shredded after the new card is issued [2019.05]. Note: As per PINES Executive Committee discussion while approving this policy, the library will create a normal Patron account (not Homebound or GLS).
- Sample Library Card Application Forms

Residency

- Library cards are free to all residents of Georgia. Persons who attend school, own property or are employed full-time in Georgia are eligible for a free PINES card. Patrons of both PINES and non-participating Georgia public libraries may receive a PINES card. Users from non-participating Georgia libraries shall have the same privileges as PINES users. Most PINES cards are valid for 2 years [1999.05].
- Property owners who do not reside in Georgia are required to show proof of Georgia property ownership, such as a tax bill or deed. Non-Georgia residents who are employed in Georgia or attending school in Georgia are required to show proof of that employment or enrollment.
Out-of-state cards are available to persons living outside Georgia who do not meet the above criteria for a $25 annual fee, payable at the time the card is issued. A temporary card is available for a $12.50 fee and is valid for 6 months.

Responsibility

- Signing a PINES card application denotes acceptance of responsibility for all fines and fees for lost or damaged materials.

- There is no minimum age for a child to receive a PINES card. A parent or legal guardian may register a child [1999.05]. Parent or legal guardian must show proper ID to register a child. A parent or legal guardian must sign the application for all children under 18. Signing a child’s PINES card application denotes acceptance of responsibility for all fines, lost or damaged materials.

Acceptable Forms of ID

An applicant for a new card is required to provide proper ID, which includes current, local address. Acceptable ID for receiving a PINES card (3 choices):

1. Photo ID which shows the applicant’s current local address, OR
2. Photo ID which does not include current local address plus one item from the list of acceptable address verification documents, OR
3. TWO (2) items from the list of acceptable address verification documents.

Acceptable Photo ID:

- Valid driver’s license
- Valid passport
- Valid US Military ID
- Valid matricula consular
- Valid Georgia Weapons Carry License

Acceptable Address Verification Documents (must show applicant’s name and current address):

- Valid Georgia voter registration card
- Recent utility bill (e.g., gas, electric, cable, internet, water/sewer, waste management)
- Recent tax receipt or other piece of mail that shows the user’s name and present address
- Recent pay stub
- Current lease/rental agreement
- County tax assessor records
- Official base assignment documentation (for current military and family members)

If applicant resides out of state, but works, goes to school, or owns property in Georgia, then applicant must show supporting documentation in order to obtain a “Patron” card at no charge (as opposed to an “Out of State” card which incurs a fee).

Original documents are required with the exception of utility bills: because many people now pay their
utility bills online and no longer receive them on paper, patrons may present their online bill or statement on their mobile device or printed from their utility’s web site [2015.12].

The registering library is responsible for ensuring that a correct address is obtained [2005.08].

Historical Notes:

- Matricular consular was added [2004.08]
- Social Security Numbers are not used in PINES [2006.11]
- Lists were updated to include passports, military ID, weapons carry license, pay stubs, lease/rental agreements, and county tax assessor documents. The decision was made to remove checks with pre-printed addresses [2022.05]

**Record Retention Policies**

The legal department of the Board of Regents has indicated that public libraries are not mandated to follow the USG data retention schedule for “Courtesy Borrowers Records” (a.k.a library patron applications) [2014.09 BOR communication to the PINES Program Director]. Each library system should develop its own record retention policies in accordance with the Secretary of State policy for voter registration. Whether that information is recorded electronically or on paper forms is determined by each library system.

More information can be found by searching the [Secretary of State’s Website](https://sos.georgia.gov). For questions, please feel free to contact Rachell Simmons of the SOS Elections Office through email: rsimmons@sos.ga.gov or phone: 470-312-2755.

From: [https://pines.georgialibraries.org/dokuwiki/](https://pines.georgialibraries.org/dokuwiki/) - **PINES Documentation**


Last update: **2022/06/28 10:28**
Creating New Patron Accounts

1. **Check for Existing Accounts:** To avoid creating a duplicate record, library staff should always search for the patron’s name in the Evergreen patron database before entering a new patron record. The “Include inactive patrons?” box should be checked and the “Limit results to patrons in:” option should be set to “PINES.” If an identical name is found, compare the address, birth date, and other identifying information on the screen with the card application to determine if the patron is already registered in the system.

   - If you find the patron already has a record in the system, DO NOT create another record. Instead, update the existing record with the corrected information.
   - If the patron’s information is outdated, update the information. (See: Updating Accounts)
   - If a patron has lost his or her card, issue a replacement card. (See: Lost Cards)

2. **Create New Account:** If the name is NOT found in the database, open the Register Patron screen. The PINES user record can contain as many addresses as necessary, and notes and comments that display to all PINES facilities. Required fields are:

   - Barcode
   - OPAC/Staff Client User Name
   - Password
   - First Name
   - Middle Name is strongly encouraged but not required.
   - Last Name
   - Date of Birth
   - Primary Identification Type (and information)
   - Home Library
   - Main (Profile) Permission Group (See: User Permission Groups)
   - Privilege Expiration Date
   - Internet Access Level
   - Address (Type, Postal Code, Street (1), City
   - Response to the Voter Registration Survey Question (See: Voter Registration Survey)
   - See Also: Account Registration Field Descriptions

   Staff should not enter “placeholder” information (e.g. “N/A”, “No Middle Name”, “NMI” or the like) in any field when registering a patron. Please avoid punctuation such as quotation marks (i.e., James “Jimmy” Jones) or parentheses (i.e. Martin (Alan) Smith) to indicate nicknames or preferred names. Unnecessary spaces, misplaced apostrophes, and other typing errors can cause the search for a patron to return incorrect results. If staff wishes to record a nickname for local use, it could be added to the Alerts field.

3. **Save:** When you are finished entering the patron’s information, click the Save button and ask the patron to sign on the signature strip on the PINES card. It is a local decision on the part of each Library System whether the PINES card will be given to the user at registration or be mailed [1999.10]. Consult your circulation supervisor for the policy at your library.
4. Records Retention: Follow local policy for storing signed applications. (See: Record Retention Policies)

## Patron Self-Registration Form

PINES rolled out a new automated e-card registration process on September 8, 2020. This eliminates the previous pending patron account process to provide better service to patrons and reduce work for library staff.

1. When a patron successfully submits the online application form (Patron Self-Registration Form), the system creates an account which provides immediate access to e-resources. This account is valid for 1 year, but does not allow holds or checkouts.
2. To obtain a full PINES card, the patron will come into the library and provide their e-card number and proof of ID.
3. Staff should then:
   1. Check for duplicate accounts.
   2. Check the provided ID/documentation to verify that the information on the account is correct and up to date.
   3. Give the patron a PINES card and update the barcode in the account.
   4. Change the permission group from Quipu to Patron.

## Cloning a Patron with the Same Address

When a member of a family residing at the same household as an existing member is registering for an account, the Save and Clone function can be used. The cloned patrons will automatically be grouped with the first patron.

1. Register the first family member using the procedure outlined above (or, Edit the account of an existing family member).
2. Click Save and Clone.
3. Complete the patron information as normal, modifying the information that was filled in automatically as needed.

## Sample Registration Forms

- Sample Patron Form 1 (Text Only):
  - English
  - Spanish
- Sample Patron Form 2 (Formatted):
  - Editable Word Document
  - PDF Form
- Sample Institution Forms:
  
  | Sample 1 |
  | Sample 2 |

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: **2023/02/08 09:29**
Patron Registration Form Field Descriptions

- **Barcode** - Staff should scan the library card barcode to enter. Accounts created for staff use only may be given a unique identifier (Example: CLAYTN-HQSCIR1) other than a barcode.
- **OPAC/Staff Client User Name** - The username field will be populated with the library card number by default. Users may later choose to change their username to a text name via the OPAC.
- **Password/Verify Password** - The password will be set to the last four digits of the first phone number provided after it is entered. If the patron does not have a phone, the system will create a randomly-generated PIN. Staff should provide the PIN to the patron with instructions to set a new password for themselves via the OPAC and encourage them to do so as soon as possible.
- **Primary Name (ie, Legal Name)**
  - **Prefix/Title** - Optional (Use for Mr., Ms., Dr., etc.)
  - **First Name/Middle Name/Last Name** - Staff should enter names with an initial capital letter and lowercase letters following (e.g., Jacky or Young). Use apostrophes in names as appropriate. (e.g. O’Connor). Because of the large size of the PINES patron database, staff are strongly encouraged to enter full first, middle and last names. The legal name of the patron should be entered as shown on their ID. No nicknames should be added or listed here (see Preferred Name and Name Keywords below). If the patron has a single name (one word or one letter), enter that name in both the First Name and the Last Name fields [2013.12].

If the patron does not have a middle name, leave the field blank. Do **not** enter “NMN” or “No Middle Name.” If you wish, you may add a note on the account that the patron does not have a middle name.

- **Suffix** - Optional. The suffix of names with Sr., Jr., III, should be entered in this field.
- **Preferred Name**
  - The same fields are available in the Preferred Name tab as in the Primary Name tab. Use to enter the name that the patron prefers to be known by if it is different than the legal name (nickname, middle name, alternate name, etc.) This name will appear in the patron's OPAC “My Account” view, on Hold Slips, and on the Patron Summary Bar underneath the legal name. [Feature added 2019.01]
- **Name Keywords** - Optional. Use this field to store other names the patron is or has been known by, previous married names, or other keywords which should be searchable. For example, your library may wish to enter ‘fol’ for all of your patrons who are members of your Friends of the Library group. These words may be searched in the new Keyword patron search field. [Feature added 2019.01]
- **OPAC/Staff Client Holds Alias** - This field is provided as a privacy measure for patrons who would not like their actual name to be used on hold slips (this is configurable by your Local System Administrator). PINES/GPLS staff does not recommend the use of this field at this time.
- **Date of Birth** - Staff may enter the birthdate manually in the format MM/DD/YYYY, or may use the supplied calendar tool to enter the date automatically. Birth date is a required field [2010.02]. For cases in which the patron date of birth is unknown, staff will enter the dummy date “01/01/1901” to allow the patron record to be saved [2011.09].
- **Juvenile** - This checkbox will automatically be checked if the birthdate entered indicates that the
patron is under 18 years old [2006.05]. If the patron is a juvenile, the Parent/Guardian field must be filled out (at the time of this documentation, the Evergreen software does not require the Parent/Guardian field, but this policy indicates that it should be).

- **Parent/Guardian** – This field is required for juvenile accounts, as the person signing the application form for the juvenile is accepting responsibility for that library card.

**Best Practice:** Enter the parent or guardian's name followed by the relationship (“Jane Smith, Mom”). The parent or guardian's ID should be entered in the Primary Identification field.

- **Primary Identification Type** - Staff may choose either Driver's License or Other from the dropdown menu. PINES prohibits the use of patron Social Security Numbers for identification [2006.11].

- **Primary Identification** -

  Staff should enter driver's license number in the specified format (GA-XXXXXXXXX), substituting the appropriate state abbreviation (e.g., FL, AL, SC, TN) for non-Georgia drivers licenses. If the driver's license was not used for primary identification, enter relevant information and explain in the Alert Message field if necessary.

**Driver's License Format:** It is crucial that driver's licenses are entered in a consistent format in order to alert staff to duplicate accounts. All driver's licenses should begin with the two-letter state abbreviation followed by a dash and then the number (“GA-123456789”).

**Best Practice:** If the ID is a driver's license from a state that uses dashes or other characters, enter it as the two-letter state abbreviation followed by a dash and then the number as it is typed on the ID (“FL-123-456-78-9-0”). See also: State DL Format Guide

**Best Practice:** If the ID used is not a driver's license, enter the unique alpha-numeric portion of the ID and then follow it by a brief description of the type of ID. For example, “123456789 Military” or “123456789 US Passport”. This way, if that ID is presented again at a later date, the staff can search just for the first portion (“123456789”) without needing to know exactly how the description was entered.

**Best Practice:** If the ID belongs to a parent or guardian, enter their name in the Parent/Guardian field and their ID followed by a descriptive note in the ID field. For example: GA-123456789 (Parent's ID)
- **Secondary Identification Type** - Use only when a second piece of identification is required.
- **Secondary Identification** - Use only when a second piece of identification is required.
- **Email Address** - Staff should encourage PINES users to provide email addresses for the benefit of receiving automated hold, overdue, and preminder (preoverdue reminder) notices. An email address stored in the system also allows the patron to use the automated “Forgot your password?” feature in the OPAC. (NOTE: If an email address is entered, the patron will receive overdue notices, as well as holds notices, via email. Final overdue notices will be mailed via U.S. Mail as required by Georgia law).

If the patron does not provide an email address, leave the field BLANK and UNCHECK the Email option in the Hold Notification Preferences section.

- **Email checkout receipts by default?** - If this box is checked, patron will automatically receive emails instead of printed receipts at checkout time. (Staff may choose to print out a copy as well.) [Feature added 2018.01]
- **Daytime Phone** - Day telephone number including area code. This is the patron’s preferred phone number of contact and will be used for automated telephone notifications. When setting up a new account, Evergreen will automatically assign the last four digits of this phone number as the patron’s initial PIN for online account access.
- **Evening Phone** - Night telephone number including area code.
- **Other Phone** - Telephone number (usually, cell phone) including area code.
- **Home Library** - Users will have system-wide borrowing privileges yet belong to a “home” library. Staff will designate the home library when they enter the user record in PINES. This field will default to the PINES location at which the user account is being entered.
- **Main (Profile) Permission Group** - The patron profile determines the user’s loan period and fine rates. One of the profiles below will be assigned to each user. Some library systems may choose not to use certain profiles (for example, Friend or Trustee). Library systems may also wish to direct Circulation staff to seek approval from a manager before assigning certain profiles (such as Homebound or GLS) – this would be a matter of local policy rather than a permissions setting in the system. (See: User Permission Groups)
- **Privilege Expiration Date** - Automatically set based on the Profile Group, but may be edited by staff to a closer date if necessary. The date should not be entered for a later date than that which is automatically selected.
- **Internet Access Level** - Defaults to Filtered, but may be set to Unfiltered or No Access.
- **Active** - Checked by default. If unchecked, the patron is no longer considered an active PINES patron and will no longer be included in statistical reports. (See: Inactive Patrons)
- **Barred** - (See: Barred Patrons)
- **Is Group Lead Account** - Unchecked by default. If multiple patrons are grouped together (example: a parent with children), one patron in the group will be the lead account.
- **Claims Returned Count** - Shows the number of items marked Claims Returned that the patron has accrued. After accruing 5 Claims Returned items, the patron may not have any more items set Claims Returned [1999.10]. This count may be reset by editing the patron record.
- **Claims Never Checked Out Count** - This feature is not used in PINES [2012.03].
- **Alert Message** - Staff may enter an alert message that will appear when the account is retrieved.
- **Default Hold Pickup Location** - If set, holds placed for this patron will default to be delivered to this location. May or may not be the same as the Home Library.
- **Default Phone Number** - Default phone number to be called when a hold is available for pickup (optional).
- **Default SMS/Text Number** - Default phone number to be used if SMS/Text notification option is selected for a hold.
- **Default SMS/Text Carrier** - Phone service provider that the patron’s Default SMS/Text Number is associated with. Some carriers are not listed because they will not accept SMS messages from the Evergreen server.
- **Collections: Exempt** - This feature is not used in PINES.
- **Hold is Behind Circ Desk** - For patrons who pick up holds at a library branch that places holds for pickup in a public area by default and who are concerned about privacy. If this box is checked, the patron’s holds will be stored behind the circulation desk and not in a public area.
- **Hold Notification Format** (Phone and/or Email) - Sets default contact preference when holds are available for pickup.

- **Address Fields**
  - **Postal Addressing Standards**
  - **Mailing / Billing** - Both are selected by default. An additional address may be selected if necessary.
  - **Type** - Defaults to “MAILING.” Staff must otherwise enter a short description of the address (e.g. “Lake House”). For addresses that were imported from PINES’ previous automation system, this field will be marked “LEGACY ADDRESS.”
  - **Postal Code** - Standard 5- or 9-digit postal codes are accepted. City, State, and County information are automatically populated for Georgia addresses when this field is entered (NOTE: the automatically entered information should be checked for accuracy, particularly when one postal code covers portions of more than one city).
  - **Street (1)** - The number and street for the address.
  - **Street (2)** - Apartment, Lot, Suite, or additional address information.
  - **City** - City of residence.
  - **County** - County of residence (optional, but auto-populated by Postal Code entry). Although optional, this is useful for statistical reports.
  - **State** - State of residence (if a Georgia Postal Code is entered, defaults to GA).
  - **Country** - Country of residence (defaults to USA).
  - **Valid Address?** - Checked by default. May be edited if an address is found to be invalid.
  - **Within City Limits?** - Based on patron-provided information, staff may uncheck this box or leave it checked (checked by default). This is useful for statistical reports.
  - **New Address** - Additional addresses may be added as needed. Addresses may also be deleted, but the primary address may not be deleted. Note: For accounts that are grouped, the owner of the address must be edited with the correct address or the patron must be removed from the group to change a single patron’s address.

- **Statistical Categories** - The purpose of statistical categories is to establish controlled vocabulary that describes an individual user’s special characteristics for statistical analysis of circulation and registration. The “Non-English Primary Language” category was determined to be a universal statistical category in the PINES patron record [2006.05]. PINES does not require the use of statistical categories. They may be created by individual library systems as needed by the Local System Administrator.

- **Voter Registration** - PINES uses the Survey function to electronically record patron voter registration responses to be in compliance with Georgia law. (See: [Voter Registration Survey](#))

- **Additional Surveys** - Additional Surveys may be created at the local library system level by the Local System Administrator.
User Permission Groups

Each patron and staff account is assigned to a permission group (type of account) that controls what functions they can use and circulation rules may apply.

Patrons Permission Groups

- **Patron** - Normal users. Privilege is two years. This user will be blocked if a total of $10 or more is owed. User is billable [1999.05]. User may have up to 50 holds at a time. This profile can also be used for users who live out-of-state but work, attend school, or own property within Georgia.

- **Digital Only** - This permission group provides access to electronic materials (databases, ebooks, etc.) that the library provides, but does not allow checkout of physical materials. Privilege is one year. This account type may be used at the library's discretion for cards that are created for students in partnership with schools, for deployed military, for patrons who cannot come into the library and/or only wish access to digital materials, and for patrons that are experiencing homelessness. [Pilot began May 2017. Updated May 2018. Updated May 2019.]
  - See also: More information about Digital Only accounts

- **Friend** – A library user who is a member of a local Friends of the Library organization. Privilege is one year. User is billable, and has same use parameters as the Patron profile.

- **GLS** – This profile type is restricted to patrons who are already registered with GLS and have a KLAS ID number. PINES staff can create these accounts, but most will be created and managed by AMLAS staff. GLS users are allowed up to 50 checkouts at a time. Privilege is for two years. Standard checkout period is for 30 days with 1 renewal. Homebound users are not billed overdue fines, but will be charged for lost, damaged, or long overdue items. 15 holds are allowed at once. GLS users may place holds on DVDs that have descriptive audio tracks and on large-print books, and these items will be routed to the AMLAS office (STATELIB-B) for packaging and shipping through the United States Postal Service’s Free Matter for the Blind program. [2014.05 and 2014.07]
  - See also: GLS Patron Profile Instructions

- **Homebound** – Homebound users are individuals who are unable to visit a library in person without great difficulty and who either have materials delivered to them by a library’s outreach department or picked up for them by a designated representative. Cards should not be issued to users that live outside of a library’s service area. Individuals who assist the Homebound user by picking up materials from the library on behalf of the Homebound user should be listed in the account’s Alert field. Homebound users are allowed up to 50 checkouts at a time. Privilege is for two years. Standard checkout period is for 30 days with 1 renewal. Homebound users are not billed overdue fines, but will be charged for lost, damaged, or long overdue items. 15 holds are allowed at once. [2014.05]
  - Each Library System's Director shall determine which of their staff members are permitted to create user accounts with the Homebound profile.
  - Libraries may use discretion in the case of a user who is able to visit the library but may need longer than a normal check-out period to process information.
  - Each library system shall determine whether Homebound cards are kept at the library or kept by the user or user’s representative.
Because each library system may decide how long to keep its own items on their own holds shelf, a library system may choose to decide to keep their own items for Homebound patrons on their holds shelf for a longer period of time to better assist patrons who are unable to pick up the items quickly. Libraries should not keep items from a different library system on their holds shelf longer than the standard maximum of 7 days.

- **Institution** – A library system may choose to issue an Institution card to any institution or organization with a regular daily population that is housed long term. Examples include school media centers, day care centers, nursing homes, assisting living facilities, and jails [2014.12]. Each library system shall develop an application form different from the standard patron application form that enters the institution into a legal contract with the library ensuring that the institution will take responsibility for any fines and fees. The application form must be signed by an authorized representative of the institution and should be approved by the Library System Director or an authorized representative of the library system. A library system should not issue an Institution card to any institution located outside the library’s service area.

  - Example Form 1
  - Example Form 2
  - Example Form 3
  - Example Form 4
  - Example Form 5

- When entering data into the account registration form, the name of the primary representative of the institution should be entered as the name on the account. The Institution’s name should be entered as the first line of the Address. Any representatives of the institution who are authorized to check out materials on that card should be listed in the account’s Alert field.

- Privilege limit is 1 year. This user will be blocked if a total of $10 or more is owed. User is not billed overdue charges, but is billed for Lost, Damaged, and Long Overdue items. User may have up to 50 items checked out at a time. User may have up to 50 holds at a time. Circulation period is 42 days with no renewals [2015.05]. Note: The 42-day circulation period was implemented 5/4/2015. Items checked out prior to this have a 30-day circulation period.

- Library systems may choose to store an Institution’s physical card at the library.

- **NonResident** – A library user who resides in the state of Georgia, but outside of the areas served by PINES libraries. Privilege is one year. This user will be blocked if a total of $10 or more is owed. User is billable. User may have up to 50 holds at a time.

- **OutOfState** – A library user who resides out-of-state. Privilege fee is $25. Privilege limit is 1 year. This user will be blocked if a total of $10 or more is owed. User is billable. User may have up to 50 holds at a time.

- **PaymentPlan** – Temporary status for individuals making payments on fees that would otherwise automatically go to collections. A library system can notify the collection agency not to pull patrons with this profile. The profile should be returned to a permanent status after full payment of the fee. User has identical privileges to Patron profile [2008.11].

- **PLAY Card** - This permission group should only be used during the automated batch loading of student accounts by PINES. PLAY cards are limited to five checkouts at a time and to two holds at a time. Users are not charged overdue fines, but can be billed for lost, long overdue, and damaged materials as normal. Parents/guardians are responsible for these fines. The patron's home library will be responsible for lost or damaged materials and long-overdue fines not recovered by other libraries for their materials. The account expires after one year. [Pilot approved 2018.12, became available 2019.02, modified 2019.12, made permanent 2021.05.]
- **PLAY Card Documentation**

  - **Quipu** - Patrons who register online get assigned a Quipu e-card that provides immediate access to e-resources, but no holds or checkouts. The account expires after 1 year. Patrons may upgrade to a full Patron card by coming into a library and presenting their ID/proof of address.

  - **Restricted** - A library user with restricted library use. Privilege limit is 1 year. This user may have only 2 items checked out simultaneously. This user will be blocked after 1 overdue item and if a total of $0.01 is owed. User is billable. User may have up to 5 simultaneous holds.

  **Restricted** cards are intended for temporary or probationary purposes. This may include seasonal workers, RV park residents, the homeless or in lieu of fully barring a patron from library use.

  PINES should accept as proof of residency, a letter on official letterhead from agencies serving the homeless, temporary group homes (such as family violence shelters), and similar institutions.

- **StaffNoPerm** - A library user who has staff member privileges on borrowing items, but does not have staff-level permissions [2009.05].

- **Temp** - A library user who resides in the area for a limited period of time, but lives permanently outside of the state. Privilege limit is 6 months. Privilege fee will be $12.50 of the fee charged for OutOfState users. This card carries limited borrowing privileges. This user may check out up to 5 items simultaneously. This user will be blocked after 1 overdue item and if a total of $0.01 is owed. User is billable. User may have up to 5 simultaneous holds.

- **TempRes6** - A library user 18 years of age or older. User has identical privileges to Patron profile, except that privilege expires after 6 months, and card must be renewed at that interval. This profile may be used for college students or military personnel who move frequently. There is no fee to receive this card.

- **TempRes12** - A library user 18 years of age or older. User has identical privileges to Patron profile, except that privilege expires after 12 months, and card must be renewed at that interval. This profile may be used for college students or military personnel who move frequently. There is no fee to receive this card.

- **Trustee** - A library user who is a member of a Library’s Board of Trustees. Privilege is 2 years. User is not billable. Same use parameters as Patron profile.

### Staff Permission Groups

Each staff member should generally be given the lowest level permission group which allows them to manage their responsibilities. Additional permissions may be granted to an individual to increase their access without moving them to a higher permission group (for example, a CIRC1 may also be granted the ability to create and run reports), but specific permissions cannot be removed from an individual without moving them to a lower permission group.

The Director of each library system must designate a Cat1 and a LocalAdmin. Those accounts can only be set up and updated by PINES staff. The LocalAdmin will manage the rest of that library system's
accounts.

**Chart of Staff Permissions**

All staff accounts must have at least one Working Location set or some features of the staff client will not work properly. Working locations are set under Administration > User Permission Editor or from within the account at Other > User Permission Editor.

- **Acquisitions**
  - ACQUADMIN, ACQFIN, ACQLIST, ACQREC, ACQSEL - Permissions are assigned and explained by PINES staff during Acquisitions training

- **Cataloging**
  - CatCoord - Library staff must complete the CatCoord Certification and must have completed the Cat1 training with PINES staff. Each library system must have a designated CatCoord, who can perform reporting, workstation, and shelving location tasks in addition to cataloging functions. CatCoord accounts can only be updated by PINES staff at the request of the library system's Director.
  - Cat1 - Library staff must be trained by PINES staff prior to being given Cat1 permission, and each library system must have a designated Cat1 who is responsible for overseeing all of that library system's cataloging functions. Cat1 accounts can only be updated by PINES staff at the request of the library system's Director.
  - Cat2, Cat3 - Other technical services staff whose permissions are managed by a library system's Cat1.

- **Circulation**
  - LibraryManager - Each library system designates LibraryManagers (usually branch managers or circulation department managers) who have all circulation-related permissions. These accounts are managed by a library system's LocalAdmin.
  - Circ1, Circ2, Circ3, Circ4 - Varying levels of circulation staff. These accounts are managed by a library system's LocalAdmin.

- **LocalAdmin**
  - Each library system designates a LocalAdmin (usually the library system's technical lead / system's administrator).

**Permission Groups No Longer In Use**

- **Class** - This is no longer used in PINES [2003.02].
- **Homeschool** – The Executive Committee rejected the creation of a new Homeschool profile with additional permissions beyond that of a standard Patron profile [2014.05]. Homeschool students should be assigned the standard Patron profile.
- **Outreach** – This is no longer used in PINES [2014.12].
Digital Only Accounts

About Digital Only Accounts

This profile type was originally restricted to students whose schools have partnered with a PINES library to register them for library cards. The library cards are restricted to one year (ie, the school year), and do not allow holds or circulation of physical materials. The cards only allow access to online materials that are available through the library.

A Memorandum of Understanding should exist between each library and school that participates in this program.

The Digital Only account can be converted to a full Patron account if the patron visits the library with a parent or guardian, or if the patron has turned 18 and visits the library to update the account information.

A pilot was begun May of 2017 and the Executive Committee chose to make it a permanent account type May of 2018.

In May of 2019, the account type was expanded to allow use as needed for deployed military, for patrons who are unable to visit the library and only wish to check out digital materials, and for people experiencing homelessness.

Best Practices Registering New Student Accounts

1. Sign up

   - School collects parent permission forms and student data. (The standard library card registration form can be used, or the library can create a customized form for this purpose.)
   - School delivers forms/data to the partner library.

2. Account Creation

   - Library creates Digital Only accounts.
     - At this time, this must be done individually. No batch processing is available.
     - Library may wish to include the school name in an alert field.
   - Library packages each new card so that it can be delivered to the school. This package should include the students name, password, welcome information, and routing information so that it can be delivered to the appropriate school and teacher/office.
3. Delivery

- The library delivers the library cards to the school and the school distributes them to the students.
- The system will email the standard welcome notice to any student that has an email address included on his or her account.

**Best Practices for Batch Renewals**

This process will save staff time by allowing batch renewals of the student digital card accounts. This process should only be used for students that are remaining in the same school for the next school year, and at this time is limited to 100 accounts at a time.

**Generate a list of Digital Only accounts**

The easiest way to do this is to use a Quick Report: Patrons > List of Patrons or Staff by Permission Group

Export this list to an Excel file.

**Confirm which accounts should be renewed**

The school will need to provide a list of students that are continuing for another school year. This list can then be compared to the Excel file generated in step 1.

Remove any students from the Excel file that are not on the list of continuing students, leaving only the accounts which should be renewed.

**Export the barcodes**

Delete the table header row and all of the non-barcode columns from the Excel file, leaving only barcode data.

This barcode data will then need to be broken down into blocks of 100 accounts (note: this 100 account limitation will be removed at some point, but at this time, we need to work around it).

Save each block of 100 accounts as a CSV (Comma Separated Value) file.

**Create a User Bucket**

1. In Evergreen, go to Circulation > User Buckets.
2. Create a New Bucket called “Digital Card Renewals”.

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/
Add accounts to User Bucket

1. Switch to the Pending Users tab.
2. Click Browse and select the first CSV file.
3. You should see that the accounts have been imported (you may need to change the number of visible rows to 100).
4. Click on the Buckets dropdown and select the Digital Card Renewals bucket.
5. Select all of the accounts.
6. Click Actions > Add to Bucket

Batch renew accounts

* Note: In order to do this step, staff must have the CONTAINER_BATCH_UPDATE permission. LibraryManager and LocalAdmin accounts should have this permission automatically.

1. Switch to the Bucket View tab.
2. Select all accounts (you may need to change the number of visible rows to 100).
3. Click “Batch edit all users”.
4. The “Update all users” popup will appear.
5. Type in a name (eg, “Update expiration date”) 
6. Choose the new Privilege Expiration Date.
7. Click Apply Changes.
8. You should see green bars go across the screen as the accounts are updated.
9. Select all the accounts again.
10. Click Actions > Remove Selected Users from Bucket
11. Repeat steps 5 and 6 until all renewals are processed.
The Cards

A digital card design has been approved and can be ordered by the library, or the library may choose to use either the standard PINES card design or one of the approved children's card designs (see: http://pines.georgialibraries.org/cards).

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2019/05/13 15:12
PINES Staff Accounts

PINES library staff members are granted passwords for access to the PINES database via the Evergreen staff client. PINES member libraries are required to change PINES passwords once a year [2002.09], and at the library’s discretion when a key staff member with high-level access leaves, or if an employee leaves under hostile circumstances [2005.08].

Libraries may choose to use shared logins for circulation staff, but using individual logins for each staff member allows for better tracking and accountability. If a shared login is used, the password should be changed when anyone who uses that shared login leaves employment. If individual logins are used, the account should be changed from a staff account to a patron account if the staff member leaves employment.

Staff with a 'Library Manager' account may update circulation staff accounts. Staff with a 'Local Admin' account may update all other types of accounts except CatCoord and Cat1 accounts. Local Admin accounts may only be created by PINES staff at the request of the library director after the staff member has successfully completed the required local admin certification, and Cat1 accounts may only be created after a staff member has successfully completed required Cat1 training. CatCoord accounts require Cat1 training as well as the completion of the CatCoord certification. Staff with Local Admin, CatCoord, or Cat1 accounts should submit help desk requests when the accounts need to be renewed or otherwise updated.

As of the January 2023 Evergreen upgrade, staff will not be able to log in to the staff client with an expired account. Most account types expire after 2 years and will need to be renewed by library staff or by submitting a help desk ticket.

Although staff members cannot edit their own accounts in the staff client, they may log in to the My Account portion of the online catalog to update their password, search preferences, etc.

In the event of presentation of a National Security/FBI letter requesting information under the PATRIOT ACT, any PINES Director may give his/her system password access to PINES [2006.01].

⚠️ Staff need to have at least one Working Location set. To set the working location, go to the staff account and click Other > User Permission Editor, then select the appropriate location(s).

⚠️ Staff should read, agree to, and sign the PINES Code of Ethics.

See also: Staff Permission Groups (aka Profiles)
When A Staff Member Leaves Employment

When a PINES staff member leaves employment, his or her account should be immediately changed from a staff permission group to the standard Patron permission group. The secondary permission group should also be checked and removed to ensure that no other staff permission group is assigned to the account. The email address and other contact info should be updated to reflect personal rather than business information.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:
https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:accounts:staff

Last update: 2023/01/17 13:29
PINES Permissions Chart

See the attached spreadsheet to determine which PINES Permission Group has which specific staff rights in the Evergreen software. Each staff member should generally be given the lowest level permission group which allows them to manage their responsibilities. Additional permissions may be granted to an individual to increase their access without moving them to a higher permission group (for example, a CIRC1 may also be granted the ability to create and run reports), but specific permissions cannot be removed from an individual without moving them to a lower permission group.

- permissions_list.xlsx

As of January 2023, PINES is completing a comprehensive permissions review. The above chart may be slightly outdated until the review is complete.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/01/12 16:53
Creating Staff Users and Assigning Permission Profiles

Local Admins have overall responsibility for creating, updating, and maintaining all staff accounts for their system except for CatCoord, Cat1, and LocalAdmin accounts. CatCoord, Cat1, and LocalAdmin accounts may only be created and updated by PINES staff at the request of the library system's director. CatCoord and Cat1 accounts require specialized training by the PINES Cataloging Specialist before being created.

The PINES/GPLS staff strongly recommend the use of personalized Evergreen accounts for logging into staff functions. This eases troubleshooting and allows library staff to audit particular staff members actions, and provides a more secure and accountable system. Use of generic logins (e.g., “WGRL-HQ-Circ1” and the like), is strongly discouraged.

- Types of Staff Permission Groups
- Policies Regarding Staff Accounts
- Permissions Spreadsheet

It is important to remind library staff members that their personal library cards and their staff accounts are one and the same. Some staff users have gotten confused when they change their password via the OPAC and are then unable to login to the staff client, for instance.

Hierarchical Permission Structure

Evergreen employs a hierarchical permissions structure in which “child” groups inherit permissions settings from “parent” groups. The basic group is “User”, which contains all Evergreen users. Above the “User” level are subcategories, including “Staff,” which contains a set of permissions that is inherited by all “Staff” group members. “Staff” is subdivided into “Administrator,” “Cataloger,” and “Circulator,” and each of these levels may also contain permissions that are inherited by their subgroup members. In the case of the “Administrator” group, a base set of administrative permissions is granted to the “GlobalAdmin,” “LocalAdmin,” and “Library Manager” permissions groups, which are then assigned to individual users. See the diagram below for a visual representation of this structure.
Assigning a permissions group to a user grants them all of the permissions in the tree. This means that a LibraryManager assignment equates to granting all permissions in User + Staff + Administrator + LibraryManager, inclusive.

Permissions Scopes

Evergreen permissions are “scoped,” meaning that “boundaries” are set to limit staff actions to a single system or branch. In PINES, there are three scopes:

1. Consortium: the permission applies to the staff member at any location in PINES.
2. System: the permission applies to any location within the library PINES Local System system at which the staff member works.
3. Branch: the permission applies to the individual library at which the staff member works.

Adding Custom Permissions

Staff users are assigned a set of permissions and, for the Administrator class of users, some of those permissions are grantable. A grantable permission is one that an administrative user can grant individually to a single user. This is done in the Administration > User Permission Editor interface by entering the user's library card barcode and adding checkboxes beside the appropriate permissions.

Though LocalAdmins have the ability to grant permissions, PINES/GPLS staff recommends caution when doing so, as customized permissions may cause problems down the line. For example, if a staff member changes employment positions at a library, their permissions profile group may change, but any custom permissions will continue to be assigned unless manually removed by the LocalAdmin. It would be beneficial to keep a record of such individualized changes.

Locally assigned permissions override permissions assigned “higher up” in the hierarchy. For example, if
the Circ2 profile has VIEW_USER assigned at the Consortium scope, and you assign that same permission to a specific Circ2 at the Branch scope, that staff member will be limited to viewing/accessing user accounts at their branch.

Permissions assigned at the permissions profile group level are not able to be removed on a per-user basis. LocalAdmins must assign a profile with fewer permissions to decrease the permissions level of a user.

**Context Matters: Working Location and Workstation**

**Working Location**

Evergreen permissions rely on the user's "working location" which is set under Administration > User Permissions Editor (or, from the staff person's account page under Other > User Permissions Editor).

For staff such as LocalAdmins or Cat1s, who may need to administer or perform work at more than one location, each relevant location must be selected.

**Workstation**

The other context Evergreen uses is the workstation location. See Workstation Documentation for more information.

**Personal Device Policy**

If an employee needs to use a personal device to access the PINES staff client or PINES data, see:

PINES Personal Device Policy
Renewing & Updating Patron Accounts

Updating a Patron Record

To edit a user record, retrieve the patron record (Search > Search for Patrons). Verify that all information is up to date and in the correct format. See: Patron Registration Field Descriptions

Card Expiration and Renewal

Most types of PINES cards are valid for 2 years. The system will notify staff that a card is about to expire (within 30 days) or has already expired by placing an alert on the patron record which displays whenever the patron record is retrieved. Patrons can see their own expiration dates when logging into “My Account” via the OPAC. Patrons that include an email address in their account will be sent an automated courtesy notice 30 days prior to their account expiration date.

At renewal time, staff should ask to see current identification and update the patron’s information (address, phone number, etc.) This is a good time to add or update the patron’s email address, and confirm that the user’s full name is entered. Be sure to correct any typos or capitalization problems in the record, and verify that the Driver's License is in the correct format (GA-123456789).

⚠️ The patron must resolve all outstanding fines and fees in order to renew her/his card. [2009.12]

If a user’s account is set to expire during the proposed renewal period for items, Evergreen will not allow an item renewal past the patron expiration date.

Online Account Renewal (Coming Soon!)

This online patron account renewal proposal was approved by the PINES Executive Committee September of 2021 and software development is currently underway. This section will be updated when the new feature becomes available in the Spring of 2023.

An online account renewal form will be available to patrons through the “My Account” section of the OPAC if the following conditions are met:

- The patron account is active and the expiration date is no more than 30 days in the future.
- The patron's permission group is either Patron, Friend, GLS, Homebound, Quipu, or Trustee.
- The patron's account is in good standing (no outstanding bills, no blocks, is not barred, has not...
been flagged with an invalid address or phone number).
- The patron has not already been given a temporary renewal.

If the patron does not have an address change, the account will be renewed without requiring the patron to come into the library. If the patron does have an address change, the account will be given a 30-day temporary renewal and the patron will be required to come into the library with their proof of address so that staff may verify it and fully renew the account. (Homebound and GLS patrons are exempted from this requirement.)

**Temporary Renewals**

If a patron is eligible to renew their account online but their address has changed, they will automatically be given a 30 day temporary renewal and be directed to visit a PINES library with their proof of address for a full renewal term.

A patron note will be automatically added to their account which will alert staff to the fact that the patron has already received a temporary renewal. This note will prevent the patron from submitting another temporary renewal.

When the patron comes into the library to complete their account renewal, staff should:

1. Verify the patron's new proof of address
2. Update the patron's account expiration date
3. Remove or archive the patron note

**Incorrect Addresses**

When mail is returned to the library due to an incorrect address, the patron’s address should be marked as invalid. These users will then be omitted from the overdue notice reports.

1. In order to identify the users who need corrected address information, the “valid” checkbox beside the address in the user record must be unchecked. Staff should do this whenever mail is returned.
2. The patron record will be marked with an (Invalid Address) message.
3. Once this procedure is under way, each library may periodically wish to run a report of users with invalid addresses, in order to determine which items are still checked out and presumed lost, in case those items should be discarded.

**When a PINES Patron Moves to Another PINES Library System**

If a patron moves from one PINES library system to another, change the home library of the patron from the old library system to the new library system and update address, telephone numbers, and hold pickup location in the patron record. The patron may keep the same card if they wish to, however it is recommended that staff replace the patron's card with one from the new library system, as electronic reference database access is often based on patron card number. (Please note that the $2 card replacement fee is waived in this scenario.) Although it won't count as a new registration, the patron will now be included in reports of all patrons registered in the new library system.
If a patron moves from one library to another within the same system, the home library and hold pickup location should be changed in the patron record and the address and telephone information should be updated.

Georgia law mandates that library staff offer patrons the opportunity to register to vote when receiving or making changes to their library accounts.

**Patron Record Deletion / Deceased Patrons**

Evergreen contains a feature that allows the complete deletion of patron accounts, but this is restricted to extreme cases and may only be performed by PINES staff at the request of a library director.

In the case of deceased patrons, the best practice is to:

- Change the name on the patron account to first name “Deceased” and last name “Patron”
- Delete the driver's license number or ID, as well as any other personally identifiable information.
- Mark the phone number and email address (if present) as invalid.
- Change the account expiration date to a past date.
- Uncheck the Active box.
- Change the password so that no one is able to log into the account from the OPAC.

This will effectively anonymize that person's account without affecting circulation or billing history.

**When A Staff Member Leaves Employment**

When a PINES staff member leaves employment, his or her account should be immediately changed from a staff permission group to the standard Patron permission group. The email address and other contact info should be updated to reflect personal rather than business information.
Voter Registration Survey

PINES libraries will keep records of voter registration and declination electronically within the PINES user record. Each time a user record is created or modified, a patron must be asked if he/she wishes to register to vote, and his/her decision must be recorded in the designated field.

PINES libraries should include the following question on the PINES card application: If you aren’t registered to vote, would you like to register to vote here today? Select one:

- I am already registered to vote
- I want to register to vote
- I do not want to register to vote
- I do not wish to register to vote, but will take a registration form home
- I am not eligible to vote

All public libraries are required to keep this information for two (2) years by the Georgia Secretary of State’s office. Georgia public libraries must continue to follow all rules and requirements of the Motor Voter Act as specified by the Georgia Secretary of State’s Office.

Mailing in Voter Registration Applications

To ensure timely processing of applications, completed voter registration applications must be mailed to the Secretary of State's office:

- Election calendars can be found at: http://www.sos.ga.gov/page/elections-and-voter-registration-calendars
- If you do not have any completed applications, you do not need to submit anything to the Secretary of State’s office.
- Mail the applications in the pre-paid envelope provided by the Secretary of State’s office. You may either include a daily recap sheet (or similar agency identifying sheet) with your submittal, or you may print or stamp the following on the pre-paid envelope:
  - Supervisor and Facility Name
  - Address
  - Phone Number

Information from the head of the Elections Division of the Secretary of State's office given to the State Librarian:
If an individual registering to vote does not have ID, you should accept the registration and submit it. The best practice is to take whatever they give you; it is their responsibility, not yours, to ensure proper completion of the form and presentation of ID. The county registration office will flag the account, and the voter will be required to show ID upon first instance of voting.

### Reporting Registration and Declination Numbers

The Secretary of State's web page for Public Libraries is currently down. The Agency Recap Form can be accessed here if you would like to make a copy to edit. For any other order requests (e.g., Voter Registration Forms), please feel free to reach out to Dr. Jesse Harris directly through email. His information is included below.

As of May 2022, the Secretary of State's Office advised that libraries must report numbers for those registering to vote and those declining - whether or not these reports are submitted with voter registration forms - using the Agency Recap Form furnished by the Secretary of State’s Office. *(To edit the form provided in the link, please make a copy in Google Docs or download as a Word file.)*

These numbers should be reported weekly, except in the period beginning 15 days prior to the registration deadlines when they must be reported daily. If you have no registrations or declinations to report for the week, you do not need to send in a recap form. When reporting weekly, the recap forms can be sent on Mondays for the previous week. There are two options for reporting this information:

1. Libraries can mail the Agency Recap Form to the Secretary of State's Office. If you are submitting the recap form with voter registration forms, please use this option.

2. Libraries may e-mail the Agency Recap Form to Dr. Jesse Harris at jharris@sos.ga.gov. (Dr. Harris can be reached by phone at 470-312-2742 if you have questions.)

If you wish to pull the numbers from the PINES database, you can use this report in PINES Quick Reports:

- Quick Reports > Patrons > Voter Registration Survey Responses

After running the report, you can filter for “Declined to register” to determine the declination count and “Registered today” to determine the registration count.

[Click here for a quick video on running the report.](#)

For more information regarding voter registration, check out the [Voter Registration FAQ for Libraries](#).
From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/12/27 12:50
**Inactive Patrons**

PINES will mark users “inactive” in the patron database three (3) years after the last use of a PINES library card, if the card has not been blocked [2002.12]. A server process runs nightly which identifies inactive patrons and marks them as such.

A PINES patron account is considered “inactive” if all of the following conditions are met:

- a patron has no items currently out.
- there are no bills on the patron’s account.
- there has been no activity such as circulations, renewals, check-ins, payment of bills, placement of holds for 3 or more years.

In keeping with current ideas about what constitutes library “use,” PINES also defines a user as “active” when she/he accesses any of the following non-circulation-related services with her/his library card [2008.11]:

- Use of library computers (unless “circulated”)
- In-library wi-fi access
- E-books or audiobook downloads
- GALILEO databases (whether or not authenticated through the OPAC).
- Logging into a user account in Evergreen

From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation


Last update: 2018/10/11 16:15
Blocked and Barred Patrons

User Status - Blocked

If a patron’s record is automatically blocked due to excessive fines ($10.00 or above), the patron's name will appear in red when the patron record is retrieved. The patron will not be able to check out or renew items until the reasons for the block are resolved.

Block reasons are recorded in the Messages section of the patron’s account. Blocks are automatically removed when the reason for the block is resolved. Blocks may also be manually removed by highlighting the block(s) and going to Actions for these Penalties > Remove from Patron.

A staff member may also create a manual block on a patrons account if necessary.

1. Retrieve the patron account.
2. Open the Messages tab.
3. Click the 'Apply Penalty / Message' button.
4. Select 'Block' as the Penalty Type.
5. Add a concise note explaining the block and how it can be removed.
6. Enter the staff member's first initial and last name in case there are any questions about the block.
7. Click OK.

User Status - Barred

Barred is a status that should be reserved for serious offenses, such as theft of library materials. Each Library Director or designee shall decide the circumstances under which a patron may be barred, and must enter the reason for the barring in an alert message (Notes > Create Note > Alert) on the patron account [1999.10]. This alert should also include the name of the library which barred the patron.

It is PINES policy that only the library that barred the patron can unbar said patron. If a barred patron presents items for checkout at other than the library that barred the patron, he/she should be directed to speak with that library to resolve outstanding issues and restore library privileges.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/01/13 12:59
Multiple Patron Accounts / Patron Record Merging

If a patron is discovered to have multiple accounts, the accounts may be merged. This facilitates patron database cleanup and helps to address the issue of outstanding charges on multiple accounts. To see a patron’s previously active cards, staff may click the See All button on the Patron Edit screen.

Patron record merging is restricted to PINES staff due to the intensive nature of the updates involved. Contact the PINES staff via the Help Desk with the accounts that should be merged and which of the accounts is current. PINES has configured patron merging to preserve all history on all merged records [2012.03].

Requesting an Account Merge

If you encounter two or more accounts that belong to the same patron, please submit a Help Desk ticket. We will need:

- Patron Barcodes (Indicate which one should be the “Lead” or primary barcode. If one of the accounts is in collections, then that account must be marked as the lead account.)
- Patron Name

Ideally, we would also appreciate:

- Patron Date of Birth
- Patron ID and/or Parent Information

If the account names or other identifying information do not match, please explain what criteria you used to identify them as the same patron. We will store this in the help desk in case for record-keeping purposes in case there are any questions in the future about why specific accounts were merged.
Lost / Stolen Cards

If a patron comes into the library and reports their PINES card lost or stolen, ask for ID to verify the name of the patron. Use the patron search function to search for and retrieve the patron record. Click Edit, then click the Replace Barcode button and assign a new card to the patron.

If a patron reports a card lost or stolen by telephone (or is otherwise not present), place a temporary Block on the account (Notes > Create Note > Block) until the patron is able to come into the library to pick up a new card. This will prevent anyone else who finds the card from using it.

There is no charge for a replacement card [2022.09].

*Historical Note: Between October 1999 - September 2022 the charge for a replacement card was $2.00.*

If the patron uses their card number as their username for PINES account access, consult with the patron as to whether the username should be updated to the new card number.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/02/08 16:19
Patron Messages and Alerts

Historical Note: Prior to January 18, 2022, patron alerts, messages, and notes were managed in three different interfaces.

**Alerts** (such as “Patron exceeds fine threshold”) may be added to a patron's account automatically by the PINES system, or may be added manually by staff. If a patron account has an alert, the alert title will appear in red under the patron's name on the upper left in the staff client. The patron's name will also turn red.

**Blocks** may also manually be added if necessary. A block appears the same as an alert in the interface, but will prevent the patron from checking out items, renewing items, and placing holds on items.

**Notes** that are not urgent, but contain information that the library wishes to retain for historical purposes, may be manually added by staff. If the patron account has a note, the patron's name will not turn red, but the Notes tab will indicate the number of total notes and messages.

Creating a New Message

To add a message to a patron account, open the account and click on the Notes tab, then click Create Note.
Select either the Note, Alert, or Block option. (Notice that when you change this option, the Penalty Type changes. This provides additional information about the type of message you have chosen.)

The Depth should be set to “All PINES Libraries” in most cases so that when the patron goes to any library location, the staff will see the same messages.

Check the “Patron Visible” box if the message should be visible to the patron when they log into the OPAC and view their messages.

Enter a title for the message, then the complete text of the message. If you are creating an alert, only the title will appear under the patron’s name in the patron summary bar.

Enter your first initial, last name, and location in the Initials box (for example, TMcCanna/STATELIB-A).

**Reviewing Existing Messages**

The Notes tab will display all previously created messages. Use the standard controls to change the visible columns and change the number of rows you see at once. Click on the column headers to sort columns (most staff will want to sort the Creation Date/Time column to show the most recent messages.)
Select a message and click Actions > Edit Note to view the complete details of the message and edit it. (Note that some types of messages may not be editable.)

You may also use Actions > Delete Note to permanently delete messages or Actions > Archive Note to move them to the Archived Notes section below. You may select multiple notes to Delete or Archive at once.

**Automatically Added Notes**

The system will also automatically leave notes in the Patron Message Center (see Automated Notifications).

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/07/08 15:11
Grouping Patrons

If a new patron is cloned from another patron (e.g., a child's card is cloned from a parent's card), they are automatically grouped together. You may also manually group different patrons together.

If you open the Group Member Details and no one (including the patron you are viewing) loads in the list, please refresh your browser window to get them to display.

Viewing a Group

1. Open a patron's account.
2. Click Other > Group Member Details.
3. The list of people in the group will appear.

Adding a Patron to a Group

1. Open one patron's account.
2. Click Other > Group Member Details.
3. Check the box next to the patron's name.
4. Click Actions.
5. Click Move Another Patron To This Group.
6. Enter the second patron's barcode number.
7. Click OK.

Removing a Patron from a Group

1. Open the account of a patron who is in the group, but who is not the member you wish to remove.
2. Click Other > Group Member Details.
3. Check the box next to the patron you wish to remove.
4. Click Actions.
5. Click Remove Selected From Group.

Group Fines

There are no PINES policies related to groups, but if members of a group have fines, the sum of all the fines will appear in the patron summary bar when any member of that group is opened.
<table>
<thead>
<tr>
<th>Profile</th>
<th>Patron</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Library</td>
<td>ARL-ATH</td>
</tr>
<tr>
<td>Net Access</td>
<td>Filtered</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>1/1/1980</td>
</tr>
<tr>
<td>Last Activity</td>
<td>4/11/2017</td>
</tr>
<tr>
<td>Last Updated</td>
<td>3/17/2017</td>
</tr>
<tr>
<td>Create Date</td>
<td>1/30/2017</td>
</tr>
<tr>
<td>Expire Date</td>
<td>1/30/2019</td>
</tr>
<tr>
<td>Fines Owed</td>
<td>$0.00</td>
</tr>
<tr>
<td><strong>Group Fines</strong></td>
<td><strong>$0.09</strong></td>
</tr>
<tr>
<td>Items Out</td>
<td>0</td>
</tr>
</tbody>
</table>

From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link: https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:accounts:families

Last update: 2022/03/10 10:07
User Buckets

User Buckets can be created to temporarily hold a group of patrons that need to be reviewed or updated. For example, you may wish to create a user bucket of potential duplicate patron accounts that you wish to review further, or a user bucket for a family that needs to have all of their addresses updated, or a user bucket for all new accounts that are created so that they can be double-checked for completeness later.

Adding Patrons to User Buckets

Patrons can be added to a User Bucket from the Patron Search Screen or the Circulation Menu.

Patron Search Screen

1. Perform a patron search.
2. Select the patron(s) to add to a bucket and click the Add To Bucket button.
3. Choose the bucket to add the patron to or create a new bucket.
4. A message will show at the bottom right of the screen that says, “X # of patrons have been added to bucket Y.”
5. To view the bucket open the Circulation menu and choose User Buckets.
6. In the Bucket View tab click the Buckets button and choose the bucket to view.

Circulation Menu

1. Open User Bucket from the Circulation menu.
2. In the Bucket View tab click the Buckets button and choose the bucket to add the patron(s) to or create a new bucket.
3. Leaving the bucket being used open in the Bucket View tab, click on the Pending Users tab.
4. Scan the patron barcode in the Barcode box. The patron will be added to the list below.
5. Highlight the patron and right click or use the Actions menu and select Add To Bucket.
6. Switch back to the Bucket View tab. You will see that the patron has been added to the open bucket.

Actions

Batch Edit All Users
Only staff with LibraryManager or LocalAdmin permissions can use the Batch Edit feature. Clicking on the Batch Edit All Users button allows you to update certain fields on all of the patrons in the current bucket at once. Give the update a name in the “Name for edit set” field and then you can update:

- Home Library
- Main Profile (Patron Permission Group)
- Internet Access Level
- Barred Flag
- Active Flag (PINES has scripts that run nightly to mark patrons active or inactive, so this will not typically be used by PINES staff)
- Juvenile Flag (PINES has scripts that run nightly to change juvenile accounts to adult accounts when they turn 18, so this will not typically be used by PINES staff)
- Privilege Expiration Date (Account expiration)

**View Batch Edits**

This allows you to see the list of batch edits that have already been done on the current bucket.

**Roll Back Batch Edit**

This allows you to select a previous batch edit that was done to the current bucket and undo it.
Batch Modify Statistical Categories

For those libraries that use patron stat cats, this will allow all patrons in the current bucket to be updated at once.

Individually Edit Selected Users

Select the patrons you wish to edit from the list and click on Actions > Individually Edit Selected Users. Each of the patron accounts you selected will open in a new tab.

Remove Selected Users From Bucket

Select the patrons you wish to remove from the current bucket and click Actions > Remove Selected Users From Bucket. The patrons you selected will be removed from the bucket.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2019/03/19 10:16
Searching for Patron Accounts

The patron search function can be accessed by the staff client home page (Search For Patron) or from the top menu (Search > Search for Patrons). If you only see a few name search fields when you go to the page, click the down arrow to the right of the search button to expand the section to see all available search fields. This option is “sticky,” meaning that it will save your preference on your workstation.

Most of the search fields are left-anchored. What this means for searching is that you can type in the first letters of a name and the search will retrieve name variants starting with those fields. For example, typing “kat” in the first name field will retrieve patrons with first names of Kat, Katherine, Kate, Katie, Katelyn, etc.

**Name Keyword Searching**
The Name Keywords search field is new as of 2019.01. This field may be used to search across First Name, Last Name, Middle Name, Preferred Name, and Name Keyword fields. For example, using the name keyword field to search for 'Carol James' should retrieve anyone named Carol James, Caroline James-Smith, James Carolton, etc.

**Filtering by Permission Group and Location**
In most situations, such as searching to see if a new patron already has a library card or not, you will want to search across all of PINES and all Profile Groups (aka, permission groups), and have the Include Inactive? box checked. However, you can see subsets - for example, to easily retrieve a list of all staff members registered in your library system), change Profile Group to “Staff” and change PINES to your system.

**Searching by Date of Birth**
If searching for a common name, it may be useful to filter your search results by birth date. If you know the exact birth date, you may enter it in the DOB Year, DOB Month (enter numerically, eg 9 for September), and DOB Day fields. If you know the year but not the month or day, just enter the year. If you are not sure of the year but think it is in a particular decade, you could enter 197 to filter to patrons born between 1970-1979.

**Searching by Identification**
All Georgia driver’s licenses should be entered in the format GA-123456789. Because of this, when searching by ID, type in your search in the same format. (Searching GA 123456789 will not retrieve GA-123456789 and vice versa.)

---

From:
[https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation](https://pines.georgialibraries.org/dokuwiki/)

Permanent link:

Last update: 2023/02/07 13:10
"My Account" Access

https://gapines.org/login

PINES users have access to selected areas of their personal patron record, including checkouts, fines/bills, holds placed, and other information through the My Account section of the OPAC.

Patrons have the option to automatically store their own checkout history and access it through their My Account login. This option is turned off by default, but patrons may turn it on by logging into their accounts and selecting the appropriate option. Library staff cannot see the patron’s checkout history through the staff client. [2015.12].

Access to the personal patron record is available only through the PINES library card number and password or personal identification number (PIN) for each user, as all library records are confidential in nature. The assigned PIN should be provided to the user at the time of library card registration, and staff will advise the patron to login to the OPAC and change their password to one of his or her choosing as soon as possible. The user may also use the My Account options to select a text username to use in lieu of the library barcode for OPAC access.

The PINES patron has the ability to change his/her own PIN/password after accessing the record with the correct library card number and PIN/password. Some patrons may need staff assistance in remembering the current PIN/password to access their patron record.

Users may reset their PIN in person at any PINES participating library with proper identification. Patrons may reset their passwords from the My Account page if they have a valid email address on file via ‘Forgot your password?’ functionality [2006.05]. Patrons may also request a password reset by phone by calling a PINES library. The patron must be able to provide the library staff person with the barcode number, full name, date of birth, and either address or phone number. Library staff should encourage patrons to log in to the OPAC and change the assigned password to a password of their own choosing as soon as possible for security and privacy purposes [2014.12].

My Account Resources

For a list of frequently asked questions from patrons, see the FAQ.

Additional resources:

- How to Update Account Preferences
- How to Renew Items
From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/01/31 08:03
GLS Patron Profile

Georgia Library Service (GLS) for the Blind and Print Disabled (formerly known as GLASS - Georgia Libraries for Accessible Statewide Services) provides library material in various formats (such as talking book cartridges and Braille) to people who are unable to read or handle standard printed material as a result of temporary or permanent visual or physical disabilities. Certain PINES library materials not traditionally provided by GLS (namely, large print books and DVDs with descriptive audio tracks) are eligible for free home delivery via the United States Postal Service’s Free Matter for the Blind program. GLS and PINES are now working together to provide eligible PINES materials to GLS patrons via mail using this program.

- Written Instructions for PINES Staff
  - Instructions for GLS Staff: Retargeting a hold when an item isn't eligible for free mail delivery
  - Learn More About GLS
  - Learn More About the USPS Free Matter Service

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2021/06/15 11:05
Searching the Catalog

- Advanced Search Tips (Cheat Sheet)
- Advanced Search Tips (Slideshow PDF)

From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation


Last update: 2019/09/10 16:26
## Advanced Search Tips

The Basic and Advanced Search screens in the PINES catalog are relatively self-explanatory, but there are a number of search tips you can make use of below if you wish to improve your search capabilities. You can use these tips in the basic search screen or even in a PINES keyword search box that you've included on your web site.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Definition</th>
<th>Example</th>
<th>Example Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Wildcard (asterisk)</td>
<td>teach*</td>
<td>Keyword search returns teach, teacher, teachers, teaching, etc.</td>
</tr>
<tr>
<td>-</td>
<td>Does not contain (minus sign)</td>
<td>teenage ninja -mutant</td>
<td>Keyword search returns records that include the words teenage and ninja, but not any of the Teenage Mutant Ninja Turtles books.</td>
</tr>
<tr>
<td>&quot;&quot;</td>
<td>Search as a phrase (quotation marks)</td>
<td>“the help”</td>
<td>Adding quotes will search for the exact phrase instead of the separate words.</td>
</tr>
<tr>
<td>after(year)</td>
<td>Limits search to after publication date (includes the year specified)</td>
<td>nasa after(2018)</td>
<td>Finds the newest items</td>
</tr>
<tr>
<td>before(year)</td>
<td>Limits search to before publication date (includes the year specified)</td>
<td>macrame before(1980)</td>
<td>Finds the older items</td>
</tr>
<tr>
<td>between(year,year)</td>
<td>Limits search by publication date range (includes the years specified)</td>
<td>Kennedy assassination between(1963,1966)</td>
<td>Finds books that were published in the years immediately following the incident.</td>
</tr>
<tr>
<td>#available</td>
<td>Filter by availability</td>
<td>GMAT #available</td>
<td>Shows only the books that are currently shown as being available on the shelves (same as checking the Available checkbox on the search results screen).</td>
</tr>
<tr>
<td>sort(pubdate)</td>
<td>Sort search results by publication date (oldest first)</td>
<td>GMAT sort(pubdate)</td>
<td>Sorts list of results with the oldest ones first</td>
</tr>
<tr>
<td>sort(pubdate)#descending</td>
<td>Sort search results by publication date (newest first)</td>
<td>GMAT sort(pubdate)#descending</td>
<td>Sorts list of results with the newest ones first (same as the sort by dropdown list on the search results page).</td>
</tr>
</tbody>
</table>

PINES Documentation - https://pines.georgialibraries.org/dokuwiki/
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Definition</th>
<th>Example</th>
<th>Example Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>sort(titlesort)</td>
<td>Sort search results by title (A-Z)</td>
<td>Nora Roberts sort(titlesort)</td>
<td></td>
</tr>
<tr>
<td>sort(authorsort)</td>
<td>Sort search results by author’s last name.</td>
<td>weight loss sort(authorsort)</td>
<td>Returns list of books in order by author's last name</td>
</tr>
<tr>
<td>audience(a,b,c,d,j)</td>
<td>Limit search results by the audience type fixed field (a=0-5, b=6-8, c=9-13, d=14-17, j=0-17) – an item can only be assigned one audience type</td>
<td>Neil Gaiman audience(a,b,c)</td>
<td>Returns books by this author that are children’s books only.</td>
</tr>
<tr>
<td>kw: or keyword:</td>
<td>Use to create complex searches in a basic search field</td>
<td>ti:help au:stockett</td>
<td>Searches records that contain “help” in the title fields and “stockett” in the author fields.</td>
</tr>
<tr>
<td>title: or ti:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>author: or au:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>subject: or su:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Example Searches

- `au:gaiman audience(a,b,c) after(2013) sort(titlesort)`
- `ti:easter audience(a,b) sort(pubdate)#descending`
- `kennedy assassination between(1963,1966) sort(authorsort)`

From:
https://pines.georgialibraries.org/dokuwiki/ - **PINES Documentation**

Permanent link:

Last update: **2019/09/10 16:47**
Library Card Requirements for Circulation

A patron must have an account in good standing to borrow materials. A patron’s card will be blocked, and no services may be obtained with it if the patron owes $10 or more in unpaid fines and/or fees [2011.05]. Blocked services include renewals [2009.05, 2009.09] and hold request placement [2008.02]. Delinquent borrowers who have not reached these limits may still borrow materials; the system operator will be notified that the patron is delinquent.

A PINES card is required at all times and at all libraries for all transactions [2006.11], with the following exceptions:

- when an item is in hand, no library card is required in order to renew the item [2007.02]
- when an item is in hand, no library card is required for payment of fines [2007.02]
- when the patron does not have their library card with them when they present materials to be checked out, they may present an approved form of identification to staff. Care should be taken to ensure the correct account is used for check out [2021.12]
- when the patron presents their barcode via the PINES app (no additional piece of identification is required when using the PINES app, as the password is required in order to access the account on the app) [Feature added 2018]
- when the patron presents a scannable electronic facsimile of their PINES card on a hand-held device (such as through the Key Ring app. Staff must confirm the patron’s identity by asking for an additional key piece of information from the patron record. Name, phone number, email address, street address, or date of birth would be acceptable. Note that if a library’s barcode scanners cannot scan the card number from the hand-held device, library staff will type in the card number displayed on the hand-held device along with confirmation of the patron’s identity. [2014.05]

It is recommended that libraries using self-check machines require that the patron input their PIN to avoid items being checked out to incorrect accounts [2014.05].

A card is required for renewals or bill payment if neither the cardholder nor the item is present [2007.02].
Circulating Items

- Checking Out Items
- Renewing Items
- Checking In Items

General Policies

Circulation Matrix

- See: Circulation Matrix (Recurring Fine Amounts, Loan Durations, and Renewal Counts)

Circulation and Hold Data Retention

With a few exceptions, circulation and hold data that has been resolved/closed is archived by the system after one year. Archiving this data does not affect statistical reporting, such as total number of circulations per item, circulation staff, circulation workstation, and circulating library.

Circulation data with outstanding fines or fees, including Lost and Long Overdue, is retained. Circulation information is also retained for those patrons that opt to have the system store their circulation history.

However, when looking at the “Show Last Few Circulations” item screen or the “Show Cancelled Holds” patron screen, data older than a year is not be displayed.

Default Item Price

Items that have never had a price assigned use $25.01 as the default item price [2007.12]. That is, if the price in the database is NULL, $25.01 is used when assigning Lost, Long Overdue, and Damaged charges. If the price in the database is 0 or blank, then no item price will be automatically used when assigning Lost, Long Overdue, and Damaged charges, and staff will need to add the price to the bill manually.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2018/10/11 16:15
Checking Out Items

Basic Checkout Procedure

A normal checkout session would proceed as follows:

1. Staff member opens the Check Out screen (Circulation > Check Out).
2. Patron presents his/her library card (see: **Library Card Required for Circulation**).
3. Staff member scans card to retrieve account.
4. Staff member determines if patron is in good standing (i.e., not blocked, barred, inactive, exceeding fine limits).
5. Staff member scans barcodes of items presented for checkout.
6. Staff member clicks the “Done” button to prompt printing of checkout receipt.
7. Staff member should verbally inform patron of due dates. (It is good practice to also inform patron of due dates on any items already checked out on the account and to inform the patron of any fines owed.)

Circulation Limits

In most cases, a maximum of 50 items may be charged simultaneously on a PINES card [1999.05], [2002.12]. Some types of accounts, such as Restricted, and lower limits. See **User Permission Groups** for more information on different patron account types.

Materials circulate for varying periods of time; see the **PINES Circulation Matrix** for details on circulation rules.

Audio-visual materials (DVDs, games, etc.) are limited to 15 per patron at any given time [2013.05]. This policy supersedes any local limits that previously been used.

Proxy Borrowing

Any user may present another user’s card to check out materials. Library staff should remind all patrons at the time a card is issued that they are responsible for all items checked out on that card, and that lost cards should be promptly reported. (See: **Lost / Stolen Cards**) PINES libraries also have the ability to check out items on hold to an authorized proxy user (often husband or wife), as opposed to the user who originated the hold, while maintaining the integrity of the holds queue.

Policies regarding Proxy Borrowing and procedures for administering this feature are at the discretion of the individual library systems [2001.11]. The authorized proxy is not required to present the originator’s card, but the authorization for proxy permission should be noted in the Alert Message field. Because all library records are confidential in nature, PINES library staff must be aware that authorization of the originating user (the person placing the hold) is required for proxy checkout for all persons over 18 years.
of age.

Materials placed on hold by juveniles, as with any and all parts of the juvenile’s patron record, are accessible and may be checked out by parents or legal guardians without prior authorization.

**Checking Out Non-Cataloged Items**

Many libraries do not have bibliographic records for paperback books, circulating magazines, or equipment. The non-cataloged circulation function should be used to record a count of these items.

1. Retrieve the patron account as you would for a normal checkout.
2. Click on Barcode to pull down a list of non-cataloged item types.
3. Select the appropriate type of non-cataloged item.
4. Enter the number of items.
5. Click Submit.

These items will be checked out on the patron’s account and will be given a due date, but will accrue no fines. The patron account will show the non-cataloged items as checked out on the patron’s account until the due date has passed and then will be automatically removed from the patron’s account. Non-cataloged item types may be configured separately for each library system by the designated LocalAdmin.

**Pre-Cats**

With the exception of items that are intentionally non-cataloged (see above), all items borrowed by patrons should have a barcode and be checked out through Evergreen. If an item is brought to checkout without a barcode or if the barcode on an item is no longer in the database, it should be added/re-added to the database on the spot, using the pre-cataloged item function to allow its circulation. For non-barcoded items, staff should apply a spare barcode to the item and scan it. Assigning ad hoc/temporary or shortened barcodes is not recommended, as this can cause other items in other libraries to accidentally be scanned. The following screen will appear:
When this message appears when scanning a barcoded item, staff should first attempt to re-scan the item. Many pre-cats are created from mis-scans, which causes problems with tracking and cleanup.

When it is determined that the item’s barcode is not in the database, fill out the form.

When the item is returned, it must be forwarded to the Cataloging Department for full entry into the database. Brief records should not remain in the system for more than one circulation. PINES member libraries will be asked to periodically clean up brief records by deleting them or creating full records [2002.05].

- Complete Step-by-Step Instructions for Handling Pre-Cats

**Cataloged Items Without Barcodes**

If a cataloged item has lost its barcode, staff should apply a new barcode to it before checking it out.

1. Identify the old barcode number by searching the catalog.
2. In Evergreen click Circulation > Replace Barcode.
3. Enter the original barcode and the new barcode.
4. Click Submit.
5. Return to the patron account and check out as normal.
Replace Item Barcode

Enter Original Barcode for Item

Enter New Barcode for Item

Submit

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2021/02/03 11:00
Renewing Items

Most items can be renewed twice (see the PINES Circulation Matrix for exceptions). After items have been renewed the maximum number of times, they must be returned and made available for all library patrons. Certain categories of materials are not eligible for renewal. If there are more pending holds on a record than there are available copies, then it may not be renewed [2021.12]. Selected staff will have the authority to force the renewal in special circumstances.

To accomplish a renewal, the patron must present his/her PINES card or read his/her PINES barcode number to staff over the phone. Staff is encouraged to ask for a second item of identification, such as address or telephone number, to verify the identity of the caller. Staff may also look up an account using an approved form of identification (for example, a driver's license). Items will not be renewed with patron name only. Patrons may also renew their checked out items via the My Account feature of the OPAC or through the PINES app. When an item is in hand, no library card is required in order to renew the item.

Historical Note: Prior to March 1, 2022, items could not be renewed if there were any pending holds that the item could fill. Currently, the renewal process considers the ratio of available copies to holds and will allow the renewal to proceed as long as there are enough available copies to fill all pending holds.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/12/08 16:37
Checking In Items

Basic Check-In Procedure

1. Open the Checkin Items page (Circulation > Check In).
2. Scan each item's barcode.

When checking in materials, it is crucial to watch the screen as each barcode is scanned to be sure the scan is registering and to be aware of on-screen messages and directions. Messages directing the staff member to send items to another location or library, or directions for items on hold are visually displayed on the screen at check-in, and audible alerts will assist the operator in noticing important messages.

Back-dating Checkins

Staff may change the date for the check-in by altering the Effective Date field for purposes of checking in items from the bookdrop first thing in the morning using a previous day's date, or in other circumstances in which the check-in date needs to be changed. Set the desired check-in date, and check in items normally. Reset the effective date to the current day once back-dated checkins are complete.

Checking In Items That Need To Go To Another Library

If the item that is checked in needs to go to be routed to another library (either to fulfill a hold request at
another library or to return to its owning library), check it in as normal. The system will automatically change its status to “In Transit” and a pop-up message will appear that will allow you to print a Transit Slip that should be included with the item when sent to its destination.

Checking In Items That Will Fill Hold Requests

If the item being checked in is needed to fill a hold request at your library, check it in as normal. A pop-up will appear that will prompt you to print a hold slip that should be attached to the item.

The item's status is automatically changed to “On holds shelf” and automated notices to the patron are triggered (see: Automated Notifications). If the patron has opted to be notified by telephone, the telephone number will appear on the hold slip so that staff may call.

Checking in Pre-Cats

When pre-cataloged items (see: Pre-Cats) are checked in, the item status is automatically changed to
Cataloging and an alert message appears. Route the item to the cataloging department for full entry into the database.

**Checkin Modifiers**

Evergreen includes various options for altering how items are checked in for special circumstances (for example, during amnesty periods). These options are selected through the Checkin Modifiers button on the Checkin Items page.

- **Ignore Pre-cataloged Items**: When checked, an “Ignore Pre-cataloged Items” message will appear at the top of the screen and any pre-cataloged items will not appear in the checked-in list. *Not normally used.*
- **Suppress Holds and Transits**: When checked, a “Suppress Holds and Transits” message will appear at the top of the screen and holds or transits will not be triggered by check in. *Not normally used.*
- **Amnesty Mode/Forgive Fines**: See below.
- **Auto-Print Hold and Transit Slips**: This should be checked for most users in most situations.
- **Clear Holds Shelf**: When checked, a “Clear Holds Shelf” message will appear at the top of the screen. This checkin modifier is used when removing items from the holds shelf that have not been picked up by patrons. It will clear the item’s “On hold shelf” status and allow it to be routed to its next destination.

Each setting is unchecked by default, but the preferred setting is retained by the staff client once selected.

**Amnesty Mode**

On certain occasions, a library may set an ‘amnesty’ period to forgive overdue fines on books returned during a specified time period. In order to save time manually forgiving these fines, you may use the Amnesty Mode option during the checkin process.

1. In the Evergreen Staff Client, click Circulation > Check In Items.
2. On the bottom-right corner of the screen, click Checkin Modifiers > Amnesty Mode.
3. Check books in (you will see messages indicating if overdue fines have been removed from the items).
4. Remember to uncheck Checkin Modifiers > Amnesty Mode when you wish to return to normal checkin.

When you check in items in while Amnesty Mode is turned on, the fines are voided (not forgiven) so they will no longer show up on the patron accounts. If you need to find out how many fines were voided during this time period, you will need to run a report. (There is a PINES Quick Report you can run to review voided fines - please submit a Help Desk ticket if you require assistance.)

**Amnesty Mode & Lost / Long Overdue Items**

Checking items in with Amnesty Mode will only clear overdue fines and will **not** clear 'Lost' or 'Long Overdue' charges. When you scan in a lost or long overdue item, an alert will pop up to inform you of its status. If the item belongs to your library, you may opt to go into the patron's account to manually forgive the remainder of the lost or long overdue charges.

If the item belongs to a **different library**, the fines should **not** be forgiven (only an item's owning library should forgive lost or long overdue fines).

**Other Checkin Options**

- **Print Receipt:** Prints a receipt of the items listed on screen that have been checked in. (Use this option if a patron requests a receipt of the items they have returned.)
- **Trim List:** This option limits the list of items on screen to 20 rows, regardless of how many barcodes are input. *Not normally used.*
- **Strict Barcode:** If checked, the barcode field will only accept 13-digit Codabar barcodes. Barcodes in any format, even if legitimate, will not be processed.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: *2021/06/23 16:05*
Claims Returned Items

Claims Returned (aka, Claimed Returned or CLAIMSRETURNED) can be applied to an item when the owning library system and the patron the item is circulated to are unable to agree on its current location, thus creating a temporary 'draw' or 'amnesty' for the item until it can be resolved.

Please be aware that not all PINES library systems opt to use Claims Returned. As with other types of item status and bill changes, it is good practice to only modify the items that belong to your own library system.

How to Mark an Item Claims Returned

1. From the Items Out screen, you can either right-click on the item in question and select Mark Claims Returned or select the item(s) and then click on Actions for Selected Items and select Mark Claims Returned.
2. You will be prompted for the date that the patron claims to have returned the items.

What Happens in the System

- Overdue fines (if any) stop accruing as of the date chosen. (If this is back-dated, the bills that have accrued since the chosen date are voided.)
- The status of the item remains Checked Out but the Stop Fines Reason is changed to Claims Returned.
- The item will remain listed on the patron's account, but moves to the Other/Special Circulations section of the Items Out screen.
- The Claims Returned Count on the Edit Patron screen is incremented. (This counter will only go up to 5 and then the system will not allow any more items for that patron to be marked as Claimed Returned.)
- The item is NOT hidden from the online catalog.

Checking in a Claims Returned Item

If an item with the CLAIMSRETURNED status is found and checked in, the system will update the item's status so that it can be circulated again. If there are no fees associated with the item, it will be removed from the patron's account. If there are fees, it will remain listed on the patron's account until all the fees are paid. The system will not remove a number from the patron's Claims Returned Count counter. This number may be changed manually if needed. Staff with Circ1, LibraryManager, or LocalAdmin permissions can manually update the Claims-returned Count in the patron edit screen.
If Another Patron Tries to Check Out a Claims Returned Item

If another patron finds an item on the shelf that has been marked as Claims Returned and tries to check it out, the circulation staff will see an error stating that the item was marked as Claims Returned and it will not allow the item to be checked out. If this happens, you must check the item in first before it can be checked out again.

Policies and Best Practices

PINES policy indicates that a library may mark Claims Returned items as Lost after 45 days from the due date.

To follow up on these missing items, some libraries run a report to find items that have the Stop Fines Reason of Claims Returned and the Copy Status of Checked Out, then checks the shelves for those items. Those items that are not found after 45 days are then marked as Lost and the patron is billed appropriately. There is a Quick Report available that you can run for your library at:

Quick Reports > Quick Report Templates > Items > List of Items Marked Claims Returned

Patron Communication

To prevent potential patron confusion regarding how the Claims Returned process works, you may wish to develop a local procedure not only for following up on Claims Returned items, but also for communicating the process with patrons.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/01/24 14:10
Item Statuses and Actions

For complete list of possible statuses, see: Cataloging Manual: Item Statuses

Available

The item is on the shelf and available for check out.

Checked Out

The item is checked out to a patron. This status does not indicate whether or not the item is overdue.

Claims Returned Items

Claims Returned is used when both a library system and a patron are unable to agree on the location of the disputed item thus creating a ‘draw’ or ‘amnesty’ for the item [2010.02]. If a user claims to have returned materials that still show as checked out, the material may be marked with a Claims Returned date. Overdue fines stop accruing as of the date entered in the Claims Returned field.

A user may have up to 5 Claims Returned items on his/her record, after which no more items for that user can be marked Claims Returned. If Claims Returned items are found, the Claims Returned counter on the patron’s account information screen may be manually changed at the discretion of the owning library system.

A Claims Returned item can be declared Lost by the owning library if it is not found after 45 days [1999.10].

- More Information about Claims Returned

Damaged Items

Damaged Items Policy

When an item is marked Damaged, it is hidden from the public catalog and will not be targeted for holds. The Damaged item status may be used for items that are damaged beyond repair and will need to be discarded, or for items that will be returned to the collection after repairs. The Damaged item status may be used regardless of whether or not a patron will be billed for damages.
Only the library that owns an item should assess whether or not a patron should be billed for damages to that item or not. The owning library may choose to bill the entire cost of the item plus a processing fee if an item is damaged by the patron beyond repair, or may choose to bill a partial amount (for example, when there is repairable damage such as a minimally torn cover), or may choose to mark the item damaged without billing the patron for it (for example, when there is damage caused by normal wear and tear).

Libraries may choose to assess a processing fee of up to $10 per item for item damage on their own items (this is set in the Library Settings Editor). If the damage is assessed after the item has been checked in, a damaged bill may be added to the patron account manually.

Marking an item Damaged will not void overdue charges. If the patron is being billed the full price of an item, the library may choose to manually void overdues.

See Payment Retention and Reimbursal regarding payments on Damaged items that are accepted by a non-owning library.

**Damaged Items Instructions**

1. To mark an item Damaged, open it in the Item Status/Details screen.
2. Click the Actions button.
3. Select Mark > Item as Damaged.
4. You will be alerted that the item will be marked Damaged. Click Submit.
5. If the item is currently checked out or contains information about the last patron that had it checked out, a second popup will appear prompting you to choose whether to bill the patron for the item or not. Your options will be to bill the full amount plus processing fee (this is the amount that appears by default), to bill a different amount (simply type in a different amount), or not to charge (click on the No Charge option).
6. Enter a note describing the type of damage.
7. Once you have made your selection, click Submit.
If the damaged item belongs to another library, you may mark it damaged with No Charge so that it will return to its owning library and cannot be captured by a hold. If you do so, be sure to include a note with the physical item explaining that you have marked it damaged but have not charged for it so that it will be routed to the appropriate department at the owning library. The owning library may then go through the steps to mark it damaged a second time, and choose the fee they wish to apply.

Libraries should never use tape to attach notes to directly books [2019.09].

**Discard/Weed**

Beginning January 2019, Circulation staff may now change items to a Discard/Weed status in order to streamline the weeding process. Marking an item Discard/Weed immediately hides it from the public catalog and it will not be able to be targeted for holds. Depending on local workflow, the items marked for Discard/Weed can either be placed into a bucket for review by cataloging staff, or cataloging staff may wish to run reports to obtain lists of items marked Discard/Weed.

- More information is available at: Marking Items Discard/Weed

**In Process**

Items in this status have been cataloged and are awaiting check in at the circulation library, which makes item active. Items in process can be placed on hold. If patron has placed a hold on the item, checking in triggers notification that item is needed to fill a hold. Otherwise, after check in item is now in Available status.

**In Transit**

The item is being shipped from one library location to another. This status is automatically assigned by the system. When an item arrives at its destination, a library staff member checks it in, which removes it from the In Transit status. If an item is in the In Transit status but does not arrive and cannot be located at either the sending or receiving library, the status can be manually changed to Missing.

See also: Items in Transit

**Long Overdue Items**

Items that are overdue for longer than 3 months are automatically changed to a status of LONG OVERDUE (unless the patron has been flagged for collections). The price of the item, plus an optional processing fee of up to $10 (set per library in the Library Settings Editor), is applied to the patron’s
account. Overdue fines on the item are automatically voided.

See Payment Retention and Reimbursement regarding payments on Long Overdue Items that are accepted by a non-owning library.

If the patron finds the item and returns it within 6 months (180 days) of payment*, the system will void the item price and re-apply the overdue fines that had been previously voided. The system will not void processing fees.

* Although the PINES Executive Committee approved the policy of automatically refunding a payment based on the payment date, the software only automates this action based on the item's due date. If an item is paid for and then returned more than 6 months after the due date, the library may refund the amount following local procedures.

If the patron has not paid for the item, but finds and returns it within 6 months (180 days), the system will void the item price and re-apply the overdue fines that had been previously voided. The system will not void processing fees.

If the patron is flagged for collections, the Long Overdue process will bypass additional items that become Long Overdue. Staff may manually mark those items that would have been marked Long Overdue as Lost according to local policy and procedure.

(Bills for Long Overdue items are highlighted in yellow-orange on the bills screen.)

Historical Note: The PINES Executive Committee agreed upon a Long Overdue policy in May of 2006 [2006.05], but the system was not capable of automating it at the time. Implementation of this feature occurred October 2014 and eligible items for the previous three years were marked Long Overdue.

Historical Note: Prior to July 1, 2022, the Long Overdue process affected items that were overdue for longer than 180 days [2021.12].

**Long Overdue Items Report**

*Shared Folders > Templates > dda > Helpdesk Request > Collection Maintenance > Lost or Long Overdue and Paid Item List*

**Payment for Long Overdue Items**

If a Long Overdue item is paid for at a different library than the owning library, the payment amount may be kept by the payment library unless the owning library sends an invoice for reimbursal within 90 days.

**See Also:**

*Note: These documents were created at the time Long Overdue was implemented when the process was triggered at 6 months. The process is now triggered at 3 months, but is otherwise unchanged.*

- Staff Workflows for Long Overdue Processing
- How Long Overdue Processing Works
Lost Items

A patron may inform staff that an item is LOST. Staff should mark the item LOST in Evergreen to create a bill for the lost item. The price of the item, plus an optional processing fee of up to $10 (set per library in the Library Settings Editor), will be assessed to the patron’s card. Overdue fines on the item will be automatically voided when marking an item lost [2002.09]. Lost items may be paid for at any PINES library.

See Payment Retention and Reimbursal regarding payments on Lost Items that are accepted by a non-owning library.

If an item has been marked lost that has not been paid for is returned within 180 days, Evergreen will automatically void the item’s cost and reinstate any overdue fines that had previously been voided when the item was marked lost. The system will not void processing fees.

(Bills for Lost items are highlighted in red on the bills screen.)

You should never mark an item Lost if it has already been marked Long Overdue. If an item has already been marked Long Overdue, then it has already been appropriately billed. If you mark it Lost, it will essentially double-bill the item. If this happens and you do not know how to correct the bill, contact the Help Desk with the details.

Refunds on Lost and Long Overdue Items

If an item has been marked Lost or Long Overdue that has not been paid for is returned after 180 days, Evergreen will not void the item's cost.

Evergreen will not void processing fees. If a library chooses to forgive a processing fee for one of their own items, staff must do it manually. Libraries must not forgive or void processing fees on items owned by other libraries.

Evergreen will only automatically void and restore fines associated with the circulation that resulted in the lost item. The system does not void/restore overdue fines related to other circulation transactions on an item.

“Found” materials may be returned to any PINES library but routed to the owning library, with the understanding that the owning library will be the final authority on whether the material is in acceptable condition for return. When appropriate, the owning library will issue a refund check to the patron via U. S. Mail. The refund check will be payable to the library cardholder on whose record the materials were circulated [1999.10].

Missing

Missing is a status assigned to items which show as available in the library catalog, but which are not
found on the shelf. When an item is not found on the shelf, a staff member should manually mark the item Missing in Evergreen using the Item Status editor. The library should then run a regular report of items in Missing status to try to locate them, and then delete them as they see fit.

**On Holds Shelf**

The item has been placed on a library's Holds Shelf and is ready for pick up by the patron it is on hold for at the patron's desired pickup location.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: **2022/12/15 15:53**
Items in Transit

When an item is routed from a library location to another, it is placed automatically in “Transit” status. When the item arrives at its destination, it should be checked in. If the item is returned and does not have any holds on it, it will switch to “Reshelving” status. After one day (24 hours), it will automatically switch to “Available” status. If the item is on hold for someone, the system will print a hold slip.

If the item arrives at its destination but is not checked in properly, it will remain in Transit status even though it might be reshelved. To anyone viewing the catalog, it will look like the item is not available and it will delay holds on the title.

It is recommended that each library check their transit lists on a regular basis (monthly or weekly) to catch any items that have been routed to their location, but not checked in.

Evergreen's Transit List Interface

1. In the Evergreen Staff Client, click on Administration > Local Administration > Transit List.
2. Select whether you want to view Transits to or Transits From a particular library.
3. Select a date range. The screen will refresh with a list below.

To search for items that have been in transit for a long time:

1. Use the column picker to add the Call Number Label column and then click the column header to sort by call number.
   - You may wish to display more rows at once.
   - You may wish to remove some columns
   - Use the browsers File > Print functionality to print the list. (You may be able to get the information you need using the Print Transits button, but that is still under review as of 2.12.)
2. Check the library for each item.
   - If you find an item, scan it into the Checkin screen to update its status.
   - If you are unable to find an item, mark it Missing.

Transit Quick Reports

You may also retrieve this information through reports if you wish.

- Quick Reports > Quick Report Templates > Items > Transits: My Library's Items In Transit
- Quick Reports > Quick Report Templates > Items > Transits: Sent from My Library
- Quick Reports > Quick Report Templates > Items > Transits: Sent to My Library
PINES Circulation Matrix

Circulation modifiers (circ mods or circ modifiers) set the loan duration and fine levels for each item in PINES. They are added to items as an item attribute during cataloging.

Circulation modifiers and their associated circulation rules and policies are governed by the PINES Executive Committee and any changes or additions require their approval. Requests for changes should be made by the library system director, in writing, to the PINES Program Director. In consultation with PINES staff, the Director will evaluate the proposal in regard to PINES policies and consortial needs. Proposals may be sent back to the library system director or forwarded to the PINES subcommittee for discussion. The PINES team may make suggestions on streamlining additions to the circ matrix for consortial benefit. The subcommittee discussion is then forwarded to the Executive Committee for further discussion and a vote for or against approval.

PINES staff may develop a project to implement and create the circulation modifier changes, either as a part of the proposal or after Executive Committee approval.

Fine Levels

Every item has an attribute called “Fine Level” that determines the level of recurring fine with which the item circulates, within a pre-determined range of levels. By default, copies are set to “normal”. If a copy has been manually altered in the copy editor to “high” or “low”, the fine level will change according to the table below. For example, if a given item circulates at $.20/day and the item flag is changed to have a “high” fine_level, then it will circulate at $.50 / day.

Fine level options are not enabled for all item types.

Duration Rules

Every item also has a “Loan Duration” attribute, which affects the length of time an item circulates with the options of “short”, “normal” (the default setting), and “long”.

Loan duration options are not enabled for all item types.

Circulation Matrix

- Use of circulation modifiers for specific item types should be in compliance with PINES policies.
- When an item has a circulation modifier, that modifier takes precedence over the MARC item type when determining circulation rules.
- PINES libraries should no longer use MARC item Type for circulation rules. All new items should be assigned an appropriate circulation modifier.
Circ Modifier | Recurring Fine (Normal) | Recurring Fine (Low) | Recurring Fine (High) | Short Duration | Normal Duration | Extended Duration | Renewal Count
--- | --- | --- | --- | --- | --- | --- | ---
art | .20 | 3 months | 1
audiobook | .20 | 14 days | 2
bestseller | .50 .20 | 7 days | 2
book | .20 | 14 days | 2
book-ff | no fines | 14 days | 2
e-device | 10.00 5.00 50.00 1 day | 7 days | 14 days | 0
e-device-local | 10.00 5.00 50.00 1 day | 7 days | 14 days | 0
equipment | 10.00 5.00 50.00 1 day | 3 days | 7 days | 0
equipment-local | 10.00 5.00 50.00 1 day | 3 days | 7 days | 0
high-demand | $1.00 | 7 days | 0
ll item | .20 | 14 days | 0
kit | .20 5.00 50.00 | 14 days | 2
localpass | 3.00 1.00 5.00 3 days | 7 days | 14 days | 1
magazine | .20 | 14 days | 2
map | .50 | 3 days | 1
microform | .20 | 14 days | 2
music | .20 | 14 days | 2
realia-0 | 10.00 3.00 25.00 3 days | 7 days | 14 days | 0
realia-1 | 10.00 3.00 25.00 3 days | 7 days | 14 days | 1
realia-2 | 10.00 3.00 25.00 3 days | 7 days | 14 days | 2
software | 1.00 .20 5.00 3 days | 7 days | 14 days | 2
statepass | 3.00 | 7 days | 1
talking-book | 0 | unlimited | 0
toy | .20 | 14 days | 2
video-0 | .50 .20 | 7 days | 14 days | 0
video-2 | .50 .20 | 7 days | 14 days | 2
videogame | 1.00 .20 5.00 3 days | 7 days | 14 days | 2

**Circulation Matrix: MARC Types**

PINES has discontinued using MARC types for circulation rules. All items should have the appropriate circulation modifier. This matrix is included here for those items not yet assigned a circulation modifier and still dependent on MARC type for fines and circulation duration. PreCats not assigned a circulation modifier at creation will follow circulation for language materials.

<table>
<thead>
<tr>
<th>MARC Item Type</th>
<th>Recurring Fine</th>
<th>Recurring Fine (Low)</th>
<th>Recurring Fine (High)</th>
<th>Short Duration</th>
<th>Normal Duration</th>
<th>Long Duration</th>
<th>Renewal Count</th>
</tr>
</thead>
</table>
a - Language Material | .20 | | | | 14 days | | 2
### MARC Item Type

<table>
<thead>
<tr>
<th>MARC Item Type</th>
<th>Recurring Fine</th>
<th>Recurring Fine (Low)</th>
<th>Recurring Fine (High)</th>
<th>Short Duration</th>
<th>Normal Duration</th>
<th>Long Duration</th>
<th>Renewal Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>c - Notated Music</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>d - Manuscript Notated Music</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>e - Cartographic Material</td>
<td>.50</td>
<td></td>
<td></td>
<td></td>
<td>7 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>f - Manuscript Cartographic Material</td>
<td>.50</td>
<td></td>
<td></td>
<td></td>
<td>3 days</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>g - Projected Medium</td>
<td>.50</td>
<td></td>
<td></td>
<td></td>
<td>7 days</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>i - Nonmusical Sound Recording</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>j - Musical Sound Recording</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>k - Two-dimensional Nonprojectable Graphic</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>3 months</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>m - Computer File</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>o - Kit</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>p - Mixed Materials</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>r - Three-dimensional artifact or naturally occurring object</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>t - Manuscript Language Material</td>
<td>.20</td>
<td></td>
<td></td>
<td></td>
<td>14 days</td>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>

### Restricted circulation modifiers

These circulation modifiers are restricted to libraries participating in the fines free pilot.

<table>
<thead>
<tr>
<th>Circ mod</th>
<th>Recurring fine (normal)</th>
<th>Recurring fine (Low)</th>
<th>Recurring fine (High)</th>
<th>Short Duration</th>
<th>Normal Duration</th>
<th>Long Duration</th>
<th>Renewals</th>
</tr>
</thead>
<tbody>
<tr>
<td>audiobook-ff</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>14 days</td>
<td>none</td>
<td>2</td>
</tr>
<tr>
<td>music-ff</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>14 days</td>
<td>none</td>
<td>2</td>
</tr>
<tr>
<td>video-0-ff</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>7 days</td>
<td>0</td>
</tr>
<tr>
<td>video-2-ff</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>none</td>
<td>7 days</td>
<td>14 days</td>
<td>2</td>
</tr>
</tbody>
</table>

### Circulation Exceptions

<table>
<thead>
<tr>
<th>Item Circ System</th>
<th>Circ Mod, Etc.</th>
<th>Recurring Fine</th>
<th>Short Duration</th>
<th>Normal Duration</th>
<th>Long Duration</th>
<th>Renewal Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATELIB</td>
<td>book</td>
<td>no fines</td>
<td>35 days</td>
<td>35 days</td>
<td>35 days</td>
<td>1</td>
</tr>
</tbody>
</table>
Age Protection

See: Age Protection

Holds

Items with the audiobook, audiobook-ff, book, book-ff, music, music-ff, video-0, video-0-ff, video-2, video-2-ff, or videogame circulation modifiers are holdable throughout the consortium. Items with all other circulation modifiers are holdable only within their own systems. See definitions of circulation modifiers for more details.

Hold Types or Levels

There are five levels or types of holds that can be placed in Evergreen. Library staff can place holds at all levels. Patrons can place title, metaholds, or part level holds. Only staff can place item/copy and call number/volume level holds.

Title level holds (T)

Designated by a T, title holds are placed on a single title/bibliographic record and can be filled by any copy in a holdable state on that record. Patrons and library staff can place title level from either the staff catalog or patron OPAC.

Part level holds (P)

Designated by a P, part level holds are placed when a specific volume or part of a multi-part work is needed. Parts are chosen at the time the hold is placed from a dropdown menu and apply to any volume or call number from any library with the same part label attached to the title record. Part level holds can be placed by either patron or library staff from either the staff catalog or patron OPAC.

Item/Copy level holds (C)

Designated by a C, Item/copy level holds are placed on a specific item on a bibliographic record and can only be filled by that specific item. Item/Copy holds should only be used by catalogers when they need to resolve a cataloging problem. Item level holds placed for patrons can negatively impact hold fulfillment and should not be used for patron holds. Item level holds can only be placed by library staff from the staff catalog.
Call Number/Volume level holds (V)

Designated by a V, call number/volume level holds are used when any item attached to a specific library’s call number or volume is needed. Call number/volume level holds should be rare since there are few occasions where a title or part level hold would not be a better option. Call number/volume level holds may also negatively impact hold fulfillment since the targetter will not look beyond that specific call number. Volume level holds can only be placed by library staff within the staff catalog.

Metaholds (M)

Designated by an M, metaholds are used when a patron will accept the first available copy of any format of a title, or any language available for a title. Placing a metahold groups titles together for hold availability using a machine-based algorithm that identifies like titles. Holds are not placed on all records in the group; but, will be fulfilled with the first available copy on one of the grouped records. At hold placement, patrons or staff can choose format and/or language under advanced options. Metaholds can be for all formats for the grouped records, only book formats (regular or large print) or editions, only sound recording formats, or only visual material formats. Metaholds can be placed by patron or library staff from either the staff catalog or patron OPAC.

Max Fine Levels

See Max Fines vs. Max Bills for an explanation of the difference between maximum fines and maximum bills.

Systems using the max-fine level of $10.00

- Augusta-Richmond County Library System (ARCPLS)
- Athens Regional Library System (ARL)
- Cherokee Regional Library (CHRL)
- Coastal Plain Regional Library System (CPRL)
- Dougherty County Public Library (DCPL)
- Flint River Regional Library (FRRLS)
- Greater Clarks Hill Regional Library (GCHR)
- Henry County Library System (HCLS)
- Houston County Public Libraries (HOU)
- Marshes of Glynn Libraries (MOGL)
- Newton County Library System (NCLS)
- Oconee Regional Library (OCRL)
- Ohoopee Regional Library (OHOOP)
- Okefenokee Regional Library System (OKRL)
- Piedmont Regional Library System (PIED)
- Pine Mountain Regional Library System (PMRLS)
- Screven-Jenkins Regional Library (SJRLS)
- Statesboro Regional Public Libraries (STRL)
• Three Rivers Regional Library System (TRRLS)

All other systems use the $5.00 max-fine level

Library Processing fees

For processing fees at individual libraries, see Library Processing Fees

Special User Groups

Users in the following groups (or sub-groups) accrue no late fines on circulations:

• Staff
• Trustee
• Institution
• GLS
• Homebound
• PLAY Card

See User Permission Groups for more information.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/02/09 09:04
PINCES Circulation Modifier List

art
audiobook
audiobook-ff
bestseller
book
book-ff
e-device
e-device-local
equipment
equipment-local
high-demand
ILL item
kit
localpass
magazine
map
microform
music
music-ff
realia-0
realia-1
realia-2
software
statepass
talking-book
toy
video-0
video-0-ff
video-2
video-2-ff
videogame

PINCES Circulation Modifier Definitions

See PINCES Circulation Matrix for circulation rules

<table>
<thead>
<tr>
<th>Circulation Modifier</th>
<th>Description</th>
<th>MARC Type Correlation (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>art</td>
<td>Circulating artwork such as prints, paintings or statuary. Not holdable outside owning library system.</td>
<td>k: Two-dimensional nonprojectable graphic; r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>audiobook</td>
<td>Nonmusical sound recordings on any physical format designed to be played back on an audio device. A 007 field should be included in the bibliographic record to define specific type. Holdable outside owning library system.</td>
<td>i: Nonmusical sound recording.</td>
</tr>
<tr>
<td>audiobook-ff</td>
<td>Nonmusical sound recordings on any physical format designed to be played back on an audio device. A 007 field should be included in the bibliographic record to define specific type. Holdable outside owning library system. <strong>Does not accrue fines. Use is currently restricted to libraries participating in the fines free pilot project.</strong></td>
<td>i: Nonmusical sound recording.</td>
</tr>
<tr>
<td>bestseller</td>
<td>High demand book. Modifier should be changed to book when demand lessens, or after owned by library for specific period of time. Items with this modifier can be nonholdable for owning library. Not holdable outside owning library system.</td>
<td>a: Language material; t: Manuscript language material; d: Manuscript notated music.</td>
</tr>
<tr>
<td>Circulation Modifier</td>
<td>Description</td>
<td>MARC Type Correlation (if applicable)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>book</td>
<td>Physical print monographs and serials, except for print magazines or journals. Can include atlases, pamphlets, musical scores, or technical reports as well as books. Holdable outside owning library system; age protection rules can apply.</td>
<td>a: Language material; t: Manuscript language material; d: Manuscript notated music.</td>
</tr>
<tr>
<td>book-ff</td>
<td>Physical print monographs and serials, except for print magazines or journals. Can include atlases, pamphlets, or technical reports as well as books. <strong>Does not accrue fines.</strong> Holdable outside owning library system; age protection rules can apply.</td>
<td>a: Language material; t: Manuscript language material.</td>
</tr>
<tr>
<td>e-device</td>
<td>Any electronic device used to read or playback downloadable media, whether print, sound, or visual. Or, any device used to assist patrons’ internet access such as hotspots, laptops/Chromebooks, tablets/ iPads, etc. Not holdable outside owning library system.</td>
<td></td>
</tr>
<tr>
<td>e-device-local</td>
<td>Any electronic device used to read or playback downloadable media, whether print, sound, or visual. Or, any device used to assist patrons’ internet access such as hotspots, laptops/Chromebooks, tablets/ iPads, etc. Not holdable outside owning library (branch only holds).</td>
<td></td>
</tr>
<tr>
<td>equipment</td>
<td>Physical resources such as projectors, cameras, magnifying glasses, screens, etc. made available for circulation. Does not include e-readers or other devices more properly categorized elsewhere. Not holdable outside owning library system.</td>
<td>r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>equipment-local</td>
<td>Physical resources such as projectors, cameras, magnifying glasses, screens, etc. made available for circulation. May include e-readers or other devices more properly categorized elsewhere if holds need to be restricted to the branch library. Not holdable outside owning library (branch only holds).</td>
<td>r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>high-demand</td>
<td>Items with this modifier can be any media, format, or audience. Used to support a program where patrons can check out high demand items if they are on the collection shelf when the patron is in the library. Voluntary use; libraries can name program/collection as they wish; some libraries call their collection Lucky Day. Items with this circulation modifier have a circulation period of 7 days; $1.00/day fine, OPAC invisible and should be set as nonholdable (if library uses separate shelving/copy location, it should be set up as not holdable and OPAC invisible. Otherwise, items with the circ modifier should have attributes set to not holdable and OPAC invisible).</td>
<td>Type depends on format and content.</td>
</tr>
<tr>
<td>Circulation Modifier</td>
<td>Description</td>
<td>MARC Type Correlation (if applicable)</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>ILL item</td>
<td>This circulation modifier is used <strong>ONLY</strong> for items borrowed through OCLC ILL and have records created as Precataloged items. They can be any media, format, or audience. Items with this circulation modifier have a circulation period of 14 days; .20/day fine, OPAC invisible, and no renewals. See Processing Interlibrary Loan Items in PINES: Best Practices for more information</td>
<td>Type is not applicable.</td>
</tr>
<tr>
<td>kit</td>
<td>Mixed-formats or multiple components that circulate as a unit under one barcode. May not be considered a kit for cataloging purposes (record may not use Type o since a component might be considered primary). Not holdable outside owning library system.</td>
<td>Type varies.</td>
</tr>
<tr>
<td>localpass</td>
<td>A ticket or other physical pass to a local venue or attraction. Generally cataloged as Type k – two-dimensional nonprojectable graphic. Not holdable outside owning library system; may not be holdable depending on partnership program requirements.</td>
<td>k: Two-dimensional nonprojectable graphic.</td>
</tr>
<tr>
<td>magazine</td>
<td>Individual or bound issues of a periodical. Not holdable outside owning library system.</td>
<td>a: Language material.</td>
</tr>
<tr>
<td>map</td>
<td>Physical map and other cartographic material in any format, not including atlases. (Use circ modifier book for atlases). Not holdable outside owning library system.</td>
<td>e: Cartographic material; f: Manuscript cartographic material.</td>
</tr>
<tr>
<td>microform</td>
<td>Forms containing micro-reproductions. Includes microfilm reels and microfiche cards. These can be cataloged as monographs, serials or other MARC Types. Not holdable outside owning library system.</td>
<td>Type varies.</td>
</tr>
<tr>
<td>music</td>
<td>Music sound recordings in any format. Can be audiocassettes, compact discs, MP3 players or other nonprint physical media designed to be played back on an audio device. Holdable outside owning library system.</td>
<td>j: Musical sound recording.</td>
</tr>
<tr>
<td>music-ff</td>
<td>Music sound recordings in any format. Can be audiocassettes, compact discs, MP3 players or other nonprint physical media designed to be played back on an audio device. Holdable outside owning library system. <strong>Does not accrue fines. Use is currently restricted to libraries participating in the fines free pilot project.</strong></td>
<td>j: Musical sound recording.</td>
</tr>
<tr>
<td>realia-0</td>
<td>Any three-dimensional artifact or naturally occurring object not appropriate for other circulation modifiers. May be games, toys, musical instruments, etc. Not holdable outside owning library system. No renewals.</td>
<td>r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>realia-1</td>
<td>Any three-dimensional artifact or naturally occurring object not appropriate for other circulation modifiers. May be games, toys, musical instruments, etc. Not holdable outside owning library system. One renewal.</td>
<td>r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>Circulation Modifier</td>
<td>Description</td>
<td>MARC Type Correlation (if applicable)</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>realia-2</td>
<td>Any three-dimensional artifact or naturally occurring object not appropriate for other circulation modifiers. May be games, toys, musical instruments, etc. Not holdable outside owning library system. Two renewals.</td>
<td>r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>software</td>
<td>Programs used to control the functioning and operation of a computer or other device. Can be any format. Use videogame for game software. Not holdable outside owning library system.</td>
<td>m: Computer file.</td>
</tr>
<tr>
<td>statepass</td>
<td>Any physical pass or ticket issued for a venue or attraction that is a part of a state-wide promotion. May be governed by contractual obligations requiring specific circulation rules. May be a serial or a kit. Not holdable unless allowed by partnership agreement.</td>
<td>k: Two-dimensional nonprojectable graphic.</td>
</tr>
<tr>
<td>talking-book</td>
<td>Audio recordings specifically formatted for use of the visually impaired.</td>
<td>i: Nonmusical sound recording.</td>
</tr>
<tr>
<td>toy</td>
<td>Realia toys, games or other three-dimensional object for play or instruction using play. Not holdable outside owning library system.</td>
<td>r: Three-dimensional artifact or naturally occurring object.</td>
</tr>
<tr>
<td>video-0</td>
<td>Projected video/media on any physical format. A 007 field should be included in the bibliographic record to define media format. Not renewable. Holdable outside owning library system.</td>
<td>g: Projected medium.</td>
</tr>
<tr>
<td>video-0-ff</td>
<td>Projected video/media on any physical format. A 007 field should be included in the bibliographic record to define media format. Not renewable. Holdable outside owning library system. Does not accrue fines. Use is currently restricted to libraries participating in the fines free pilot project.</td>
<td>g: Projected medium.</td>
</tr>
<tr>
<td>video-2</td>
<td>Projected video/media on any physical format. A 007 field should be included in the bibliographic record to define media format. Two renewals. Holdable outside owning library system.</td>
<td>g: Projected medium.</td>
</tr>
<tr>
<td>video-2-ff</td>
<td>Projected video/media on any physical format. A 007 field should be included in the bibliographic record to define media format. Two renewals. Holdable outside owning library system. Does not accrue fines. Use is currently restricted to libraries participating in the fines free pilot project.</td>
<td>g: Projected medium.</td>
</tr>
<tr>
<td>videogame</td>
<td>An electronic or computerized game played by manipulating images on a video display or television screen. Holdable outside owning library system.</td>
<td>m: Computer file</td>
</tr>
</tbody>
</table>
From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/10/26 13:47
Recommended Collection Maintenance Reports

The following reports assist libraries with maintaining the accuracy of their local collection data.

**Claims Returned**

Libraries may mark Claims Returned items Lost after 45 days from the due date. For assistance identifying these items, use:

_Quick Reports > Quick Report Templates > Items > List of Items Marked Claims Returned_

See also: Claims Returned Items

**Holds**

**Expired Holds:**
To identify expired holds that are currently on your holds shelf, see: Clear Holds Shelf

**Hopeless Holds:**
To identify holds that cannot be filled because all copies on the record are unfillable. See: Hopeless Holds

**Uncaptured Holds:**
To identify holds where an item has been targeted but the item has not been found.

_Quick Reports > Quick Reports Templates > Holds > Unfilled Holds (Not Captured)_

**Inventory**

See: Inventory Process

**Item Status Report**

Get lists of items of a particular status (Missing, In Process, etc.) in order to do shelf checks.

_Quick Reports > Quick Report Templates > Items > List of Items by Status_
Long Overdue Items

See: Long Overdues

Pre-Cats

Pre-cat (pre-cataloged item) records are temporary records used for Interlibrary Loan or to allow checkouts of items that have barcodes but no record in the catalog. Pre-cat records should be used for temporary purposes only and should be corrected (or deleted, in the case of ILL) when the item is returned to the library.

Quick Reports > Quick Reports Templates > Items > Pre-Cat List

See also: Instructions for managing Pre-Cats

Transit Reports

Transit reports can help you to identify items that have been put into the transit status but have not been scanned in at their destination. You can retrieve transit reports through a built-in staff client function or through a report, depending on your needs. Items identified this way should be looked for at both the sending and receiving libraries.

See: Clear Items In Transit

Weeding Report

Quick Reports > Quick Report Templates > Items > Basic Weeding List

The Basic Weeding List is meant to provide a list of possible items to consider for weeding. Each item on the list should be reviewed on its own merits (see Slideshow link below for tips.

Report filters:

- **Use Count (Less than):** This is the number of total circulations over all time. If you want to list items that have circulated less than 10 times since they were added to the collection, enter 10. If you want to only list items that have never circulated, enter 1.
- **Shelving Location Name (Substring):** Enter part or all of the name of the shelving location that you are weeding. This report filters by shelving location in order to make the results manageable and because you will likely have different weeding requirements for each section of a branch.
- **Callnumber Label (Between):** This filter allows you to focus on a specific section of a large shelving location. If you want to weed everything in the Dewey 200s, enter 200 and 300 to capture everything between those call numbers. If you want to look at the entire shelving location, enter 0
(zero) in the first box and zzz (lower case) in the second box.

- **Status (In List):** In many cases, you would only look at items in the Available status to consider for weeding because if an item is Checked Out then it means there is current interest in it. However, this filter allows you to select as many other item statuses as you wish. By selecting all statuses, you may identify some items that are in incorrect statuses as well, such as items in “Canceled Transit” status that are actually on the shelf.

- **Last Circulation Date (Before):** This filters out any items from the list that have circulated recently. If you don't want to weed anything that has circulated in the last 3 years, then select a date 3 years ago.

- **Organizational Unit ID (In List):** It is best to only circulate one branch per report.

See also: Weeding and Inventory Slideshow

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/07/18 17:42
Offline Circulation

There are times when the full PINES functionality is unavailable – during a PINES upgrade, or unexpected outage, when a library's internet or local network service goes down, or when doing outreach in an area without an available internet connection.

Rather than shutting down all circulation operations or trying to track checkouts on paper, you can use the Evergreen Offline Interface to process checkouts. There are several advantages over the paper method: 1) the barcode scanner can be used to reduce typing errors and save time, and 2) a receipt will print after each checkout.

This interface stores a local transactions file that contains information about all of the circulation actions made while offline. When the computer can reconnect to the PINES server, that offline file must be uploaded and processed as soon as possible.

**Do Not Clear Cookies or Local Database:** Offline transactions are stored locally within the browser's built-in storage. If you perform offline transactions and then clear your cookies or delete your browser's local database before uploading the offline transactions to the server, then those offline transactions will be lost. (Clearing cache is fine.)

Set Up

Prior to using the web-based offline interface for the first time, you will need to:

1. Bookmark the offline circulation page in your browser:
   - https://gapines.org/eg/staff/offline-interface
2. If you are using Hatch, you may need to disable it in order to print while offline.
3. Log in to the staff client, register a workstation, and click through the Check Out, Check In, and Register Patron pages (this loads information into the browser's local storage for use when offline).
Using the Offline Interface

Start

1. Open the Offline Interface: https://gapines.org/eg/staff/offline-interface
2. Verify that the Workstation and Working Location are correct.

Checkout

1. Click on the Checkout tab.
2. Set the Due Date either by using the calendar OR by changing the Offset dropdown to “Today + 14
Days” (or whatever time period is appropriate for the item type).
3. Check the Print Receipt box.
4. Scan the patron barcode.
5. Scan an item barcode.
   ○ Or, circulate honor-system items by using the Non-cataloged Type option and the number counter.
6. Click Checkout after each item. This will display the item to the right.
7. When all items for the patron have been checked out, click the Save Transactions button at the top of the page.

**Renew**

The offline interface does not provide information about what items a patron already has checked out, how many times the patron has already renewed their items, or if the items they are renewing are on hold for another patron. So, if a library chooses to renew items through this interface, the system will provide a list of errors when the offline file is uploaded that staff will need to follow up on.

1. Click on the Renew tab.
2. Set the Due Date either by using the calendar OR by changing the Offset dropdown to “Today + 14 Days” (or whatever time period is appropriate for the item type).
3. Check the Print Receipt box.
4. Scan the patron barcode.
5. Scan an item barcode.
6. Click Renew after each item. This will display the item to the right.
7. When all items for the patron have been renewed, click the Save Transactions button at the top of the page.

**In-house Use**

1. Click on the In-house Use tab. (Do *not* check the Print Receipt box.)
2. Scan an item barcode.
3. Click Record Use after each item. This will display the item to the right.
4. When all in-house use items have been scanned, click the Save Transactions button at the top of the page.

**Checkin**

The Checkin function **should not be used in PINES** because it will not be able to alert staff if the item has any holds, transits, routing alerts, or any other type of statuses that require staff attention.

**Register Patron**

The offline interface has no way of knowing whether or not the patron that is applying for a library card already has a card in the system. If your library chooses to register patrons using the offline interface, you will need to be very diligent about checking each new account for older duplicate cards after you reconnect to the server. If you find duplicates, create a help desk ticket for each one so that they may be merged (see: [Multiple Patron Accounts / Patron Record Merging](https://pines.georgialibraries.org/dokuwiki/)).

1. Click the Register Patron tab.
2. Verify that the screen is showing All Fields.
3. Complete the registration form as you normally would (see: Creating New Patron Accounts).
4. Click the Save button.
5. Click the Save Transactions button.

**Uploading the Offline Transactions**

1. Log in and go to Circulation > Offline Circulation.
2. Click on the Session Management tab.
3. Click on the Offline Sessions tab.
4. Click the Create Session button and enter a name for that session (ex: Upgrade CircComputer1).
5. Select / highlight the new session you created.
6. Click the Upload button.
7. After uploading, click the Process button (the processing step must be done by a staff member logged in as a LibraryManager or LocalAdmin).
8. When processing is complete, scroll down to the very bottom of the screen to see the Exceptions List.
9. Go through each item in the exception list and investigate and correct the problem. The Item and
Patron buttons to the right of each row are clickable and will open in a new browser tab for convenience.

Definitions of Exceptions

**ACTOR_CARD_NOT_FOUND**
Indicates the patron's library barcode was mis-scanned/mis-typed. Attempt to correct it if you can determine the error, but that may not be possible.

**ASSET_COPY_NOT_FOUND**
Indicates the item barcode was mis-scanned/mis-typed. Attempt to correct it if you can determine the error, but that may not be possible.

**CIRCCLAIMS_RETURNED**
Indicates a book previously marked as claimed returned was found and checked out. Check the current patron to be sure it is checked out correctly, and check the item's history to make sure any erroneous messages or fines are removed from the prior patron's account.

**COPY_IN_TRANSIT**
Indicates a book was checked out that had been marked as in transit. Check the patron to make sure that the book was checked out correctly to his or her account.

**COPY_STATUS_LOST**
Indicates a book previously marked as lost was found and checked in.

**MAX_RENEWALS_REACHED**
Since the patron already has the item in hand, you will need to go into the patron's account and either override the extra renewal to allow it or change the due date to the new due date.

**OPEN_CIRCULATION_EXISTS**
Indicates a book was checked out that had never been checked in. This is not usually an issue because the book should usually appear on the patron's account correctly even though the error appears on this list. However, you should look up the item's history to be sure that it is showing up correctly and no longer indicates that it is checked out to the previous patron.

**PATRON_ACCOUNT_EXPIRED:**
If you are downloading the offline patron list on a daily basis, and if the Circulation Staff are paying attention to the error messages that pop up while using the Standalone Client, you should rarely see this error. On the occasions you do see it, go into the patron's account and renew their card for a few days. Make a note in the patron's account to renew their card the next time they are in the library and check out the items to that card. You may also wish to add a message to the Patron Message Center (see: Alerts, Notes, and Messages) to alert them that they'll need to renew their card (see: Card Expiration and Renewal) the next time they come into the library.

Problems That May Not Generate Exceptions
• Checking out an item with an incorrect borrowing time.
• Attempting to re-check out an overdue book.
• Checking out a reference book.
• Checking out an item belonging to another library.
• Checking out a book on hold for another patron.

Importing and Exporting Pending Transactions

If for some reason the workstation that was used for offline circulation cannot be used to upload the transactions file, that file can be exported and then imported into a different workstation for uploading and processing.

1. On the workstation that was used for offline circulation:
   • Go to the Offline Circulation interface.
   • Click on the Export Transactions button.
   • Save the file to a convenient location (do not change the name or formatting or add a file extension).
2. On the workstation that is connected to PINES:
   • Log in and go to Circulation > Offline Circulation.
   • Click on the Session Management tab.
   • Click on the Pending Transactions tab.
   • Click on the Import Transactions button.
   • Select the offline file that you saved in step 1.
   • Go to the Offline Sessions tab and upload and process as normal.

Viewing Offline Transactions without Exporting

The easiest way to view offline transactions before uploading them is to export them. However, if that is not possible, you can view them via the browser's internal tools. (Clearing your browser's local storage (cache) will erase the offline transaction data, and you will no longer be able to access it.)

In Firefox:

1. Click on the Menu icon (three dashes) > Web Developer > Storage Inspector
2. Expand Indexed DB
3. Expand https://gapines.org
4. Expand offline (default)
5. Click on offlineXact
6. You should be able to view the value for each offline transaction that has not yet been uploaded.
In Chrome:

1. Click on the Menu icon (three dots) > More Tools > Developer Tools
2. Switch to Application tab
3. Expand Indexed DB
4. Expand the offline https://gapines.org section
5. Click on offlineXact
6. Expand each row to see the data.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/03/11 14:45
**Curbside Pickup Module**

**Enabling Curbside Pickup**

Curbside pickup functionality was added with the 3.6.1 upgrade in January, 2021. Usage of this module is optional and can be enabled either at the branch level or the system level. To enable the functionality, submit a Help Desk ticket with the following information:

1. The Library System or Branch to enable it for
2. The maximum number of possible pickups per pickup time slot
3. The duration of the pickup time slots (15 minutes, 30 minutes, 1 hour, etc.)

**Assumptions**

Curbside pickup assumes a few things.

1. Curbside pickup has been enabled for the library system or branch.
2. A staff member must be assigned to monitor the appointments for the day.
3. The library's hold shelf in PINES must agree with what is on the physical holds shelf.
4. You have a work table / area set up to place the items that should be picked up in the next time slots.
5. Only items that are placed on hold and ready for pickup are available for appointments and checkouts through the curbside pickup module.
6. It also assumes that patrons with appointments will have their items checked out from the Curbside interface, and not from the standard checkout interface. If a patron has a Curbside appointment, but decides to come in and check out from the desk or from a self-check machine, this can lead to an “empty” appointment in the Curbside interface. This will not hurt anything, but it may be confusing.

**Workflow**

**Video demonstration of curbside pickup**

Open “Curbside Pickup” by clicking on the circulation menu. Go to the bottom of the menu to find it. (If you cannot see the full menu, you may need to scroll down or press the Ctrl key and the “-” (minus) key to zoom out. If you do this, you can use Ctrl and + (plus) to zoom back in.

There are 5 tabs on the curbside window:

1. To Be Staged
2. Staged and Ready
3. Patron Is Outside
4. Delivered Today
5. Schedule Pickup

1. Schedule a Pickup

When a hold is ready to be picked up, an email notification will be sent to the patron's address on file informing them that curbside pickup is available for your location and they can call or log in to the online catalog to set up an appointment. (The phone number included in the message will be the library's phone number that is set in the PINES database.) Please note that the emails are sent from the server in batches, so it may take up to an hour for the email to be sent out. If the location is only doing curbside pickup, then staff may need to call those patrons who have not yet called in.

Scheduling by phone:
When you are speaking on the phone to a patron, open the “Schedule Pickup” tab and enter the patron barcode number. After entering the patron card number, the patron name will display along with the number of holds available for that patron at your location.

Click the “Make New Appointment” to select an appointment date and then time slot. The number beside the time shows the remaining appointments for that time slot. Appointments can only be scheduled during normal operating hours. There is also a box for notes should any need to be entered - for instance, you may want to enter a description of the car / license plate number so that the patron will not have to call in when they arrive. Click the “Save” button. The appointment has now been scheduled. A confirmation will be displayed in the bottom right corner of the screen.

An email confirmation will automatically be sent to the patron's email address on file.

Self-scheduling in the OPAC:
Patrons can also schedule their own appointments in the public catalog.

When a patron's home library uses the Curbside Pickup module and the patron has an item ready for pickup, they may schedule pickup appointments online:

1. The patron will log into the OPAC and go to My Account > Curbside Pickup.
2. An appointment form will appear. First, select a date.
3. Click the Check times button, then select a time. to select a date and then choose a time.
4. Optional: The patron may wish to include arrival notes such as the color and type of vehicle they will be arriving in.
5. Click on “Request Appointment” and wait for the page to refresh.
6. Upon arrival at the library, the patron may click on the “Alert staff of your arrival” button or may call in to let the library know they are there.
2. Retrieve Items

Open the “To Be Staged” tab to retrieve the holds needed to fill the appointments in the next ten time slots. (If your time slots are set to 15 minutes, you will only see a list of holds for the next 2 1/2 hours - if your time slots are set to 1 hour, you will see holds to retrieve for the next ten hours.)

Retrieve the listed items, and place them in your curbside pickup work area. Then select them on the list and click “Mark Staged and Ready for Pickup.”

The Staged and Ready tab shows which holds have already been placed in the curbside area and are ready for pickup.

If more than one staff member is working on curbside pickups the staff members can “claim” the patron to prevent others from trying to pull the same items. Click on the “Claim” button to claim that patron’s pickup.

3. Mark Patron Arrival (Optional)

Depending on your library’s setup, you may want your patrons to call in when they arrive and your curbside pickup staff person may not be the person who answers the phone. If this is the case, whoever answers the phone can go to the Staged and Ready tab and click “Mark as Patron Arrived.”

Note: The patron may also use the “Alert staff of your arrival” option through the online catalog to inform staff of their arrival.

The curbside pickup interface will refresh itself every 15 minutes, but can be updated more quickly by refreshing the browser page. So, if the curbside pickup staff person is in a different area than the staff person answering the phone, the curbside pickup person may want to refresh the browser page more frequently to see which patron has pulled up and called in.

If the curbside pickup staff person is also receiving the phone call or has another way of knowing which patron has pulled up, then the “Mark as Patron Arrived” action is not required.

4. Check Items Out
If your local workflow is to mark patrons as arrived (see step 3, above), then the Patron is Outside tab will show you which patrons are waiting outside. If you are using this function, select the items for the patron and click “Checkout Items and Mark as Delivered.”

If you are not using the mark patrons as arrived function, you can check items out to a waiting patron by going to the Staged and Ready tab, then selecting the items and clicking “Checkout Items and Mark as Delivered.”

Items should not be checked out to the patron until the patron has arrived.

**5. Deliver the Items**

Deliver the items to the waiting patron.

The Delivered Today tab will show which patrons and items were picked up via curbside today.

**Rescheduling**

To reschedule an existing pickup appointment, go to the Schedule Pickup tab and enter the patron barcode. The patron’s existing appointment should appear and be editable.

Patrons may also see and reschedule their appointments through the OPAC.

**Report of Upcoming Appointments**

You may also run a report to see all of the upcoming pickup appointments you have scheduled for any selected time period. This may be helpful in scheduling staff coverage. This report is available under:

*Reports > Shared Folders > Templates > terran > Help Desk > Circulation > Curbside Pickup Appointment Slots*

**More Information**

More detailed information is available in the Evergreen software documentation at: https://docs.evergreen-ils.org/eg/docs/latest/circulation/curbside_pickup.html

Video demonstration at: https://my.nicheacademy.com/pines/course/24107
Holds

PINES patrons may place holds on most books and audiovisual materials owned by any PINES library, as well as on certain additional types of materials within their own local library system. Items which are placed on hold will be delivered via courier from the owning library to the patron's desired pickup library.

*Note: Prior to March 1, 2022, holds on audiovisual materials were restricted to pickup at their owning library systems.* [2021.12]

Circulation periods and allowed renewals are standardized across PINES libraries, but some types of materials have several different circulation options which are set by their owning libraries (see the Circulation Matrix for details). When thinking of intra-PINES lending, it is important to remember that a PINES patron is a patron exactly like your local patron. Intra-PINES loans are not ILLs – they are simply circulations like any other. The PINES Executive Committee has ruled that circulations between PINES libraries must be free of charge to system libraries and to patrons [2008.09].

The vision of the PINES statewide library card included as a key component the ability for patrons to see and borrow library materials from all participating public libraries in the state. Our goal is maximum access for all patrons, while realistically addressing the logistics of moving materials around the state. Member libraries have agreed that PINES membership would not relieve libraries of the responsibility for purchasing the materials needed to meet the demands of local patrons.

Staff must never give preference to one patron over another regarding holds. The PINES code of ethics requires that all libraries respect the integrity of the hold queue, and share equitably.

Placing Holds

- Patrons may place their own holds via the OPAC, and may select their pickup location and notification method. The software will refuse holds requests which do not conform to PINES policies. Patrons may choose any pickup location for holds. Patrons may not place multiple holds on a single title record, but staff may place multiple holds on a single title record for specific purposes (e.g., for a book club) [2006.05].
- Patrons whose PINES cards are expired will not be allowed to place holds until the card privilege is renewed.
- Most patrons may place 50 holds at any given time on their account [2006.11]. Certain user categories are restricted to different number of holds limits.
- If a patron presents the on-hold item for checkout before it is retrieved for the requesting patron, the in-house patron with item in hand receives preference; a circulation supervisor will override the hold and check out the item to the in-house patron. The requesting patron will be next in line for the item.
- Hold requests expire after 6 months with the option for staff or patron to make it an earlier or later date [2008.02].
Pulling Holds

An automated process (the Holds Targeter) runs periodically and identifies copies of items at PINES libraries that can fulfill holds.

Each weekday (M-F) morning, each PINES library location will print a report (the Holds Pull List) of items on their shelves which have hold requests (Circulation > Pull List for Hold Requests). The items on this list should be retrieved from the shelves and processed within 24 hours.

If an item should be on the shelf but cannot be found, mark the item Missing (Circulation > Item Status > Scan Barcode > Actions > Mark Item as Missing). This will direct the Holds Targeter to look for a different copy of the item within PINES. It will also allow you to generate a report of missing items in your library.

If you receive an inappropriate holds request on your list (for an item type that is not eligible for intra-PINES loans), contact the requesting library via e-mail or telephone and ask them to remove the hold. Please DO NOT ignore such holds, as they will continue to appear on your list each day until they are resolved.

Libraries may choose to pull and process holds more than once per day if desired, and may also choose to pull and process holds on weekend days if desired.

Processing Holds

After pulling items from the shelves (or when receiving items routed to your location to fulfill a hold from another location), scan them into the Checkin Interface (Circulation > Capture Holds).

If the item being scanned is on hold for a local patron, the system will print a Hold Slip that contains the patron’s contact information. If the patron has chosen to be notified by email, an email will be automatically generated within the hour and sent to the address on file. If the patron has chosen to be notified by telephone, then staff must call the patron. The item should then be placed on the Holds Shelf.

If the item being scanned is on hold for a patron of another location, the system will print a Transit Slip and staff will place the item in transit. Items should be appropriately packaged to protect them from damage while in transit [2008.11]. All materials should be treated the same as each library would want its own materials handled [2009.05].

The library should keep the hold or transit slip with the item (most libraries will insert the slip into a book with the slip showing), but should never use tape to attach the slip to a book [2019.09].

Additional information:

- Holds that are not processed within 24 hours will be re-targeted to another library if possible. For 5 days, the hold targeter will only select items within the pickup library. After 5 days, the hold may be filled by any copy within PINES [2007.12]. Borrowed items should be promptly sent back to the owning library or on to the next library to fill a hold.
- A spreadsheet of PINES delivery addresses is provided to each library (see Library Routing, Courier,
and Contact Info); you can print out the addresses needed on demand. For convenience, the Evergreen receipt templates for transit items are configured by default to print the library policy name and courier code for each item (see Print Templates). All items should be sent out within 24 hours of receipt of the holds list.

- Items should be placed in a green PINES courier bag with the courier code and library policy name in clearly showing through the window of the bag. Multiple items may be placed in a green bag, but all items within a bag must be destined for a single library branch (ie, an item going to ARL-ATH and an item going to ARL-BOG must be packaged in separate bags).
- Holds notices will be emailed within an hour of when the item is available for those patrons who have email addresses in their user records and who have chosen to be notified by email. Each library is responsible for contacting users who have chosen to be telephoned regarding available holds. No paper notices will be mailed centrally.
- Holds will also be captured in the normal course of checking in items. These holds should be processed and routed within 24 hours.

**The Holds Shelf**

Each library may decide how long to keep its own items on the holds pickup shelf; however, items from outside the local library system should be held on the holds shelf for a maximum of seven (7) open business days [2009.05], then returned to the owning library or forwarded to the next person waiting in line for a hold.

**Clearing the Holds Shelf**

Staff should monitor the holds shelf and remove items that have not been picked up within the designated amount of time or whose holds have been cancelled.

**Identify the holds which should be placed back into circulation.**

1. View the holds shelf (Circulation > Holds Shelf). The list you see should match the books that are actually present on your holds shelf.
2. Determine which items should be pulled off of the holds shelf.
   - If you check the View Clearable Holds box, it will show you which items have been on the holds shelf for more than 7 days.
   - The Available On column displays the date that the item was actually placed on the holds shelf.
   - Each library system may determine how many days to allow their own items to remain on the holds shelf. However, items belonging to a different library system should not be held for more than 7 days.
3. Scan the items in the Checkin interface using the ‘Clear Holds Shelf’ Checkin Modifier (see Checkin Modifiers).
   - If you have checked the View Clearable Holds box and you press the Clear These Holds button, the current holds for the listed items are all cancelled at once, but their item status will still read ‘On holds shelf’ until you check the items in. If you use this method, you do not
need to use the 'Clear Holds Shelf' Checkin Modifier, you can just check the books in as normal.

- If you use the ‘Clear Holds Shelf’ Checkin Modifier, be sure to disable the modifier before checking in other books. (On the Check In screen, press the Checkin Modifiers button on the bottom-right of the screen and select Clear Holds Shelf to remove the checkmark.)

### Checking in Returned Holds

When a patron returns an item that is owned by another library, the system will print out a transit slip directing the staff to return the item to the owning library (or to the next location waiting for a hold on the item). Route these items to the appropriate location within 24 hours of their return.

### Suspending Holds

A hold can be placed on an item and then suspended (inactivated) until a later date by staff or the patron. The holds targeter will ignore these holds while they are inactive.

If an activation date is set, the system will automatically reactivate the hold on the set date. If not, the hold will not reactivate until manually reactivated by the patron or by library staff.

### Changing the Pickup Location of a Hold

A staff member or a patron may change the pickup library of a hold after the hold has been placed. Once the pickup location has been changed, the item needs to be scanned on the checkin screen to place it in transit to the correct pickup library.

A patron may change the pickup location of a hold by going to My Account > Holds, then clicking the 'Edit' link next to the title.

Staff may change the pickup location of a hold from the Holds Shelf screen or from the Patron's Hold screen (Actions > Edit Pickup Library).

If the hold has its pickup library changed while it is in transit to the original pickup library, when it arrives and is scanned in, it will print a new transit slip to the new pickup library.

If the hold has its pickup library changed after it has already arrived at the original pickup library, the Status on the Holds Shelf screen will say 'Wrong Shelf.' If staff see the Wrong Shelf status, staff should re-scan the item on the check in screen in order to place it into transit to the new destination.
Holds Behind Circ Desk

A library may choose to have the holds shelf located in a staff-only area or in a public area where patrons can retrieve their own holds. Libraries that have public holds shelves can offer patrons the ability to request that their holds are placed in a private area. To make use of this feature, the library should set the “Behind Desk Pickup Supported” option to “true” in the Library Settings Editor. This will display a “Hold is behind Circ Desk” option on the patron information screen. Hold slips for these patrons will print with the notation “PRIVATE HOLDS SHELF” and all other hold slips will print with the notation “PUBLIC HOLDS SHELF” [2014.05].

Hold Restrictions

Select categories of items (defined by circulation modifiers) and age-protected items are only available for holds by patrons registered to the owning library/region, and are only available for pickup within the item's owning system. [2007.02]

Restrictions by Circulation Modifier

PINES policy enforces hold restrictions on categories of items with select circulation modifiers including, but not limited to, statepass, microform, and e-device. Some types of items are holdable only at the owning library or within the owning regional library system, and some types of items are not holdable. Leased items will be treated the same as any other book with regards to holds [2006.11].

Note: Prior to March 1, 2022, holds on audiovisual materials were restricted to pickup at their owning library systems. [2021.12]

For a complete description of the circulation and hold policies related to each circulation modifier, see: PINES Circulation Modifier List and Definitions

Age Protection

Age Protection allows libraries to prevent holds on new books (on a copy by copy basis) from outside the owning library's branch or system for a designated amount of time. The purpose of this is to give the library's local patrons a chance to check out the new book before sending it off to other libraries. Libraries typically use this feature for popular fiction, but may also choose to use it for any or all other new books.

Each item (copy) has an “age_protect” flag which may be set to 3 month, 6 month, or None (based on the item's activation date):

- If set to “3 month” and the item was made active less than 3 months ago, the item is only holdable by patrons whose home library matches the circulating library of the copy. (Note: The system
interprets 3 months as 90 days.) After 3 months, the item will automatically roll over to 6 month age protection.

- If “6 month” is set and the item was made active less than 6 months ago, the item is only holdable by patrons whose home library is within the same system as the circulating library of the item. (Note: The system interprets 6 months as 180 days.) After 6 months is over, the item will no longer be age protected and holds may be placed on it from any PINES location, but the age_protect flag will still appear as “6 month.”
- If age protect is set to None, then no age protection occurs and the holds can be placed on the item from any PINES location.

**Book Club Holds**

Library staff may place up to 20 holds on a single title at once for the purpose of obtaining copies for book clubs. To use, place a title-level hold as normal but select a number from the Number of Copies dropdown list. [2019.01]

**Holds on Multi-Part Items**

See: [Instructions for Circulation and Reference Staff (Video)](https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:holds)
Hold Groups

Available as of the 3.8 upgrade January 2022.

Hold groups are designed to store lists of patrons that wish to have holds placed for them on selected items. For example, a library book club may store a list of patrons who wish to have each upcoming month’s reading selection placed on hold for them. Staff can reuse this list each month, adding and deleting patrons from it upon request. Or, a library may wish to store a list of patrons who are waiting for the new release by a popular author - staff could add patrons to the list upon request, and then when the title becomes available, can place holds for all of the patrons on the list at once.

How to Create a Hold Group

1. Go to Circulation > Hold Groups
2. Click on New Hold Group
3. Enter a name, a description (optional), and select whether the hold group will be for the local branch or the regional library system.
4. Choose whether or not the hold group should be visible to patrons within the OPAC or not.
5. Click Create Bucket.

Note: If you wish to edit or delete a hold group, double-click on it to open it in the Current Users tab and then click the Hold Groups dropdown to Edit or Delete it.

Add Users to Hold Group

1. From the Hold Groups tab, double-click on the hold group that you wish to add users to. This tells the system which hold group you wish to access and will take you to the Current Users tab.
   ○ If you need to open a hold group created by a different staff member, they will need to give you the hold group ID number. Go to the Current Users tab, click on the Hold Groups button, then click Shared Hold Group. Enter the ID and click Load Bucket.
2. Move to the Add Users tab.
3. Enter the barcode of the patron you wish to add. (If typing it in, you will need to click Enter.) You should see the patron load on the list below. Repeat for each patron.
4. After all patrons have been entered, select them and click Add All to Hold Group. This will move them to the Current Users tab.

Alternatively, if you are the person who created the hold group, you can add patrons directly from the patron search results.

1. Do a patron search.
2. Select the correct patron from the search results.
3. Click Add to Bucket.
4. Select the appropriate Hold Groups bucket.
5. Upon success, a message will briefly appear on the lower-right corner.

You cannot do this with a hold group created by another staff member because the Add to Bucket list will only display ones you created.

**How to Place Holds for a Hold Group**

1. In order to place a hold for a hold group, you will need the database ID for the title record you wish to place a hold for. Search the catalog, then click on the title you wish to place a hold for to open the title details. You will see the Database ID in the title summary bar. (This number also appears in the URL.) Copy that number.

2. Go to the Hold Groups tab and double-click on the hold group you wish to place a hold for.

3. Go to the Hold Events tab.

4. Click on New Hold Group Event, then enter the database ID. Uncheck the “Override all hold-blocking conditions possible?” option if it is checked so that you do not inadvertently place holds for patrons that are blocked.

5. Click Create Event.

6. The page will refresh and tell you how many holds were placed. If the hold could not be placed for one or more of the patrons in the hold group, a link for “Download patron list for failed holds” will appear. Click on that link to see the patron barcodes - you may wish to look up each patron to see why the hold failed.

**Patron View**

Patrons can see which Hold Groups they are currently a member of, and remove themselves from any of them they wish.

1. Log in to the OPAC and go to My Account.
2. Click on Holds, then Hold Groups.
3. The list of hold groups the patron is currently a member of will display. (The list will be blank if they are not a member of any hold groups.)
4. Click “Remove me” next to any hold group the patron no longer wishes to be a member of.

---

From:  
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation  
Permanent link:  
Last update: 2021/12/31 16:26
Hopeless Holds

What are Hopeless Holds?

A hold becomes “hopeless” when all available copies become unavailable.

For example, Jo places a hold on a title record that only has one available copy. When staff go to pull that copy to fill the hold, they cannot find it and mark it ‘Missing.’ If there were other copies still available, the holds targeter would retarget the hold to another copy, but since there are no other copies that can be targeted, the hold gets added to the Hopeless Holds list.

Library staff can check the Hopeless Holds list to see if there is another title record that the hold can be transferred to in order to fill the hold for the patron. Libraries may also use this list for collection development purposes.

Limitations

Please note that the Hopeless Holds list will not capture all holds that go unfilled in all scenarios. For example, in the example scenario above, if library staff did not mark the item missing when they couldn't find it, the hold would not appear on the Hopeless Holds list. Libraries may wish to use the PINES Quick Report for “Unfilled Holds (Not Captured)” to identify that type of issue.

How to Identify Hopeless Holds

Open the Local Admin menu and click on “Hopeless Holds”. This is a list of holds that cannot be filled due to the status of the items on the record. The patron will not get these items unless the hold is moved to a better bib (ie, title) record.
How to Transfer Holds to Better Records

1. Open the catalog in a new tab and do a search for the title of the hopeless hold. If possible locate a different bib record with available copies for the hold.

2. Open record 2 and go to the “Mark For” menu or right click to see the menu.

3. Click on “Reset Record Marks” before doing anything else.

In this example, the hopeless hold is on record number 1. Record number 2 has a copy that is available, so it will be a better record for the hold.

When comparing title records, be sure to check that the one you select for transferring is as close to the original record as possible. For instance, you wouldn’t want to transfer a hold that was on a DVD record to a print record, or to transfer to similar title by a different author.
This is a very important step to be sure the hold transfers to the correct record.

4. Next click on “Title Hold Transfer”.

A small box will appear in the lower right corner of the screen confirming the transfer target has been set.
5. Return to the tab showing the hopeless holds list. Select the line for the title needing to be transferred to the current hold transfer target. Go to the actions menu or right click to view the menu options. Select “Transfer to Marked Title”.

A confirmation window will open.
6. Click on “Transfer.”

A small box will appear in the lower right corner of the screen confirming the hold has been transferred.

   01/27/2021 17:16
   03/03/2021 22:12
   03/29/2021 07:05
   02/02/2021 12:31
   04/05/2021 16:06
   Successfully Transferred Hold

7. Repeat these steps to continue transferring holds to records that have available copies for the hopeless holds.

8. When all holds have been transferred, open any record in the catalog and reset the record marks. This will help prevent holds being transferred to the wrong record in error the next time a hold is transferred.
You may encounter holds that do not have any other suitable record for transferring. Those titles could be considered for collection development purposes, or the holds could simply be left alone to naturally expire.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:
https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:hopeless-holds

Last update: 2021/07/08 18:34
Courier

Transit Slips

Whenever possible, transit slips printed from Evergreen should be used. When a library must manually create a transit slip, the following information must be included:

- Courier Code
  *(eg: 444/111 - this must be in large, clear text for easy sorting at the courier's warehouses)*
- Short (Policy) Name
  *(eg: STATELIB-L - this must be large and clear for easy sorting at the HQ libraries)*
- Destination Library Branch Name
- Destination Regional System Name

See also: [Spreadsheet of STAT Courier Codes](https://pines.georgialibraries.org/dokuwiki/)

Packaging

A “green bag” (ie, the heavy-duty green, zippered PINES bags purchased for courier use) may contain multiple items destined for a single branch, but should not contain books meant for different branches in the same system. (A single green bag should *not* contain one item meant for ARL-ATH and another item meant for ARL-BOGART.)

Green bags meant for all destinations should then be placed in a “tote” (ie, the large bins that the courier uses to transport materials). The drivers collect the bins from each HQ library and bring them to centralized warehouses where they are then sorted. The sorters use the numeric courier code on the transit slip for sorting, and will not open the green bags.

The transit slip must be placed in the clear plastic window where it is clearly readable. Any materials that are not appropriately secured and labeled will be sent to the PINES office, leading to transit delays.

Packaging AV Materials

The green bags provide sufficient protection for most library materials. However, audio-visual materials must be packed with additional care in order to minimize damage. The key points are to ensure that the item is padded and is not sliding around loosely inside of the green bags or boxes.

**Best Practice:**

1. If you are sending out an AV item that has a locked security case, please remove it from the security case prior to sending it out (the receiving library may not use the same type of case and would be unable to open it).
2. Place the AV item inside a bubble wrap envelope, and then place the envelope inside the green bag. You may place multiple AV items into the same envelope if they are going to the same destination and they fit comfortably.

3. **Do not seal the bubble wrap envelope.** These envelopes were chosen because they can be reused again and again if used as directed. If they are sealed, then they have to be cut open, reducing their life span. If you are concerned that the AV item is going to slip out of the bubble wrap envelope inside the green bag, you could fold over the top and put a rubber band around it before placing it inside the green bag.

4. The transit slip that goes on the outside of the green bag needs to have the numeric courier code for the receiving branch visible (eg, 444/111). If the courier only sees the policy name (eg, ARL-ATH) then they will set it aside and send it to our office to sort out and relabel, which will delay the transit time for several days. (This is true for all items, not just AV items.)

5. If you receive an AV item that is packaged without appropriate padding, particularly if this has resulted in damage, please contact the sending library directly to alert them as there may be a need for additional training.

If the item will not fit into a bubble wrap envelope or if you have run out of bubble wrap envelopes, consider using sheets of bubble wrap, recycled bubble wrap envelopes, or small boxes. If using sheets of bubble wrap, it is better to secure them with rubber bands rather than tape so that they can be easily reused without having to be cut apart. If using a small box, ensure that the item will not slide around and hit the sides, which can easily damage the corners of the case.

See also: **AV Packaging Committee Report, September 2021**

Examples of protective packaging:

![Normal packaging, top of bubble wrap bag folded over](image)
Several DVDs that are going to the same location can be placed in one bubble wrap bag if they fit comfortably.

Recycled bubble wrap envelopes (remove any labels that contain personal information)
Bubble wrap sheet, secured with rubber bands

**Bag and Tote Requests**

When you get low on green bags or totes (aka, tubs or bins), put in a Help Desk ticket and the PINES staff will have more sent to your branch from the courier's Atlanta warehouse.

If your library has more bags or totes than you need, please send them via your courier to the Atlanta Warehouse, Attn: Brian Clingen.

In case of extreme bag or bin shortage, materials may be sent in alternative protective packaging as long as it will stand up to the rigors of sorting and transit, and as long as the transit slip is clearly legible and firmly attached to the outside of the package.

**Claim Form**

If an item is damaged during transit from one library system to another, fill out this form and submit it to the Help Desk as soon as possible upon discovering the damage.

- STAT Claim Form

*(The PINES contract with STAT only covers deliveries between library systems, from headquarters to headquarters. If your library system has an additional contract with STAT to deliver from branch to branch within the system, then any claim for an item damaged during one of those transits should go directly to your contact with STAT.)*
Courier Service Between Public and University Libraries

Georgia's public libraries and state university libraries utilize a courier service that includes interlibrary loan deliveries within the state.

Courier Expansion Policies and Procedures

Processing Interlibrary Loan Items in PINES

Courier Email Discussion List

Courier Labels

- All Public Library Courier Codes
  (HQ public lib codes w OCLC symbols complete list_2021_07.docx)
  - Courier Codes for Public Libraries
    (HQ public lib codes w OCLC symbols complete list_2021_07.pdf)
    - Courier Codes for USG Libraries
    (USG ILL courier labels.pdf)

Mail Merge Files

- Public Library Courier Label Datasource
  (Public Lib HQ codes OCLC symbols mmerge singles_2021-07.xlsx)
  - Public Library Courier Labels Mail Merge
    (Mail Merge HQ public lib codes with symbols_1.docx)
    - USG Courier Labels Datasource
      (USG Addresses with codes data_2018_07.docx)
      - USG Courier Labels Mail Merge
        (USG ILL courier labels_2018_07.docx)
Bills

To encourage the prompt return of materials, the PINES libraries have established a schedule of fines and fees as penalty to those patrons who fail to return materials by their due dates. The schedule of fines and fees can be found with the PINES Circulation Matrix.

See: PINES Circulation Matrix

Historical Note: On July 1, 2012, the fine rate for books increased from $0.15 to $0.20 per day [2012.05].

Paying Fines/Fees

PINES fines may be paid at any participating library. If the patron's home library is configured to accept online credit card payments, then that patron may also log in to the “My Account” section of the OPAC and pay their bills online.

Returned materials which are owned by other PINES libraries will be promptly returned via the PINES courier service. Patrons may pay all or a portion of overdue fines. Patrons are not allowed to carry a credit balance of fines on their account in lieu of a refund [2006.05].

PINES library systems may choose to implement “fine-free” or “food-for-fines” library promotions. These will apply only to items owned by the initiating library systems. The participating library/system must make it clear to the public that these promotions are local and do not apply to other PINES libraries [2001.11].

Returned check charges should be billed to the user's account. Payment is due from the patron that caused the loss to the library that incurred the loss [2011.05].

- See also: Collection/Materials Recovery Agencies
- See also: Payment Retention and Reimbursal
- See also: Unrecovered Debt

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2018/10/19 13:28
Bankruptcies

The Library will discharge a patron's debt that has been lawfully discharged in bankruptcy.

1. Before the Library will discharge a patron's debt, the patron must provide a copy of a valid court order discharging the patron's debt.
2. Library fines for overdue materials (this does not include debt for damaged or lost materials) may not be discharged in bankruptcy and will remain the responsibility of the patron.
3. If a patron's borrowing privileges are currently suspended pursuant to section 3.0 of the Library's Loan Policy, the patron may request reinstatement based on a lawful court order discharging the patron's dischargeable library debt, provided the patron has returned all overdue materials that have an active item record and paid all non-dischargeable and other current debt due to the Library.
4. If the patron in bankruptcy is responsible for a juvenile account, the same policies apply.

See also: Marti Minor's Presentation at the Fall 2020 Public Library Directors Meeting

From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation


Last update: 2020/10/09 17:39
Collection/Materials Recovery Agencies

Some PINES libraries contract with collection/materials recovery agencies to collect outstanding fines and fees or to recover lost materials. The following policies and procedures apply to this arrangement within PINES:

- A library may send any patrons to collections who have overdue materials as a result of transactions originating from the library in question, regardless of item ownership or patron home library [2007.05].
- When a patron is referred to collections, a Note or Alert should be added to the patron account to indicate which library took action.
- Only the referring library may remove the collections status.
- Patron accounts in collections status may be paid at any PINES library. Payments will be retained by the collection library unless the owning library sends an invoice for payment reimbursement to the collection library within 90 days of the payment date. [2018.09] Collection agency fees that are automatically added to the accounts that have been referred to collections may also be invoiced if they are paid at the non-referring library.

Prior to September 2018, patrons whose accounts were in collections status were required to pay their bill at the referring library [2003.05].
Credit Card Payments

At the Desk

Libraries may contract with the credit card processing vendor of choice (many libraries have chosen Square) to accept credit card payments at the desk. These vendors are not connected to PINES, so any payments that are accepted in this way will need to also be entered by staff in order to update the patron’s account.

Through the OPAC

Libraries may opt to take credit card payments online through the OPAC. When patrons log in to My Account, if their home library has credit card payments enabled then they will see the ability to pay online. (If the home library does not have credit card payments enabled, the patron will just see the fine information, but not the option to pay online.)

Stripe
To date, every PINES library that has opted to accept credit card payments has chosen Stripe as the vendor of choice.

1. Set up an account with Stripe
   - [http://www.stripe.com](http://www.stripe.com)
   - A single account can be created for all branches in the regional system, or separate accounts can be created for each branch.
2. After setup, Stripe will provide you with four keys for each account.
   - test private key, test public key, live private key, live public key
3. Submit a [Help Desk](https://pines.georgialibraries.org/dokuwiki/) ticket with the four keys and which system or branch they should be applied to.
4. PINES staff will enable the appropriate options on your account and patrons will be able to begin online payments immediately.

Stripe Coverage

*Updated May 2022* - Systems using Stripe shown in dark green. Please note that some systems only accept Stripe through specific locations.
Other Vendors
Evergreen is also capable of connecting with Authorize.net and with PayPal. If you wish to use one of those vendors instead of Stripe, contact the Help Desk for assistance.
Deposit-Handling Suggestions

Some PINES libraries choose to require deposits in order to check out certain high-value or high-loss materials such as test preparation (GED, ASVAB, etc.) books.

A library system that chooses to require deposits on select items will determine its own local procedures for handling deposits. This page consists of suggestions based on the existing practices of various PINES library systems, but while one approach may work for one library, it may not work for another depending on staffing structure and the way that funds are held and balanced. Please use the following information as suggestions only and be sure that whatever procedure you follow within your own library system is consistent, clearly documented, and follows all money-handling guidelines your system is required to follow.

General Notes

- The library system will determine which items will require deposits.
- The library system will determine whether or not to place copy alerts on the item's record.
- The library system will determine the amount of the deposit required for the item.
- The library system will determine where the deposit items are stored (most libraries store them behind the desk).
- The library system may choose to set up the copy record so that it will bill the patron account automatically upon checkout. Other libraries may choose to add bills to the patron accounts manually.
- Some library systems place stickers on the cover of the books indicating that deposit is required and stating the amount of the deposit required.
- Some library systems will accept non-monetary items (such as a driver's license) instead of a cash deposit for items that are for in-house use only. These situations are not typically logged in detail.
- Some library systems choose to use the Evergreen software to track deposits and refunded deposits, but others choose to create paper logs manually. If a library is required to reconcile its cash drawer with the cash report produced by Evergreen, then the library might prefer handling the deposit money separately from Evergreen for bookkeeping simplicity. However, if it is more important to a library to track the deposited funds and returned deposits within the patron accounts, then the library might prefer handling the deposits within Evergreen. Each library system should determine what approach works best for their individual situation.
- It is good practice to have the guidelines and procedures for deposits posted publicly (perhaps at the circulation desk or on the library's web site) so that the library's patrons can easily refer to them. One library system even takes the extra step of providing borrowers of these items with bookmarks that remind them to pick up their deposits when they return the items. The bookmark informs them that if the item is long overdue or lost, the deposit will go towards the cost of the item. It also informs them that if the person has returned the item but has not picked up their deposit, the deposit will be considered a donation.
- PINES policy states that items requiring deposits should be non-holdable outside their own library systems, but the software does not currently have this functionality.
Managing Deposits Manually

Checkout

Staff accepts the deposit (check or cash) and places it in a secure location. Libraries typically place the deposit in an envelope or bag (such as a pencil bag) labelled with the patron's name, library card number, date of checkout, book title, and barcode. Some libraries also keep a deposit log that patrons sign when they make a deposit and when they receive their returned deposit - this log is useful to have in case someone claims to have not received their returned deposit. It is good practice to have the library staff members that receive and return the deposits initial and date the log entry and/or envelope as well.

Renewal

If the patron wishes to renew the item, any alert is overridden and the patron is not required to provide a second deposit.

Return

When the patron returns the item, the staff will return the deposit that was being kept aside for the patron. If the item is labelled or has a copy alert on it, then the staff processing the returned item should notice that the patron is due the returned deposit. If the library is keeping a paper log, then the patron should sign that he or she received the returned deposit.

Managing Deposits with Evergreen

Checkout

The patron is billed for the deposit amount. This can be set up to happen automatically or the staff member can add it manually by opening the patron's account then clicking Bills > Bill Patron. If adding manually, the staff member should choose “Deposit Fee” as the Billing Type and enter the item's title and barcode, as well as the staff member's first initial, last name, location, and date.

Staff accepts payment for the bill and records the payment to the account (select the appropriate billing line item, choose the Payment Type, enter the amount of Payment Received, then click Apply Payment). Doing this ensures that the bill does not go above $10 due to a deposit charge and that there is a record of the transaction on the account.

Staff places the deposit in a secure location (typically in an envelope labelled with the patron's name, library card number, date of checkout, book title, and barcode) and if necessary, records the amount in a paper log as well.

Renewal

If the item is set up to the bill the patron automatically and the patron renews the item, the patron will be billed a second time. If this occurs, staff should Void that bill.
Return

When the patron returns the item, go to Bills > History > select the appropriate Bill and click Full Details. You should see that the Deposit fee was charged and paid. Close the pop-up window.

On the Bills > History screen, right-click on the paid deposit bill then click Add Billing. Choose Billing Type of “Refund: Deposit Item Returned” with an amount of zero (0) and enter an annotation with the staff member's first initial, last name, date, and location. (After saving, if you look at the Full Details, you will see that it added a line item to the bill indicating that the deposit had been returned.)

Staff returns the deposit that was being kept aside for the patron. If the library is also keeping a paper log, then the patron should sign that he or she received the returned deposit.

When a Patron Does Not Return the Item

If the book is not returned and ends up marked Long Overdue or Lost, the library may credit the deposit against the price of the book. If a personal check was used as a deposit, the library may wish to resolve the issue sooner rather than later because the personal check may no longer be valid after several months.

When a Patron Does Not Pick Up the Deposit

If an item has been returned but the patron has not picked up the deposit, it is good practice to place an alert on the patron's account so that the deposit may be returned on the patron's next visit. If the deposit has not been picked up after a pre-determined amount of time, the library may consider it a donation (the library's policy on this should be clearly indicated in the documentation).
Max Fines vs. Max Bills

The terms 'Max Fines' and 'Max Bills' can be easily confused, so the descriptions below are written to distinguish between the two.

**Maximum Bills**

*Relates to patrons.*

Once a PINES patron reaches (or surpasses) $10.00 in fines and fees, the patron's account is automatically blocked. The patron will be unable to check out or renew items until the total amount owed on his or her account drops below $10.00.

Depending on which local library system the patron uses, the patron might also lose access to public computers and downloadable ebooks/audiobooks. There is no maximum limit on how high a patron's bills might go, although many PINES libraries will refer patrons to collection agencies once they reach a certain point and do not pay it within a certain amount of time.

**Max Fine Levels**

*Relates to items.*

Each library system within PINES chooses the Max Fine Level they wish to use for overdue fines. Most library systems use $5.00, but a few use a higher amount (see the PINES Circulation Matrix). If the Max Fine Level is set to $5.00, then overdue fines on an item will accrue each day the item is overdue until the fines reach $5.00 and will then stop. If the patron has multiple items checked out and overdue, then the fines on each one will accrue until each of them reach $5.00.

If an item is not returned and marked as either Lost or Long Overdue, the overdue fines are removed and the patron is billed for the cost of the item instead. Some library systems will also charge a non-refundable processing fee if this happens.
Forgive vs. Void

In general terms, “void” indicates that the bill was incorrect and “forgive” indicates that the bill was correct, but that the library chose to waive it.

“Void” is also used by the system for various purposes - for example, if an item is marked Lost but then the item is returned, the cost of the item that was originally billed to the patron will be voided by the system so the amount is then removed from the bill.

Voided line items on a bill will appear in the staff client, but bills that are entirely voided do not appear in the staff client and are only available through reports. There are PINES Quick Reports available to assist with reviewing forgivals and voids:

- PINES Quick Reports > Bills > Bills Voided Within a Date Range
- PINES Quick Reports > Bills > Detailed Forgive and Work Payments

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2023/02/10 11:40
Reconciling Negative Bills

There are several scenarios that may result in a patron account showing a negative balance or credit. PINES policy states that patrons are not allowed to carry a credit balance on their account, so accounts that show negative balances should be reviewed regularly and balanced. In some cases, the patron is due a refund, and in other cases they are not.

Patrons may also have a combination of negative and positive bills on their account which will prevent online payments and may create confusion about the amount that is actually owed or due as a refund.

The information provided in this section is also available through the Correcting Negative Bills class in the PINES Learning Center.

Identifying Patrons with Negative Bills

Negative Balances

Open the Evergreen Staff Client and go to: Administration > Local Administration > Patrons with Negative Balances

This screen will show all patrons with a total balance that is a negative amount, but will not show patrons that have negative bills with a positive total balance.

This screen may take some time to load. It will default to the library location that your workstation is registered to. After it loads, you may select a different library location.

Click on the patron barcode link to open that patron's record.

Negative Bills

Open the Evergreen Staff Client and go to: PINES Quick Reports > (Login with your credentials) > Choose “New Quick Report” > then “Bills” > then the report “Bills with Negative Balances” and create a report. This will show patrons with individual bills that are negative. The patron may have a total balance that is not negative but have individual bills that need to be corrected.

Investigating a Negative Bill

1. Open the patron's account in the Evergreen Staff Client and click on Bills.
2. Review the bills to determine the cause of the negative balance.
3. Right-click on a line item and View Full Details to see detailed information about that bill number. This shows each charge (including voided charges) and each payment that was applied to that bill number. If an item has been both voided and forgiven, or voided and paid for, or forgiven and paid for, you should see evidence of it on this screen.
4. You may also wish to look at the history (from the main Bills screen, click the History button). From here you may view all Transactions or limit to all Payments for any specified time period.

Types of Scenarios That May Create Negative Bills

- A patron pays overdue fines before the item is checked in, and then the item is checked in under amnesty mode or with backdating enabled. (For example, a patron turns a book into the book drop, then comes to the desk and pays the overdue fines before the book drop is checked in with backdating enabled.)
- A staff member forgives a patron's overdue fines before the item is checked in, and then the fines are checked in under amnesty mode or with backdating enabled. (This creates a situation where the fine is both forgiven and voided, so there is a negative balance even though the patron has not paid anything.)
- A staff member checks items in under amnesty mode and also backdates the checkin.
- A patron pays the Lost or Long Overdue fine for an item, but then finds it and returns it within 6 months of the payment date. The item cost will be voided, and the fines will be restored and any processing fees will be kept. This generally creates a situation where the patron is due a refund.

Correcting a Negative Balance Caused by a Bill Being Forgiven and Voided

If you see that charges were voided under the Bills section, but also paid or forgiven under the Payments section, then that would explain how the bill number ended up with a credit that should not be there. In this scenario, the patron is not due a refund. To correct this, add a bill to that bill number for the amount of the incorrect credit:

1. From the patron's account, open the Bills screen.
2. Right-click on a listed bill and click Full Details to confirm that the problem is that a bill was both voided and forgiven.
3. Return to the main Bills screen.
4. Right-click on the bill and click Add Billing.
5. A pop-up window will open.
6. Choose Miscellaneous as the Billing Type.
7. Enter the Amount needed to balance the bill (if the balance owed showed -2.60, then enter 2.60).
8. Enter a detailed Note explaining the added bill (for example, “Bill #12345 - Fines were forgiven and voided in error. Adding bill for $2.60 to balance the account. TMcCanna STATELIB-A 1/25/2018”)
9. Click Submit Bill.
10. Click the Refresh button to refresh the main Bills screen to see the balanced account - this is sometimes cached and you may need to close the patron account and reopen it to see the balanced account.

Refunds

PINES policy states that if a lost item is paid for in full, but then found and returned by the patron within
six months (180 days) of payment, then the owning library should refund the payment minus any overdue fees that had been automatically voided when the item was marked lost, and minus any processing fees which had been applied.

1) Verify that the refund is due.

1. From the main Bills screen on the patron's account, right-click on the bill that is incorrectly showing a negative balance and click Full Details.
2. Confirm that the problem is that an item was paid for (the payment information should be in the Payments section) and then voided (in the Bills section, Voided will be 'Yes' and the Note will say 'VOIDED FOR LOST ITEM RETURNED' on the charge for Lost Materials).
3. Review the payment date and the Voided date to confirm that the item was returned within 6 months (180 days) of payment. If the item was returned after that date, then no refund is due to the patron. If it was within that 6 months, then the patron is due the amount they paid minus any overdue charges that had been voided, minus any processing fee. Make a note of how much money is actually owed to the patron for a refund.
4. Return to the main Bills screen.

2) Confirm the amount of the refund.

1. Confirm that the amount showing as owed to the patron matches what you have calculated in your investigation. If the displayed number is incorrect due to other billing issues or errors, correct each of them until the amount shown is correct.

3) Process the refund.

1. From the Bills screen, place a check mark in the box on the billing line with the negative amount owed.
2. Check the Annotate Payment box.
3. Enter the amount of the refund in the “Payment Received” box. This is because this is the payment the patron will receive from the library. The system understands that a refund is being processed and that the library is not receiving any money from the patron.
4. Change the number of receipts to the number you will need for your library's processes. (The test server shows # item instead of # receipts as it should.)

5. Click Apply Payment.

7. Click OK.

8. If cash reports are used a copy of the receipt will need to be placed in the register to account for the difference in the actual cash and the cash report. Another copy of the receipt should be sent to the business office with the check request as justification for the request. If the patron is present a copy of the receipt can be given stating how much they will receive in the form of a check.

9. Click the Refresh button to refresh the main Bills screen to see the balanced account - this is sometimes cached and you may need to close the patron account and reopen it to see the balanced account.

Currently there is a bug in the refund process. If there is more than one billing line that has a negative amount due, each billing line must be processed as a separate refund. The system will not process them together.

Also, if a patron owes money and has a refund, the refund must be sorted to the top of the bills to be processed. Once the refund is processed, the fines due can be paid with the refund amount. The patron will then receive a check for the difference in the fines owed and the refund if there is any negative amount still due the patron. Multiple receipts for the fines paid would need to be printed to account for the difference in the amount of the refund receipt and the actual refund amount.

**Sources of Confusion**

There are a few options you might encounter in the Evergreen Staff Client that do not work the way you might expect them to for PINES, so we recommend that you do not use them.

- If you right-click on a bill and click Refund, it will add the dollar amount to the Payment Pending column, but does not complete the Refund. You would still need to click Apply Payment to complete the process. For PINES libraries doing refunds, it is usually better to click Check All Refunds and
then Apply Payment.

- If you right-click on a bill and click Add Billing, one of the Billing Types is Refund: Lost Item Returned. If you use this, it may appear to balance the account (unless there are other fines and fees on the account), but the transactions will not show up under Bill History. For PINES libraries doing refunds, it is usually better to click Check All Refunds and then Apply Payment.
- If you click the Bill Patron button at the top of the list, a new billing line will appear. This may result in a total balance owed of zero, but negative and positive bills will still be present. To correct negative billing errors, always right-click on the negative bill and choose Add Billing. This will add a new billing line item to the negative bill rather than creating a new bill.

**Help Desk**

If you are unable to identify the cause of the negative balance or unable to correct it, please submit a detailed Help Desk ticket.
Processing fees for lost and long overdue items are determined independently by each library system (maximum of $10 per item [1999.10]). If a lost or long overdue item is paid for but then found and returned within 180 days of the payment date, the amount paid should be refunded minus the item's overdue fees and processing fee.

<table>
<thead>
<tr>
<th>PINES Policy Name</th>
<th>Branch</th>
<th>System Name</th>
<th>Processing Fees (Lost / Long Overdue / Damaged*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARL</td>
<td>All locations</td>
<td>Athens Regional Library System</td>
<td>10/10/10</td>
</tr>
<tr>
<td>ARCPLS</td>
<td>All locations</td>
<td>Augusta-Richmond County Public Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>AZRLS</td>
<td>All locations</td>
<td>Azalea Regional Library System</td>
<td>10/10/10</td>
</tr>
<tr>
<td>BROOK</td>
<td>All locations</td>
<td>Brooks County Public Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>BTRL</td>
<td>All locations</td>
<td>Bartram Trail Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>CCL</td>
<td>All locations</td>
<td>Catoosa County Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>CHRL</td>
<td>All locations</td>
<td>Cherokee Regional Library</td>
<td>3/3/3</td>
</tr>
<tr>
<td>CLAYTN</td>
<td>All locations</td>
<td>Clayton County Library System</td>
<td>10/0/0</td>
</tr>
<tr>
<td>CPRL</td>
<td>All locations</td>
<td>Coastal Plain Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>CRLS</td>
<td>All locations</td>
<td>Chestatee Regional Library System</td>
<td>10/10/10</td>
</tr>
<tr>
<td>DCPL</td>
<td>All locations</td>
<td>Dougherty County Public Library</td>
<td>10/10/10</td>
</tr>
<tr>
<td>DTRL</td>
<td>All locations</td>
<td>Desoto Trail Regional Library</td>
<td>2/2/2</td>
</tr>
<tr>
<td>ECPL</td>
<td>All locations</td>
<td>Elbert County Public Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>FRRLS</td>
<td>All locations</td>
<td>Flint River Regional Library</td>
<td>10/10/10</td>
</tr>
<tr>
<td>GCHR</td>
<td>All locations</td>
<td>Greater Clarks Hill Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>HALL</td>
<td>All locations</td>
<td>Hall County Library System</td>
<td>5/5/5</td>
</tr>
<tr>
<td>HART</td>
<td>All locations</td>
<td>Hart County Library System</td>
<td>10/10/10</td>
</tr>
<tr>
<td>HCLS</td>
<td>All locations</td>
<td>Henry County Library</td>
<td>10/10/10</td>
</tr>
<tr>
<td>HOU</td>
<td>All locations</td>
<td>Houston County Public Library</td>
<td>5/10/5</td>
</tr>
<tr>
<td>JCL</td>
<td>All locations</td>
<td>Jefferson County Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>KRLS</td>
<td>All locations</td>
<td>Kinchafoonee Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>LBRLS</td>
<td>All locations</td>
<td>Lake Blackshear Regional Library System</td>
<td>10/10/10</td>
</tr>
<tr>
<td>LEE</td>
<td>All locations</td>
<td>Lee County Public Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>LOPL</td>
<td>All locations</td>
<td>Live Oak Public Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>MCCLS</td>
<td>All locations</td>
<td>Moultrie-Colquitt County Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>MGRL</td>
<td>All locations</td>
<td>Middle Georgia Regional Library</td>
<td>10/10/10</td>
</tr>
<tr>
<td>MOGL</td>
<td>All locations</td>
<td>Marshes of Glynn Libraries</td>
<td>5/5/5</td>
</tr>
<tr>
<td>MRLS</td>
<td>All locations</td>
<td>Mountain Regional Library</td>
<td>10/10/10</td>
</tr>
<tr>
<td>NCLS</td>
<td>All locations</td>
<td>Newton County Library System</td>
<td>10/10/10</td>
</tr>
<tr>
<td>NEG</td>
<td>All locations</td>
<td>Northeast Georgia Regional Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>NGRL</td>
<td>All locations</td>
<td>Northwest Georgia Regional Library</td>
<td>4/4/4</td>
</tr>
<tr>
<td>OCRL</td>
<td>All locations</td>
<td>Oconee Regional Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>OHOOP</td>
<td>All locations</td>
<td>Ohooppee Regional Library System</td>
<td>5/5/5</td>
</tr>
<tr>
<td>OKRL</td>
<td>All locations</td>
<td>Okefenokee Regional Library System</td>
<td>5/5/5</td>
</tr>
<tr>
<td>ORLS</td>
<td>All locations</td>
<td>Ocmulgee Regional Library System</td>
<td>0/0/0</td>
</tr>
<tr>
<td>PINES Policy Name</td>
<td>Branch</td>
<td>System Name</td>
<td>Processing Fees (Lost / Long Overdue / Damaged*)</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------</td>
<td>-----------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>PIED</td>
<td>All locations</td>
<td>Piedmont Regional Library System</td>
<td>5/5/5</td>
</tr>
<tr>
<td>PMRLS</td>
<td>All locations</td>
<td>Pine Mountain Regional Library System</td>
<td>5/5/5</td>
</tr>
<tr>
<td>PPL</td>
<td>All locations</td>
<td>Peach Public Libraries</td>
<td>10/10/10</td>
</tr>
<tr>
<td>RML</td>
<td>All locations</td>
<td>Roddenbery Memorial Library</td>
<td>10/10/10</td>
</tr>
<tr>
<td>ROCK</td>
<td>All locations</td>
<td>Conyers-Rockdale Library System</td>
<td>5/5/5</td>
</tr>
<tr>
<td>SGRL</td>
<td>All locations</td>
<td>South Georgia Regional Library System</td>
<td>0/0/0</td>
</tr>
<tr>
<td>SHRL</td>
<td>All except outreach collection</td>
<td>Sara Hightower Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>SHRL-BK</td>
<td>Outreach Collection</td>
<td>Sara Hightower Regional Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>SJRLS</td>
<td>All locations</td>
<td>Screven-Jenkins Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>SRL</td>
<td>All locations</td>
<td>Satilla Regional Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>STATELIB</td>
<td>All locations</td>
<td>Georgia Public Library Service</td>
<td>0/0/0</td>
</tr>
<tr>
<td>STRL</td>
<td>All locations</td>
<td>Statesboro Regional Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>SWGRL</td>
<td>All locations</td>
<td>Southwest Georgia Regional Library</td>
<td>0/0/0</td>
</tr>
<tr>
<td>TCPLS</td>
<td>All locations</td>
<td>Thomas County Public Library System</td>
<td>0/0/0</td>
</tr>
<tr>
<td>THRL</td>
<td>All locations</td>
<td>Troup-Harris Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>TRRLS</td>
<td>All locations</td>
<td>Three Rivers Regional Library</td>
<td>5/5/5</td>
</tr>
<tr>
<td>WGRRL</td>
<td>All locations</td>
<td>West Georgia Regional Library</td>
<td>3/3/3</td>
</tr>
<tr>
<td>WORTH</td>
<td>All locations</td>
<td>Worth County Library System</td>
<td>0/0/0</td>
</tr>
</tbody>
</table>

* Damaged item processing fees were implemented on July 1, 2017. The Damaged Item processing fee is only automatically applied when the full item price is billed.

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/02/03 15:12
Payment Retention and Reimbursal

Overdue fines will be retained by the collecting library, regardless of the original lending library [1999.10]. Payments for lost, damaged, or long overdue materials (along with any associated processing fees) will be retained by the collecting library unless the owning library sends an invoice for payment reimbursal to the collecting library within 90 days of the payment date [2016.09]. Collection agency fees that are paid at the non-referring library may also be invoiced [2018.09].

Reports

The following Quick Reports are available to assist you in identifying payments that your library may request reimbursal for. Each line item on the resulting report must be investigated to determine the actual reimbursal amount, because the report is unable to determine partial payments, payments covering multiple bills, and payments that have already been refunded. There are three reports: the 'circulation' report includes payments that were made at a library on bills that the system created, the 'grocery' report includes payments that were made at a library on bills that were manually created, and the 'OPAC' report includes payments that were made via the OPAC on both circ and grocery bills.

- PINES Quick Reports > Quick Report Templates > Bills > Invoice Report: Circulation Bills
- PINES Quick Reports > Quick Report Templates > Bills > Invoice Report: Grocery Bills
- PINES Quick Reports > Quick Report Templates > Bills > Invoice Report: OPAC Payments

When you are using these three reports, be sure to select your libraries in both of the dropdown lists. This is because you want to filter items owned by your libraries (IN LIST) but payments received by other libraries (NOT IN LIST).

Invoices

Invoices should be sent to the Headquarters Library for each system within 90 days of payment.

You may use the attached invoice below, or you may use your own library's standard invoice format as long as the following information is included:

- Bill Number
- Type of Bill (Lost, Long Overdue, Damaged, Collection Agency Fee)
- Payment Date
- Patron Barcode
- Patron Name
- Item Barcode
- Item Title
Sample Invoice

When sending payment for an invoice, a copy of the invoice should be included with the payment.

**Patrons in Collections**

See: Collection/Materials Recovery Agencies

From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation


Last update: 2022/03/29 08:27
Unrecovered Debt / Uncollectable Debt

In 2007, the following procedure was agreed upon. However, the library director that requested the development left PINES before development was done, and the project was cancelled:

“As a measure to bring library accounting practices in line with Governmental Accounting Standards Board regulations, the Executive Committee has decided to adopt a procedure for marking fines/fees owed by patrons for over three years “unrecovered debt.” This status will be applied at the per-circulation-transaction level to such fines and fees [2007.09].”

At this time, each library system is responsible for developing its own procedures for handling old, 'unrecoverable' debt on patron accounts.

See Also:

Legal opinions regarding old debt, page 18+

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2018/10/11 16:15


**Booking**

The booking module was enabled with the 3.4 Evergreen upgrade in January 2020.

Libraries can currently configure two types of resources for reservations: rooms and projectors. To do this, the LocalAdmin will follow the steps below to set up the resources. After they are configured, circulation staff will be able to reserve them for staff or patron use.

If additional resource types are needed, please contact the Help Desk with your request.

1. **Local Admin: Set Up Resources**

   1. Go to: Administration > Booking Administration > Resources
   2. Click on New Resource
   3. Example for a meeting room:
      1. Barcode: Create a unique name for the room (ARL-ATH-ROOM1)
      2. Deposit Amount: Leave blank unless you charge a room deposit
      3. Is Deposit Required: Leave blank unless you charge a room deposit
      4. Overbook: Leave blank
      5. Owning Library: Select the short policy name (ARL-ATH)
      6. Resource Type: Room
      7. User Fee: Leave blank unless you charge a user fee
   4. Click Save
Optional: Define Resource Attributes

This feature doesn't currently work correctly. See: https://bugs.launchpad.net/evergreen/+bug/1807784

Resource attributes can be defined if you want to be able to filter your list of resources - for example, if you had 10 meeting rooms, it might be helpful to be able to only show the rooms that could hold 50-80 people. However, if you only have two meeting rooms, it may be easier to identify them by name (Large Meeting Room, Small Meeting Room)

1. Set up resource attributes
   1. Administration > Booking Administration > Resource Attributes
   2. Click New Resource Attribute button
   3. Example for number of seats:
      1. Owning Library: Select the short policy name (ARL-ATH)
      2. Resource Attribute Name: Number of Seats
      3. Resource Type: Room

2. Set up Resource Attribute Values
   1. Administration > Booking Administration > Resource Attribute Values
   2. Click New Resource Attribute Value button
   3. Fill out form
1. Owning Library: Select the short policy name (ARL-ATH)
2. Resource Attribute: Number of Seats
3. Valid Value: 10
4. Repeat for each possible value
   1. If the different sizes of rooms can hold 5, 10, or 50 people, set up a Resource Attribute Value for each size. You may also enter more descriptive attributes such as “Up to 20” or “20 at tables - 50 in chairs.”

3. Set up Resource Attribute Map
   1. Administration > Booking Administration > Resource Attribute Map
   2. Click New Resource Attribute Map button
   3. Fill out form
      1. Resource: Enter ‘barcode’ of resource (ARL-ATH-ROOM1)
      2. Resource Attribute: Number of Seats
      3. Attribute Value: 10
   4. Repeat until all resources have the appropriate values attached (ie, each room is associated with the proper number of seats).

2. Circulation Staff: Make Reservations

Patrons cannot reserve resources on their own, they must ask library staff to make a reservation on their behalf.

1. Click on Booking > Create Reservation
   ○ Or: Open a patron account > Other > Booking: Create Reservation

2. Choose Single Day Reservation
3. Choose a Reservation Date
4. On ‘Choose resource by type’ tab, search by type Room and the owning library
   ○ Or, use the ‘Choose resource by barcode’ tab to enter the barcode
5. Double-click on the starting time slot (example: 10:00 AM)
6. Patron Barcode: Enter barcode
   - If creating reservation from a patron account, it should automatically fill in the patron barcode
7. Enter an End Time
8. Confirm Reservation Location
   - This defaults to the current location rather than to the resource's owning library
9. Click ‘Confirm’
If you wish to add a descriptive note to a reservation, you can do so by editing the reservation from the Manage Reservations screen. This will allow you to include room requirements, additional contact information, etc.

If you are reserving a room for a member of the public who does not have a library card, you can reserve it with a staff card, and then edit the Notes field to add the person/group’s details.

3. Circulation Staff: Manage Reservations

Every library that uses the booking module should check the reservations each morning to view reservations for the day.

1. Click on Booking > Manage Reservations
2. Verify that the correct Reservation Location is appearing
3. Double-click on a reservation to view the full details

4. View Reservations for a Patron

Staff can view a patron's reservations by opening the account and clicking on Other > Booking: Manage Reservations.
The Booking Module is currently undergoing additional development. More information on the progress and ideas for future work can be found on the Evergreen Student Success Working Group site.
Curbside Pickup Module

Enabling Curbside Pickup

Curbside pickup functionality was added with the 3.6.1 upgrade in January, 2021. Usage of this module is optional and can be enabled either at the branch level or the system level. To enable the functionality, submit a Help Desk ticket with the following information:

1. The Library System or Branch to enable it for
2. The maximum number of possible pickups per pickup time slot
3. The duration of the pickup time slots (15 minutes, 30 minutes, 1 hour, etc.)

Assumptions

Curbside pickup assumes a few things.

1. Curbside pickup has been enabled for the library system or branch.
2. A staff member must be assigned to monitor the appointments for the day.
3. The library's hold shelf in PINES must agree with what is on the physical holds shelf.
4. You have a work table / area set up to place the items that should be picked up in the next time slots.
5. Only items that are placed on hold and ready for pickup are available for appointments and checkouts through the curbside pickup module.
6. It also assumes that patrons with appointments will have their items checked out from the Curbside interface, and not from the standard checkout interface. If a patron has a Curbside appointment, but decides to come in and check out from the desk or from a self-check machine, this can lead to an “empty” appointment in the Curbside interface. This will not hurt anything, but it may be confusing.

Workflow

Video demonstration of curbside pickup

Open “Curbside Pickup” by clicking on the circulation menu. Go to the bottom of the menu to find it. (If you cannot see the full menu, you may need to scroll down or press the Ctrl key and the “-” (minus) key to zoom out. If you do this, you can use Ctrl and + (plus) to zoom back in.

There are 5 tabs on the curbside window:

1. To Be Staged
2. Staged and Ready
3. Patron Is Outside
4. Delivered Today
5. Schedule Pickup

1. Schedule a Pickup

When a hold is ready to be picked up, an email notification will be sent to the patron's address on file informing them that curbside pickup is available for your location and they can call or log in to the online catalog to set up an appointment. (The phone number included in the message will be the library's phone number that is set in the PINES database.) Please note that the emails are sent from the server in batches, so it may take up to an hour for the email to be sent out. If the location is only doing curbside pickup, then staff may need to call those patrons who have not yet called in.

Scheduling by phone:
When you are speaking on the phone to a patron, open the “Schedule Pickup” tab and enter the patron barcode number. After entering the patron card number, the patron name will display along with the number of holds available for that patron at your location.

Click the “Make New Appointment” to select an appointment date and then time slot. The number beside the time shows the remaining appointments for that time slot. Appointments can only be scheduled during normal operating hours. There is also a box for notes should any need to be entered - for instance, you may want to enter a description of the car / license plate number so that the patron will not have to call in when they arrive. Click the “Save” button. The appointment has now been scheduled. A confirmation will be displayed in the bottom right corner of the screen.

An email confirmation will automatically be sent to the patron's email address on file.

Self-scheduling in the OPAC:

Patrons can also schedule their own appointments in the public catalog.

When a patron's home library uses the Curbside Pickup module and the patron has an item ready for pickup, they may schedule pickup appointments online:

1. The patron will log into the OPAC and go to My Account > Curbside Pickup.
2. An appointment form will appear. First, select a date.
3. Click the Check times button, then select a time. to select a date and then choose a time.
4. Optional: The patron may wish to include arrival notes such as the color and type of vehicle they will be arriving in.
5. Click on “Request Appointment” and wait for the page to refresh.
6. Upon arrival at the library, the patron may click on the “Alert staff of your arrival” button or may call in to let the library know they are there.
2. Retrieve Items

Open the “To Be Staged” tab to retrieve the holds needed to fill the appointments in the next ten time slots. (If your time slots are set to 15 minutes, you will only see a list of holds for the next 2 1/2 hours - if your time slots are set to 1 hour, you will see holds to retrieve for the next ten hours.)

Retrieve the listed items, and place them in your curbside pickup work area. Then select them on the list and click “Mark Staged and Ready for Pickup.”

The Staged and Ready tab shows which holds have already been placed in the curbside area and are ready for pickup.

If more than one staff member is working on curbside pickups the staff members can “claim” the patron to prevent others from trying to pull the same items. Click on the “Claim” button to claim that patron’s pickup.

3. Mark Patron Arrival (Optional)

Depending on your library’s setup, you may want your patrons to call in when they arrive and your curbside pickup staff person may not be the person who answers the phone. If this is the case, whoever answers the phone can go to the Staged and Ready tab and click “Mark as Patron Arrived.”

Note: The patron may also use the “Alert staff of your arrival” option through the online catalog to inform staff of their arrival.

The curbside pickup interface will refresh itself every 15 minutes, but can be updated more quickly by refreshing the browser page. So, if the curbside pickup staff person is in a different area than the staff person answering the phone, the curbside pickup person may want to refresh the browser page more frequently to see which patron has pulled up and called in.

If the curbside pickup staff person is also receiving the phone call or has another way of knowing which patron has pulled up, then the “Mark as Patron Arrived” action is not required.

4. Check Items Out
If your local workflow is to mark patrons as arrived (see step 3, above), then the Patron is Outside tab will show you which patrons are waiting outside. If you are using this function, select the items for the patron and click “Checkout Items and Mark as Delivered.”

If you are not using the mark patrons as arrived function, you can check items out to a waiting patron by going to the Staged and Ready tab, then selecting the items and clicking “Checkout Items and Mark as Delivered.”

Items should not be checked out to the patron until the patron has arrived.

5. Deliver the Items

Deliver the items to the waiting patron.

The Delivered Today tab will show which patrons and items were picked up via curbside today.

Rescheduling

To reschedule an existing pickup appointment, go to the Schedule Pickup tab and enter the patron barcode. The patron’s existing appointment should appear and be editable.

Patrons may also see and reschedule their appointments through the OPAC.

Report of Upcoming Appointments

You may also run a report to see all of the upcoming pickup appointments you have scheduled for any selected time period. This may be helpful in scheduling staff coverage. This report is available under:

Reports > Shared Folders > Templates > terran > Help Desk > Circulation > Curbside Pickup Appointment Slots

More Information

More detailed information is available in the Evergreen software documentation at: https://docs.evergreen-ils.org/eg/docs/latest/circulation/curbside_pickup.html

Video demonstration at: https://my.nicheacademy.com/pines/course/24107
From: https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link: https://pines.georgialibraries.org/dokuwiki/doku.php?id=circ:curbside

Last update: 2022/06/30 16:23
Freedom of Information Act (FOIA) Requests

Patron Requests for Information

Patron requests for information will be forwarded to the patron home library or the library associated with the information request. PINES is the custodian of the consortium resources (ILS) and not the individual transactions of a library system. It will be the responsibility of the library or library system to provide responses to patron requests for information. If the library or system needs assistance in providing responses to information requests, we will assist library staff through our established helpdesk paradigm.

Freedom of Information Act (FOIA) Requests

FOIA requests should be directed to the Board of Regents FOIA officer Mary Ashley McCollough. See also the Board of Regents information page: https://www.usg.edu/openrecords/

Contact info:
Mary Ashley McCollough, Legal Counsel
Open Records Officer
Office of Legal Affairs
University System of Georgia
270 Washington Street, S.W.
Atlanta, GA 30334
Em: openrecords@usg.edu
Ph: 404-962-3255
Automated Notifications

PINES generates automated notices for a number of reasons and sends various notices by email, SMS text (a form of email that gets translated to text message by the recipient’s phone service provider), and for display in the Patron Message Center. The text of each type of notice is available here:

The automated notices include:

- 1 Day Overdue Email Notification
- 1 Day Overdue Notice by SMS
- 10 Day Overdue Email Notification
- 10 Day Overdue Notice in PMC
- 3 Day Courtesy Notice (by Email)
- 3 Day Courtesy Notice by SMS
- 3 Day Courtesy Notice in PMC
- 3 Month Long Overdue Notice (Email)
- 3 Month Long Overdue Notice in PMC
- 30 Day Account Expiration Courtesy Notice
- 60 Day Overdue Notice (Email)
- 60 Day Overdue Notice (PMC)
- Fine Limit Exceeded
- Hold Cancelled (Shelf-Expired) Email Notification
- Hold Cancelled (Shelf-Expired) User Message (PMC)
- Hold Ready for Pickup Email Notification
- Hold Ready for Pickup PMC Notification
- Hold Ready for Pickup SMS Notification
- Item Lost and Billed Email Notification
- Item Lost and Billed PMC Notification
- New User Created Welcome Notice
- Password Reset Request Notification
- SMS Call Number

In addition, PINES contracts with a vendor for the following:

- 10 day overdue notice (Email attempt first, phone call if email fails, USPS mail if both email and phone fail)
- 30 day overdue letter (Letter sent by USPS)

Letters that cannot be delivered are returned to the patron's home library. The library should mark those patrons' addresses invalid when this occurs.

See also: Wording of Automated Notices

Historical Notes

1. The Executive Committee voted that PINES will issue 7- and 14-day overdue notices to patrons. Mandatory budget reductions for GPLS in summer 2009 necessitated a change to a single 10-day
notice to replace the 7- and 14-day notices. The 30-day notice remains intact, as required by Georgia law [1999.10], [2009.09].

2. The 1-day overdue notice was added July 1, 2022.
3. The Long Overdue process changed from 6 months to 3 months on July 1, 2022.

**Typical Notifications for an Overdue Item**

1. 3 Day Courtesy Notice sent 3 days prior to due date by email (if available) and SMS text (if available), and entered into Patron Message Center.
2. 1 Day Overdue Notice sent by email (if available)
3. 10 Day Overdue Notice sent by email (if available) and entered into Patron Message Center. Vendor also telephones patrons who do not have a valid email recorded in PINES, and if they cannot be reached by phone then vendor sends a letter.
4. 30 Day Overdue letter sent by vendor via USPS.
5. 60 Day Overdue Notice sent by email (if available) and entered into Patron Message Center.
6. 6 Month Long Overdue Notice sent by email (if available) and entered into Patron Message Center.
7. Fine Limit Exceeded is emailed when a patron reaches their fine limit (usually $10.00). This can be for any type of fines and fees.

**Pre-Overdue Notices ("Preminders")**

PINES sends a “pre-overdue” or “preminder” courtesy notice via email 3 days prior to the due date of an item [2007.05]. Beginning January 2017, PINES also began sending preminders via SMS text service.

Patrons should be aware that although PINES sends preminders, it is a courtesy only. Some email and SMS text providers may block the preminder emails at the server level, preventing them from arriving at their destinations. The patron is ultimately responsible for returning or renewing items by their due dates whether or not the preminders are received.

**Overdue Notices**

Overdue notices are sent as a courtesy from the libraries. Failure to receive notices does not exempt patrons from the responsibility for library materials or overdue fines. Notices are generated and mailed centrally.

The first overdue notice is generated at 1 day past the due date of an item [2022.05].

The second notice is sent 10 days past the due date of an item. These 10-day overdue notices are sent via email to those patrons with email addresses in their user records [2007.02], and patrons without email addresses are telephoned (via a telephone notice service that PINES contracts with) [2011.05].

A 30-day overdue notice is sent via US Mail.
An additional 60-day overdue notice is sent by email [2021.12].

## Sending / Bounceback Address

Although the automated notifications get sent from the PINES server, they are configured to appear that they come from the patron's home library. This reinforces consistency to the patron regarding their home library is and who they should contact for questions, payments, renewals, etc.

The email address used as the sending address can be the same address as the library's main contact email address, it can be a generic address that multiple staff have access to, or it can be the email address of the branch manager or circulation manager. If no email address is set up in the “Sending email address for patron notices” library setting, then the emails will be sent from the branch contact email address. Libraries cannot remove all contact email addresses [2020.09].

The staff member(s) that monitors the email address should make note of “bouncebacks” (aka, undelivered mail notices) and update the associated patron accounts by marking their email addresses invalid on the Patron Edit screen.

See also: SPF Records
Wording of Automated Notices

1 Day Overdue Email Notification

Type: Email
Frequency: Nightly

Subject: [PINES] Overdue Library Materials

Attention: [% user.first_given_name %] [% user.family_name %] Card Number: [% user.card.barcode %]

Our records indicate the following item(s) are overdue.

[% FOR circ IN target %] [%- copy_details = helpers.get_copy_bib_basics(circ.target_copy.id) -%] Title: [% copy_details.title FILTER ucfirst %] Author: [% copy_details.author FILTER ucfirst %] Call No: [% circ.target_copy.call_number.label %] Barcode: [% circ.target_copy.barcode %] Checked Out At: [% circ.circ_lib.name %] Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %] [% END %]

Please note that items returned while the library is closed will remain on your account until the library reopens. These items will be backdated upon checkin to the last open day. Please contact your local library if you feel you have received this message in error or if you have additional questions:

[% homelib.parent_ou.name %] [% homelib.name %] [%- SET addr = homelib.mailing_address -%] [%- IF !addr -%] [%- SET addr = homelib.billing_address -%] [% END %] [% addr.street1 %] [% addr.street2 %] [% addr.city %], [% addr.state %] [% addr.post_code %] [% homelib.phone %] [% homelib.email %]

[%- SET liburl = helpers.get_org_setting(homelib.id, 'lib.info_url') -%] [% liburl %]

You may also access your account online at: https://gapines.org/login

1 Day Overdue Notice by SMS

Type: SMS Text
Frequency: Nightly

Subject: PINES Overdue Items

Visit http://gapines.org/login for details.

[% FOR circ IN target %] [%- copy_details = helpers.get_copy_bib_basics(circ.target_copy.id) -%] “[% copy_details.title FILTER ucfirst %]” by [% copy_details.author FILTER ucfirst %] due on [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %] [% END %]
10 Day Overdue Email Notification

Type: Email  
Frequency: Nightly

Subject: [PINES] Overdue Library Materials

Attention: [% user.first_given_name %] [% user.family_name %]
Card Number: [% user.card.barcode %]

Our records indicate the following items are 10 days or more overdue.

[% FOR circ IN target %]
Title: [% copy_details.title FILTER ucfirst %]
Author: [% copy_details.author FILTER ucfirst %]
Call No: [% circ.target_copy.call_number.label %]
Barcode: [% circ.target_copy.barcode %]
Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]
[% END %]

Overdue fines will continue to accrue until items are returned. Items may be returned and fines paid at any PINES member library. Some libraries also accept online payments at: https://gapines.org/login

If you have any questions, please contact:

[% homelib.parent_ou.name %]
[% homelib.name %]
[%- SET addr = homelib.mailing_address -%]
[%- IF !addr -%] [%- SET addr = homelib.billing_address -%] [%- END %]
[% addr.street1 %] [% addr.street2 %]
[% addr.city %], [% addr.state %] [% addr.post_code %]
[% homelib.phone %]
[% homelib.email %]
[% liburl %]

(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

10 Day Overdue Notice in PMC

Type: PMC  
Frequency: Nightly

Title: Overdue Library Materials

Our records indicate the following items are 10 days or more overdue.
Items may be returned and fines paid at any PINES member library. Fines will continue to accrue until items are returned.

If you have any questions, please contact:

(Please have your library card number available.)

3 Day Courtesy Notice

Type: Email
Frequency: Nightly

Subject: [PINES] Library Materials Due Soon

Attention: [% user.first_given_name %] [% user.family_name %]
Card Number: [% user.card.barcode %]

This is a courtesy reminder that the following items will be due soon:

(Please return or renew your items by the due date in order to avoid late charges. You may renew your items online (https://gapines.org/login) or by contacting your library. (You may be unable to renew items if other patrons have holds on them, if your account is expired, or if you owe more than $10.00 in fines
and fees.)

If you have any questions, please contact:

[% homelib.parent_ou.name %]
[% homelib.name %]
[%- SET addr = homelib.mailing_address -%]
[%- IF !addr -%] [%- SET addr = homelib.billing_address -%] [%- END %]
[% addr.street1 %] [% addr.street2 %]
[% addr.city %], [% addr.state %] [% addr.post_code %]
[% homelib.phone %]
[% homelib.email %]
[% liburl %]
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

3 DayCourtesy Notice by SMS

Type: SMS Text
Frequency: Nightly

Subject: PINES Items Due Soon

[% FOR circ IN target %]
“[% copy_details.title FILTER ucfirst %]” by [% copy_details.author FILTER ucfirst %] due on [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]-
[% END %]
Go to https://gapines.org/login to renew

3 Day Courtesy Notice in PMC

Type: PMC
Frequency: Nightly

Title: Library Materials Due Soon

This is a courtesy reminder that the following items will be due soon:

[% FOR circ IN target %]
Title: [% copy_details.title FILTER ucfirst %]
Author: [% copy_details.author FILTER ucfirst %]
Call No: [% circ.target_copy.call_number.label %]
Barcode: [% circ.target_copy.barcode %]
Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]
Please return or renew your items by the due date in order to avoid late charges. You may renew your items online (https://gapines.org/login) or by contacting your library. (You may be unable to renew items if other patrons have holds on them, if your account is expired, or if you owe more than $10.00 in fines and fees.)

If you have any questions, please contact:

(Please have your library card number available.)

3 Month Long Overdue Notice

Type: Email  
Frequency: Nightly

Subject: [PINES] Long Overdue Library Materials

Attention: [% user.first_given_name %] [% user.family_name %]  
Card Number: [% user.card.barcode %]

The following items checked out to your account have been overdue for 3 months or longer. They have been marked “Long Overdue” and the replacement costs have been billed to your account.

Title: [% copy_details.title FILTER ucfirst %]  
Author: [% copy_details.author FILTER ucfirst %]  
Call Number: [% circ.target_copy.call_number.label %]  
Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]  
Bill Amount: $[% circ.billable_transaction.summary.balance_owed %]

Items may be returned and fines paid at any PINES member library. Some libraries also accept online payments at: https://gapines.org/login

If you have any questions, please contact:

(Please have your library card number available.)
3 Month Long Overdue Notice in PMC

**Type: PMC**  
**Frequency: Nightly**

Title: Long Overdue Library Materials

The following items checked out to your account have been overdue for 3 months or longer. They have been marked “Long Overdue” and the replacement costs have been billed to your account.

If you have any questions, please contact:

(Please have your library card number available.)
30 Day Account Expiration Courtesy Notice

Type: Email  
Frequency: Nightly

Subject: [PINES] Time to Renew Your Library Card!

Attention: [% user.first_given_name %] [% user.family_name %]
Card Number: [% user.card.barcode %]

[% IF user.profile.id == '61' %]
Your PINES public library card account registered through your school will expire on October 15.
If this is an error, please contact your school’s administrative office.

To apply for a regular PINES account, please visit: https://gapines.org/eg/opac/register

[% ELSE %]
Your library card is set to expire soon. Please visit any PINES library to renew to avoid an interruption in service.

HOW TO RENEW:

Renewal is easy! Just bring your library card and current photo ID to any PINES library and we will do the rest.

If you have moved and the address on your photo ID doesn't match your current address, please bring additional proof of address (such as a utility bill or a rental agreement) in order to renew your card with no delay.

If you have any outstanding fines or fees on your account, they will need to be paid before your card can be renewed.

DON’T MISS OUT!

Have you been taking advantage of everything your library has to offer?

- Books, audiobooks, DVDs and other materials from nearly 300 PINES libraries and service outlets across Georgia delivered to your local library for free
- Free downloadable ebooks and audiobooks
- Online research databases, reference books, genealogy tools, and interactive language-learning resources through GALILEO
- Online holds, renewals, and account management
- 'Georgia PINES' app for Android or iPhone
- Ability to store lists of books
- Option to save your checkout history
- Book recommendations based on books you enjoyed reading
- Free storytimes, classes, activities, and special events for all ages

FIND A PINES LIBRARY NEAR YOU:

https://pines.georgialibraries.org/pinesLocator/locator.html

FOR QUESTIONS:

If you have any questions, please contact:

[lib.parent_ou.name]
[lib.name]
[SET addr = lib.mailing_address -]
[IF !addr -] [SET addr = lib.billing_address -] [END]
[addr.street1 %] [addr.street2 %]
[addr.city %], [addr.state %] [addr.post_code %]
[lib.phone %]
[lib.email %]
[liburl %]
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

60 Day Overdue Email Notification

New as of: January 2022
Type: Email
Frequency: Nightly

Subject: [PINES] Overdue Library Materials
Attention: [% user.first_given_name %] [% user.family_name %]
Card Number: [% user.card.barcode %]

Our records indicate the following items are 60 days or more overdue.

[FOR circ IN target %]
Title: [% copy_details.title FILTER ucfirst %]
Author: [% copy_details.author FILTER ucfirst %]
Call No: [% circ.target_copy.call_number.label %]
Barcode: [% circ.target_copy.barcode %]
Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]
Item Price: $[% circ.target_copy.call_number.price %] (Additional processing charge may apply)
[END]
Please return these items so that other patrons may use them. If you do not return these items, you will be charged the owning library's item price plus any additional processing fees. Items may be returned and fines paid at any PINES member library. Some libraries also accept online payments at: https://gapines.org/login

If you have any questions, please contact:

[% homelib.parent_ou.name %]
[% homelib.name %]
[%- SET addr = homelib.mailing_address -%]
[%- IF !addr -%] [%- SET addr = homelib.billing_address -%] [%- END %]
[% addr.street1 %]
[% addr.street2 %]
[% addr.city %], [% addr.state %] [% addr.post_code %]
[% homelib.phone %]
[% homelib.email %]
[% liburl %]
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

**60 Day Overdue Notice in PMC**

*New as of: January 2022*

**Type: PMC**

**Frequency: Nightly**

Title: 60-Day Overdue Library Materials

Our records indicate the following items are 60 days or more overdue.

[% FOR circ IN target %]
Title: [% copy_details.title FILTER ucfirst %]
Author: [% copy_details.author FILTER ucfirst %]
Call No: [% circ.target_copy.call_number.label %]
Barcode: [% circ.target_copy.barcode %]
Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]
Item Price: $[% circ.target_copy.call_number.price %] (Additional processing charge may apply)
[% END %]

Please return these items so that other patrons may use them. If you do not return these items, you will be charged the owning library's item price plus any additional processing fees. Items may be returned and fines paid at any PINES member library. Some libraries also accept online payments at: https://gapines.org/login

If you have any questions, please contact:

[% homelib.parent_ou.name %]
Email Checkout Receipt

Type: Email  
Frequency: On Demand

Subject: [PINES] Checkout Receipt
To: [% user.first_given_name %] [% user.family_name %]  
Card No: [% user.card.barcode %]  
You checked out the following items on [% date.format(date.now, '%m/%d/%Y %I:%M %p') %]:  

[ % FOR circ IN target %]  
[ %- copy_details = helpers.get_copy_bib_basics(circ.target_copy.id) -%]  
Title: [% copy_details.title %]  
Author: [% copy_details.author %]  
Call Number: [% circ.target_copy.call_number.label %]  
Barcode: [% circ.target_copy.barcode %]  
Due Date: [% date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %]  
Library: [% circ.circ_lib.name %]  

[ % END %]  

If you have any questions, please contact your home library at:  

[ % lib.parent_ou.name %]  
[ % lib.name %]  
[ % lib.mailing_address.street1 %] [% lib.mailing_address.street2 %]  
[ % lib.mailing_address.city %], [% lib.mailing_address.state %]  
[ % lib.mailing_address.post_code %]  
[ % lib.phone %]  
[ % lib.email %]  
[ % liburl %]  
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login
Fine Limit Exceeded

Type: Email  
Frequency: Nightly

Subject: [PINES] Fine Limit Exceeded

Attention: [% user.first_given_name %] [% user.family_name %]  
Card Number: [% user.card.barcode %]

Our records indicate your account has exceeded the fine limit allowed for use of your PINES library card.

Please visit your nearest PINES library location to pay your fines and restore full access to your account. If your home library accepts payments online, you can pay at: https://gapines.org/login

If you have any questions, please contact your home library at:

[% homelib.parent_ou.name %]  
[% homelib.name %]  
[% addr.street1 %] [% addr.street2 %]  
[% addr.city %], [% addr.state %] [% addr.post_code %]  
[% homelib.phone %]  
[% homelib.email %]  
[% liburl %]  
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

Hold Canceled (Shelf-Expired) Email Notification

Type: Email  
Frequency: Nightly

Subject: [PINES] Hold Canceled

Attention: [% user.first_given_name %] [% user.family_name %]  
Card Number: [% user.card.barcode %]

The following holds have been canceled because they were not picked up from the library.

[% FOR hold IN target %]  
Title: [% copy_details.title FILTER ucfirst %]  
Author: [% copy_details.author FILTER ucfirst %]  
Request Date: [% date.format(helpers.format_date(hold.request_time), '%m-%d-%Y') %]
Hold Canceled (Shelf-Expired) User Message

Type: PMC
Frequency: Nightly

Title: Hold Request Canceled

The following holds have been canceled because they were not picked up from the library.

If you have any questions, please contact:

(Please have your library card number available.)
Hold Ready for Pickup Email Notification

**Type:** Email  
**Frequency:** Hourly

Subject: [PINES] Hold Available for Pickup at Your Library

Attention: [% user.first_given_name %] [% user.family_name %]  
Card Number: [% user.card.barcode %]

The items you requested are available for pickup at:

[% FOR hold IN target %]
Title: [% helpers.escape_xml(copy_details.title) FILTER ucfirst %]  
Author: [% helpers.escape_xml(copy_details.author) FILTER ucfirst %]  
Call Number: [% hold.current_copy.call_number.label %]  
Barcode: [% hold.current_copy.barcode %]  
Pickup Library: [% hold.pickup_lib.name %] (%[ hold.pickup_lib.phone %])

[% END %]

If you have any questions, please contact:

[% homelib.parent_ou.name %]  
[% homelib.name %]
[%- SET addr = homelib.mailing_address -%]  
[%- IF !addr -%][%- SET addr = homelib.billing_address -%][%- END %]  
[% addr.street1 %] [% addr.street2 %]  
[% addr.city %], [% addr.state %] [% addr.post_code %]  
[% homelib.phone %]  
[% homelib.email %]  
[% liburl %]  
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

Hold Ready for Pickup PMC Notification

**Type:** PMC  
**Frequency:** Hourly

Title: Hold Available for Pickup

The items you requested are available for pickup at your library:

[% FOR hold IN target %]
Hold Ready for Pickup SMS Notification

**Type:** SMS Text  
**Frequency:** Hourly

Subject: PINES-[% target.size %] hold(s) ready for pickup:

[% FOR hold IN target %]  
“[% title FILTER ucfirst %]” by [% author FILTER ucfirst %] (pickup at [% hold.pickup_lib.name %])--  
[% END %]

Go to [https://gapines.org/login](https://gapines.org/login) or call [% homelib.phone %] for questions.

Item Lost and Billed Email Notification

**Type:** Email  
**Frequency:** Hourly

Subject: [PINES] Lost Library Materials

Attention: [% user.first_given_name %] [% user.family_name %]  
Card Number: [% user.card.barcode %]

The following items checked out to your account have been marked “Lost” and the replacement costs have been billed to your account.
You may log into your online account to view your total bill including any other charges, or you may contact your home library for additional information. Some libraries also accept online payments at: https://gapines.org/login

If you have any questions, please contact:

%(homelib.parent_ou.name %)
%(homelib.name %)
%(SET addr = homelib.mailing_address -%)
%(IF !addr %)%(SET addr = homelib.billing_address -%)[% END %]
%(addr.street1 %)%(addr.street2 %)
%(addr.city %), %(addr.state %)%(addr.post_code %)
%(homelib.phone %)
%(homelib.email %)
%(liburl %)
(Please have your library card number available.)

You may also access your account online at: https://gapines.org/login

Item Lost and Billed PMC Notification

Type: PMC  
Frequency: Hourly

Title: Lost Library Materials

The following items checked out to your account have been marked “Lost” and the replacement costs have been billed to your account.

%(FOR circ IN target %)
Title: [%(copy_details.title FILTER ucfirst %)]
Author: [%(copy_details.author FILTER ucfirst %)]
Call Number: [%(circ.target_copy.call_number.label %)]
Barcode: [%(circ.target_copy.barcode %)]
Due Date: [%(date.format(helpers.format_date(circ.due_date), '%m-%d-%Y') %)]
Bill Amount: [$(circ.billable_transaction.summary.balance_owed %)]
[%(END %)]
Click on the Fines link to view your total bill including any other charges, or you may contact your library for additional information:

[% homelib.parent_ou.name %]
[% homelib.name %]
[%- SET addr = homelib.mailing_address -%]
[%- IF !addr -%] [%- SET addr = homelib.billing_address -%] [%- END %]
[% addr.street1 %] [% addr.street2 %]
[% addr.city %], [% addr.state %] [% addr.post_code %]
[% homelib.phone %]
[% homelib.email %]
[% liburl %]
(Please have your library card number available.)

New User Created Welcome Notice

**Type: Email**

**Frequency: Every 10 minutes**

Subject: [PINES] Welcome to Your PINES Public Library!

[%- USE date -%]
[%- user = target -%]
[%- lib = user.home_ou -%]
To: [%- params.recipient_email || user.email %]
From: [%- helpers.get_org_setting(lib.id, 'org.bounced_emails') || lib.email || params.sender_email || default_sender %]
Reply-To: [%- helpers.get_org_setting(lib.id, 'org.bounced_emails') || lib.email || params.sender_email || default_sender %]
Date: [%- date.format(date.now, '%a, %d %b %Y %T -0000', gmt ⇒ 1) %]
Subject: [PINES] Welcome to PINES!
Auto-Submitted: auto-generated

Attention: [% user.first_given_name %] [% user.family_name %]
Card Number: [% user.card.barcode %]

[% IF user.profile.id == '2' %] *(The following section gets sent to accounts with the Patron permission group.)*

Thank you for registering for a PINES library card! Your account gives you access to a wide variety of library materials and services:

- Books, audiobooks, DVDs and more from nearly 300 PINES libraries across Georgia
- Free downloadable ebooks and audiobooks
- Online research databases, test preparation resources, interactive language-learning resources and much more through GALILEO
- Online holds and renewals
- 'Georgia PINES' app for Android or iPhone
- Option to save your checkout history
- Free courier delivery of library materials you place on hold from any other PINES library to your local library
- Series information and recommendations
- Free storytimes, classes, activities, and special events for all ages

[% ELSIF user.profile.id == '61' %] (The following section gets sent to accounts with the PLAY Card permission group.)

Your school has registered you for a PINES public library card! Your account gives you access to a wide variety of public library materials and services:

- Books, audiobooks, DVDs and more from nearly 300 PINES libraries across Georgia
- Free downloadable ebooks and audiobooks
- Online research databases, test preparation resources, interactive language-learning resources and much more through GALILEO
- Online holds and renewals
- 'Georgia PINES' app for Android or iPhone
- Option to save your checkout history
- Free courier delivery of library materials you place on hold from any other PINES library to your local library
- Series information and recommendations
- Free storytimes, classes, activities, and special events for all ages

If you do not wish to use your PINES account, your parent or guardian may contact your school's administrative office to opt out of the library card program.

[% ELSIF user.profile.id == '64' %] (The following section gets sent to patrons who register online and get assigned to the Quipu permission group.)

Welcome to PINES!

You have successfully registered for a PINES e-card! You now have access to:

- Free downloadable ebooks and audiobooks
- Online research databases, test preparation resources, interactive language-learning resources and much more through GALILEO

In order to take full advantage of all library services, please visit your local PINES-member library with your e-card number and your photo ID (as well as your proof of address, if it is different from what is shown on your ID). Once you receive your full PINES card, you will have access to:

- Books, audiobooks, DVDs and more from nearly 300 PINES libraries across Georgia
- Online holds and renewals
- 'Georgia PINES' app for Android or iPhone
- Option to save your checkout history
- Free courier delivery of library materials you place on hold from any other PINES library to your local library
- Series information and recommendations
- Free storytimes, classes, activities, and special events for all ages

[% ELSE %] (The following section gets sent to accounts with any other permission group.)

Thank you for registering for a PINES library card! Your account gives you access to wide variety of library materials and services. Please contact your library for additional details.

[% END %]

To access your account, go to https://gapines.org/login

Enter your library card number and your temporary password. After you are logged in, click on “Account Preferences” to add a username, change your password, set up your Hold notification preferences, and more.

[% IF user.profile.id == '61' %] - Your barcode number is: [% user.card.barcode %] (be sure to use capital letters)
- Information about your password will be provided by your school district.
[% END %]

If you have any questions, please contact your home library at:

[% lib.parent_ou.name %]
[% lib.name %]
[%- SET addr = lib.mailing_address -%]
[%- IF !addr -%] [%- SET addr = lib.billing_address -%] [%- END %]
[% addr.street1 %] [% addr.street2 %]
[% addr.city %], [% addr.state %] [% addr.post_code %]
[% lib.phone %]
[% lib.email %]

Check your library's web site for more information: [%- SET liburl = helpers.get_org_setting(lib.id, 'lib.info_url') -%] [% liburl %]

Please have your library card number ( [% user.card.barcode %] ) ready.

Password reset request notification

Type: Email
Frequency: On-Demand

Subject: [PINES] Password Reset Request

Attention: [% user.first_given_name %] [% user.family_name %]
Card Number: [% user.card.barcode %]

You have received this message because you, or someone else, requested a reset of your PINES library
account password. If you did not request a reset of your password, you may ignore this message and your current password will continue to work.

To reset your password:
1. Go to https://gapines.org/eg/opac/password_reset/[% target.uuid %]
2. Complete the password reset form.

If you require additional assistance, please contact your library:

[% homelib.parent_ou.name %]
[% homelib.name %]
[%- SET addr = homelib.mailing_address -%]
[%- IF !addr -%] [%- SET addr = homelib.billing_address -%] [%- END %]
[% addr.street1 %] [% addr.street2 %]
[% addr.city %], [% addr.state %] [% addr.post_code %]
[% homelib.phone %]
[% homelib.email %]
[% liburl %]
(Please have your library card number available.)

**SMS Call Number**

*Type: SMS Text*

*Frequency: On Demand*

Subject: [PINES] Call Number

Title: [% title FILTER ucfirst %]
Author: [% author FILTER ucfirst %]
Call Number: [% target.label %]
Location: [% helpers.get_most_populous_location( target.id ).name %]
Library: [% target.owning_lib.name %]

**Notices Sent by Vendor**

**10-day Notice**

*Type: If patron does not have email address, vendor attempts phone call. If no valid phone, vendor sends letter via USPS*

FIRST OVERDUE NOTICE

Dear [name],
According to our records, the following items were checked out on your library card and are now overdue. Please return them as soon as possible to avoid increasing fines. Returning all the past due materials and paying your late fines will also allow you to check materials out in the future.

[Title] [Author] [Call #] [Due Date] [Item ID]

Your prompt assistance in returning these materials will help us make these items available for use by other customers. If you have questions about these items or your library account, please call [library] at [phone number].

Thank you for your help.

30-day Notice

Type: USPS Mail

FIRST OVERDUE NOTICE

Dear Valued Library Customer,

According to our records, the following items checked out on your library card and are now more than 30 days past due. Please return these items as soon as possible to avoid additional fines and maintain your library card’s validity.

[Title] [Author] [Call #] [Due Date] [Item ID]

Your prompt assistance in returning these materials will help us make these items available for use by other customers. If you have questions about these items or your library account, please call [library] at [phone number].

Thank you for your help.

OCGA 20-5-53
Any person who borrows from any public library any book, newspaper, magazine, manuscript, pamphlet, publication, recording, video product, microfilm, computer software, film, or other article or equipment necessary to its display or use belonging to or in the care of such public library under any agreement to return it and thereafter fails to return such book, newspaper, magazine, manuscript, pamphlet, publication, recording, video product, microfilm, computer software, film, or other article or equipment necessary to its display or use shall be given written notice, mailed to his last known address or delivered in person, to return such article or equipment within 15 days after the date of such notification. Such notice shall contain a copy of this Code section. If such person shall thereafter willfully and knowingly fail to return such article or equipment within 15 days, such person shall be guilty of a misdemeanor and, upon conviction thereof, shall be punished by a fine of not more than $500.00 or imprisonment for not more than 30 days and shall be required to return such article or equipment or provide reimbursement for the replacement cost of such article or equipment.
From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/10/10 09:08
Legal Resources

Georgia Library Law

- Georgia Code pertaining to libraries
- Marti Minor’s Legal Column
- Marti Minors Library Presentation Documents

Selected Presentations and Documents

Library Law Q&A (Marti Minor, Public Library Directors Meeting, Fall 2020)
- COVID-19 Issues and Leave Time
- Effect of Bankruptcy on Library Accounts
- Library as Host of Virtual Events

Anonymity for Library Users: Balancing Legal Obligations (Marti Minor, Public Library Directors Meeting, Fall 2019)

Library Law Salad (Marti Minor, Public Library Directors Meeting, Spring 2017)
- Library Law Salad: Legal Update for Georgia Public Library Directors
- Legal Matters in Georgia Public Libraries: An Update for Directors
- Topics include Georgia's Gun Law, Bathroom Legislation

Patron Conduct (Marti Minor, Public Library Directors Meeting, Winter 2016)
- Managing Patron Behavior without Abridging Legal Rights
- Policies for Patron Conduct

Case Studies: Library Law in Georgia (Marti Minor, Public Library Directors Meeting, Fall 2014)

1. In light of Georgia’s more permissive gun carry law that now includes government buildings, what type of policy (if any) should public libraries enact regarding gun possession inside the library building?
2. How does Georgia’s Health Care Freedom and ACA Non-Compliance Act apply to public libraries?
3. Is it advisable to extend borrowing privileges to institutional patrons? What are the contract and collection implications?
4. Are e-cigarettes prohibited in public buildings under state law? If not, may the public library prohibit the use of e-cigarettes inside?
5. What are a public library’s duties to maintaining electronic records for purposes of open records
requests?
6. May a public library enter into a joint venture with another non-profit entity involving value-added services for which a fee will be charged?
7. Mandatory Child Abuse Reporting: What training is required for young volunteers or short-term volunteers?
8. What is the applicability of Georgia’s Open Meetings Law to Friends Groups? What concerns would a Friends Group have in hosting meeting of local legislative authorities?
9. Are library workers required to request parental permission prior to taking photos that include children participating in library events?
10. Sharing patron info between libraries: What type of patron information may a public library provide to other libraries? Is it permissible to give name, address & phone numbers?

Legal Questions from Georgia Librarians Part II (Marti Minor, Public Library Directors Meeting, 2013)

1. Can/should a public library prohibit a patron from distributing religious materials to other patrons and library staff?
2. What duty/right does a librarian have to monitor the materials used and borrowed by minors?
3. Are there nepotism or conflict of interest concerns when members of a hiring committee are related to public library job applicants?
4. Can a public library require employees to be paid via direct bank deposit?
5. How may a library, as an employer, force someone to retire without facing an age discrimination suit?
6. What level of background check should a public library do with regard to job applicants?
7. What are the options of a library as employer when an employee is often absent from work because of health problems but refuses to discuss her intentions with regard to maintaining her employment?
8. For purposes of applying for grants, how can a public library prove its non-profit status?
9. What is a public library’s responsibility when asked to provide access to its security camera video?
10. What are the options for a library when a disgruntled patron photographs an employee and threatens to post the photo and describe the employee as rude and abusive (even when the employee has remained polite and appropriate in all dealings with the patron)?

Legal Questions from Georgia Librarians: Ten Case Studies (Marti Minor, Public Library Directors Meeting, 2013)

1. In the context of discipline and safety issues, when, if ever, can a library staff member touch a child who is not being supervised by a parent?
2. How much help can a librarian legally provide to a patron who is filling out an official form or document?
3. A patron who has ADHD has requested the public library provide a private room in which to read to allow her to concentrate. What is required of the library?
4. Whom may the library properly classify as independent contractors?
5. What are the FLSA implications of a non-exempt library staff member volunteering to work with or become a paying member of the Friends of the Library?
6. May the library deduct fines and lost material fees from an employee’s paycheck?
7. How does an employer administer FMLA leave when an employee has accrued leave and is receiving short term disability?
8. Does a power of attorney give the holder access to a library users circulation records?
9. What are the considerations for a public library in establishing or removing an area for free informational materials?
10. Is it discriminatory to be closed on holidays associated with Christianity while open on holidays associated with other religions?

**Legal Issues in Georgia Public Libraries (Marti Minor, Public Library Directors Meeting, May 2010)**

- Access Issues
- Use of Library Policies to Manage Problem Behavior by Patrons
- Debt Collection by Public Libraries
- Employment Issues
- General Liability Issues
- Board of Trustees and Friends of the Library

From: [https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation](https://pines.georgialibraries.org/dokuwiki/)


Last update: **2020/10/12 12:57**
Record and Data Retention

Patron Record Retention

Updated on 09/03/2014:

The legal department of the Board of Regents has indicated that public libraries are not mandated to follow the USG data retention schedule for “Courtesy Borrowers Records” (a.k.a library patron applications). Libraries should develop their own policies in accordance with the Secretary of State policy for voter registration (that takes place with library applications and updates). Whether you record that electronically or with paper forms is up to the library system. Please keep yourself informed of the Secretary of State's policy by checking their website at https://sos.ga.gov/elections-division-georgia-secretary-states-office.

As references in developing a record retention plan for a library system, you may also wish to consider:

- Georgia Records Act
- Local Government Retention Schedules
- Record Retention (Slides, Ben Carter, Public Library Directors Meeting, Fall 2020)

Circulation and Hold Data Retention

With a few exceptions, circulation and hold data that has been resolved/closed is archived by the system after one year. Archiving this data does not affect statistical reporting, such as total number of circulations per item, circulation staff, circulation workstation, and circulating library.

Circulation data with outstanding fines or fees, including Lost and Long Overdue, is retained. Circulation information is also retained for those patrons that opt to have the system store their circulation history.

However, when looking at the “Show Last Few Circulations” item screen or the “Show Cancelled Holds” patron screen, data older than a year is not displayed.
Volunteers in the Library

The library has an obligation to protect the confidentiality of patron and circulation records and would be liable for any exposure of those records whether it be via paid employee or volunteer. Policy decisions as to which staff will have access to the records must be made with great care.

As there is no reliable enforcement mechanism for ensuring this confidentiality for volunteers like there is with employees, the PINES Executive Committee has endorsed a policy that does not allow volunteers to access any of the staff functions of the PINES system. [2020.12]
Library Cards

Library Card Design

Any new card designs for PINES must be approved by the PINES Director, the PINES Communications Department, and the State Librarian [2016.12].

Library Card Orders

Library cards are purchased directly by each library system. Libraries may use any vendor as long as the card design, barcode format, and numbering sequence are consistent with PINES standards.

See also: Library Card and Barcode Ordering Information and Patron Card Sequences

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2018/10/11 16:15
Library Names, IDs, Codes, and Contacts

The Library Contact Info spreadsheet that is attached below includes addresses, phone numbers, email addresses, as well as library shortnames and library database IDs (for use in search codes).

- library-contacts-8-11-2022.xlsx
- See Also: Courier Labels and Courier Codes

From:
https://pines.georgialibraries.org/dokuwiki/ - PINES Documentation

Permanent link:

Last update: 2022/08/11 10:09